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1. QuantShare 

 

This chapter will guide you through the tutorial parts: 

Application: 

Using the software 
Docking windows 
Toolbars 
Workspaces 
Events 
Scripting 
Intraday Settings 
 
Charting: 

Tutorial/Application/Using%20the%20software.htm
Tutorial/Application/Docking%20windows.htm
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Charts 
Layouts 
Templates 
Drawing tools 
Auto drawing tools 
 
Symbols: 

Symbols 
Symbols Selection 

Data: 

Databases 
Application Objects 

QuantShare Language: 

QuantShare Language 
Composite Function 
Advanced Rules 

Plug-ins: 

Indicators 
Custom functions 
Custom Drawing Tools 
Composite 
Watch List 
Script Manager 
Widget Panel 
Sharing Server 
Notes 
Divers 

Downloading Data 
ASCII Importer 
Downloader 
Data Viewer 

Rules Manager 
Ranking System Manager 
Simulator 
Monte Carlo Simulation 
Advanced Money Management 
Screener 
Pivot Tables 
Portfolio 

Tutorial/Charting/Drawing%20tools.htm
Tutorial/Charting/Auto%20drawing%20tools.htm
Tutorial/Symbols/Symbols%20Selection.htm
Tutorial/Data/Application%20Objects.htm
Tutorial/QuantShare%20Language/QuantShare%20Language.htm
QuantShare%20Language/FollowedBy.htm
Tutorial/Plug-ins/Custom%20functions.htm
Tutorial/Plug-ins/Watch%20list.htm
Tutorial/Plug-ins/Script%20Manager.htm
Tutorial/Plug-ins/Widget%20Panel.htm
Tutorial/Plug-ins/Sharing%20Server.htm
Tutorial/Plug-ins/ASCII%20Importer.htm
Tutorial/Plug-ins/Data%20Viewer.htm
Tutorial/Plug-ins/Rules%20Manager.htm
Tutorial/Plug-ins/Ranking%20System%20Manager.htm
Tutorial/Plug-ins/Advanced%20Money%20Management.htm
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Artificial Intelligence 
Optimizer 

Portfolio123 

Tutorial/Plug-ins/Artificial%20Intelligence.htm
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1.1 Introduction 

 

QuantShare is an advanced technical/fundamental analysis program. 
 
We have built a flexible trading software whose possibilities are only limited by your imagination. But 
because we know that this is not enough, we have created a sharing server to let you exchange items 
with other traders in order to feed your imagination, increase your productivity, give you the 
opportunity to use advanced traders tools, and help you improve your trading skills. 

QuantShare 

  

http://www.quantshare.com/
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[TOP] 

1.2 Application 

Using the software 

  

1. Starting the program 

To start the program, double-click the QuantShare icon on the Windows desktop or select 

QuantShare menu item from the Programs menu. 

  

2. Main window 

The main application window contains the menu, the toolbars, the docking windows and the chart 

windows. 
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3. Application settings 

To access the application settings (Accounts -> Application Settings) 

 

The different tabs are: 

 

- Visual Settings: Update visual settings such as the application backcolor, application font color... 

 

- Memory Management: Update memory management options 

 

- Databases: Specify the database optimization frequency. 

You can instruct the application to start the optimization on the next run by clicking on "Schedule 

databases optimization..." 

 

- Workers: Specify different settings for workers and tasks notifications (Download items, analysis...) 

 

- Editor: Specify whether to display the wizard or standard formula editor by default 

 

- ToolStrip: Update Color settings for the different toolbars and menus. 

 

Note: Each account has its own application settings. 
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To access the application settings (Accounts -> Application Settings) 
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1.2.2 Docking windows 

Docking Windows 

  

A docking window can stick to the main application boundaries or to the other windows boundaries. 

1. Move a docking window 
  

In the picture below, we have a chart window and four docking windows. 

To move the right panel or window to the left, first click on the caption of the right panel (Where it is 

written Composite in this example). 

  

 

  

Move the mouse while keeping the mouse left button pressed; a blue rectangle will appears, 

continue moving this rectangle to the left panel. 
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An icon with five rectangles appears, select the right rectangle then release the mouse button. 
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1.2.3 Toolbars 

Toolbars 

  

This application contains two main toolbars, one located at the top below the menu and the other at 

the bottom. 

  

1. Top Toolbar 
  

The top toolbar contains mainly symbol's selection combo boxes and drawing tools buttons, it 

contains some other buttons created by the plug-ins and a list of shortcuts. 

  

2. Bottom Toolbar 
  

The bottom toolbar is used to display account name and to manage templates, layouts and 

workspaces. 

 The bottom toolbar has the following items: 

 The current account name  
 Templates menu  
 Layouts menu  
 Workspace menu  
 Divers menu, which contains the list of shortcuts  
 Symbols working information  
 Message and alerts  
 Intraday data-feeds  

  
  

3. Accounts 
  

The application starts the first time with a default account name. You can add, remove and update 

accounts later. 

Each account has its own items, databases data, quotes… 

  

3.1. Account files 
  

Account files are located in the directory 'Databases'. 

Each account has a sub-directory in the 'Databases' directory. 

Example if your account name is 'Trader' then the full path to this account is 'Application 

Path\Databases\Trader', and within this directory are located all the objects, databases associated to 

this account. 
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3.2. Create an account 
  

To create a new account (Accounts -> Add Account) 

 

 

The database folder is updated automatically after you type the account name. 

 

3.3. Change the current account 

To change the current account (Accounts -> Change Account) 
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Select an account then click on 'Open'. 

  

3.4. Update an account 
  

To update an account (Accounts -> Change Account) 

 Select an account then select the 'Update account' tab.  

Click on 'Update and reload' when you finish. 

  

3.5. Remove an account 
  

To remove an account, click on 'Change Account', select an account then click on 'Delete'. 

 

3.6. Associate an existing database to an account 
  

Select "Accounts -> Change Account" 

Select an account then click on the 'Update account' tab. 

In the database folder textbox, choose an existing directory that contains the data you want to use 

(usually the directory of another account). 
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1.2.4 Workspaces 

Workspaces 
  

  

1. Workspaces 

 

A workspace contains the location of forms and charts. 

You can create as many workspaces as you want.  

Example: You can create a workspace that contains only charts, another one that contains the 

download forms... 

  

2. Create a workspace 
  

To create a new workspace, click on the button, in the toolbar, as shown in the picture, select 'Save 

workspace' and then type a name for your newly created workspace and finally click on save. 

 

  

3. Remove a workspace 
  

To remove a workspace, click on the button, in the toolbar, as shown in the picture, select 'Remove a 

workspace' and then select the workspace you would like to remove. 
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4. Load a workspace 
  

To load a workspace, click on the button, in the toolbar, as shown in the picture, select 'Load a 

workspace' and then select the workspace you would like to use. 
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1.2.5 Events 

Application & Thread events 
 

  

1. Application events 
  

Main application and plug-ins can throw events to notify the 'Event System' that they have 

completed a task or that a user did an action... 

Main application and plug-ins can also subscribe to the 'Event System' and receive notification about 

a certain event they want to catch. 

The plug-in that makes the more use of these events is the 'Task Manager'. Its role is to execute 

scripts depending on the application or system events and on your settings. 

Example of notification: 

 

  

2. Thread events 
  

Thread events are events sent by plug-ins, the tasks associated with these events are generally time 

or CPU consuming tasks. 
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Example: (Downloading quotes)  

 

The main application catches these events and adds notifications about whether these events start 

or end into a grid (as shown below) 
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1.2.6 Scripting 

Scripting 
 

  

1. Introduction 

 

Scripts in the QuantShare software use the .Net framework and the CSharp (c#) or Jscript.Net 

programming languages. 

.Net Scripts extend QuantShare capabilities and make the application extremely flexible.  

Scripts can be shared between QuantShare users.  

There are two kinds of scripts, main script and specialized scripts. 

 

The main script allows the user to: 

         Control the application behavior 

         Extract databases data 

         Insert, inspect, control and modify database data 

         Control the objects (composites, watch lists, list of rules...) 

  

The specialized scripts allow the user to take control over some specific tasks. 

The application offers you the possibility to write scripts for the following tasks: 

  

Money management: Contains five events, the first and last events happen once while the other 

events could happen many times during the backtesting. 

         OnStartSimulation: The simulator executes this script before starting the backtesting 

process. 

         OnNewTrade: The simulator executes this script before entering a new position. 

         OnCloseTrade: The simulator executes this script before exiting a position. 

         OnEndPeriod: The simulator executes this script at the end of each period or bar. (In end of 

day back-testing, a period is a day) 

         OnEndSimulation: The simulator executes this script when the back-testing process ends. 
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Example: Create a script that initializes an optimizable variable in the 'OnStartSimulation' event  

    Create a script, in the 'OnNewTrade' event, that updates the number of shares to buy 

depending on the trading system drawdown and the optimizable variable defined in the 

'OnStartSimulation' event 

  

Example: Create a time-series metric for your trading system using the 'OnEndPeriod' and the 

'OnEndSimulation' events 

 

Note: In money management scripts, you can define global variables that can be shared between 

events. 

  

List of rules analyzer metrics: Script that let you create metrics to assess rules 

Example: Calculate the average performance of a rule for each month. 

  

Ranking system analyzer metrics: Script that let you create metrics to assess ranking systems 

Example: Calculate the standard deviation of the buckets annual return. 

  

Simulation metrics: Script that let you create metrics to assess simulations 

Example: Calculate a custom metric that uses Sharpe, Sortino and some others ratios 

  

Prediction model metrics: Script that let you create metrics to assess prediction models 

Example: Calculate a custom metric that uses others already calculated metrics. 

 

Pre-Parsing data: Script that let you manipulate text or CSV data 

Example: Create a new column that is based on others columns data 

Example: Update a column data so it can be parsed by the software 

  

Post-Parsing data: Script that let you manipulate parsed data just before the application stores it 

Example: Correct bad quotes 

  

URL-Script: Script that let you dynamically create URLs for the downloader to download. The data is 

then passed to the Pre-Parsing and Post-Parsing scripts if they are implemented. 

Example: Grab the download URL from a website that dynamically changes the URL path every day. 
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Functions: Function scripts let you create QuantShare functions. These functions could be used in 

charting, simulation... 

Example: Correct a custom indicator that is not available in the QuantShare indicators list 

 

  

2. Script Control 
  

.Net script shares the same control; the control is an advanced text box control where you 
can type in your script. 

You can press on CTRL+SPACE at any moment to display the list of functions or variable that 
you can use in the current  

script. 
Each script contains its own functions and classes. 
You can click on the right icon to display information about the current script. 
  

 
  

  

  

3. Global Variables 
  

The Global variable class lets you define global variables.  
This class is present in all scripts (main script and specialized scripts). 

Its main functions are: GetVariable and SetVariable. 
  

Example:  
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Global.SetVariable("myvar", 20); 
  

The application will now create a global variable "myvar" that has a value of 20. 
You can access this variable from any script. This will allow scripts to interact with each 

other. 
  

  

4. Create functions inside a script 
  

You can create inside a script as many functions as you want. You just need to tell the 
application where the main code 

ends. This is done, by using the following keyword: #functions# 
Example: 

double a = 0; 

for(int i=0;i<10;i++) 

{ 

     a = Sum(a, 1); 

} 

MessageBox.Show(a.ToString()); 

#functions# 

public double Sum(double a, double b) 

{ 

     return a + b; 

} 

This C# script calls the function "Sum" ten times. 
  
 

5. Reference External DLLs in a Script 

 

In any script editor (Create Functions, Money Management, Custom Drawing Tools...), click on the 

"Menu" button located at the bottom then click on "Add References". 

The new form displays all the external references of the current script.  

To remove a reference, select it then click on "Remove Reference". 

To add a new reference, click on "Add Reference", select the Dll or library you want to include then 

click on "Open". 

Once a library is added, you can reference it in the script by typing the full namescape or by typing 

the "using" keyword. 

 

Example 1: (Full Namescape) 
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System.Diagnostics.Debug.WriteLine("Hello"); 

  

Example 2: ("Using" Keyword) 

using System.Diagnostics; 

Debug.WriteLine("Hello"); 

   

Note that in the money management script, the menu button appears only in the script editor of the 

"Global" event. However, once a dll is added, you will be able to use it in any other event (Example: 

OnStartSimulation, OnEndPeriod...) 

  

  

[TOP] 

1.2.7 Intraday Settings 

Intraday Settings 
To open the Intraday Settings form: 
- Select "Accounts" then "Intraday Settings" 
 

1. Data Settings 

- Create Intraday Snapshot from Tick data: 

 

When you import or download tick data, this feature allows you to create intraday data and to store 

it in the intraday database. 

In the input field, you can select the default time-frame to use when creating the intraday data. 

This will allow quick access of data for your base time-frame. 

 

Example: 

Type 60 to create and save one-minute bars data from your tick data. 

 

- Intraday data storage 

 

Adding a lot of intraday data can slow your computer. This option allows you to instruct the 

application to delete old data by specifying the number of past days to keep in the database. Older 

data will be automatically deleted. 

Set "0" to disable this option. 

 

- Watchlist/Screener 

 

This option allows you to specify the number of days worth of data to load when using the 

screener/watchlist and when working with intraday time-frames. 
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A value of 20 is usually enough for one-hour time-frame. You can set a lower value if you work with 

lower time-frames. 

Set "0" to disable this option. The screener or watchlist will load all the available intraday/tick data. 

 

2. Exchange Settings 

Select the "Exchange" tab to open the Exchange settings control. 

This control allows you to update exchange settings. 

 

How to create an exchange: 

 

The exchanges displayed in this control correspond to the different markets you can specify in 

"Symbol -> Categories". 

- Select "Symbol" then "Categories" 

- Type the exchange name near the "Market" field then click on "Add". 

 

How to delete an exchange: 

 

- Select "Symbol" then "Categories" 

- Select a market then click on "Remove Selected Market". 

Exchange Settings: 

 

Name: The exchange name 

Abbreviation: A short name for the exchange 

Exchange Daylight Savings: Specify the start and end of daylight savings 

 

Sessions Times: 

Click on "+" icon to add a session and on the "x" to delete a session. 

The "Start" and "End" corresponds to the session start time and end time. 

Under "Days of week", click on the days of the week where the exchange is open. 

The "Sync" time allows you to synchronize the time with the open time of the intraday bars. 

Example: A sync time of 8:15 will cause a 30-minute chart to build bars that start at 8:15, 8:45, 9:15, 

9:45... 

The "Sync" time is usually the same as the day session opening time. 

[TOP] 

1.3 Charting 

Charts 

  

1. Introduction 
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2. Basic operations 
 

  

2.1. Open a chart 

Select "View" then "New chart". 

 

2.2. Update chart symbol 

Select a chart, and then select a symbol from the tool bar; the chart symbol will be automatically 

updated. 
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2.3. Arrange charts 

  

To arrange charts, click on the button shown below. 

 

You can also specify how to arrange charts by specifying the number of rows and columns.  

 
 

 

2.4. Create linked chart 

  

A linked chart is a chart that is linked with another one. 

You can link charts by symbol or by time-frame. 

 

If chart 'A' is linked by symbol to chart 'B', then if we change the chart 'B' symbol then the symbol of 

chart 'A' will be updated as well. 

If chart 'A' is linked by time-frame to chart 'B', then if we change the chart 'B' time-frame then the 

time-frame of chart 'A' will be updated as well. 

Linked Charts are those that have the same link index 

 

To link two charts by symbol, click on the "S" button (at the bottom of the chart) then select a link 

index. Linked charts must have the same link index. 

To link two charts by time-frame, click on the "T" button (at the bottom of the chart) then select a 

link index. Linked charts must have the same link index. 

If you click on a given date on a chart A, that date will be displayed in charts that are linked to chart 

A. 

If you create or update a drawing item, then linked charts will be automatically updated. 

 

2.5. Shortcuts 

To display a list of shortcuts, click on 'Divers' in the bottom tool bar, then click on 'List of Shortcuts'. 

 

Other shortcuts: 
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- Open a new chart from "Select a symbol" field (Main Window) by typing the symbol name in this 

field, then using ENTER + SHIFT shortcut. 

- Use mouse wheel to transalte a chart 

- Keep pressing on CONTROL and use your mouse wheel to zoom in and out 

- Press on CONTROL then double click on a pane to maximize it 

- To quickly change the chart symbol, keep pressing on the UP arrow and type a symbol 

- Type CONTROL+S to add a split to the current symbol for the selected data 

- Type CONTROL+B to add a dividend/bonus to the current symbol for the selected data 

- Type CONTROL+N to add a note to the current symbol for the selected data 

 

2.6. Zooming 

To zoom into a chart, click on CTRL then use the mouse wheel to zoom in and zoom out. 

 

2.7. Window Types 

There are three types of Chart Windows:  

- MDI Window: The chart can only be moved within the application 

- Owned Window: The chart is owned by the application but it can be moved outside of it. 

- Floating Window: Create a separate floating window. 

 

To update a chart window type, right click on a chart, select "Window Type" then select the type. 

You may notice that it is not possible to update the symbol of a floating chart (using "Select a 

symbol" field) if you already have more than one chart. 

To update a floating chart's symbol, keep pressing on "UP ARROW" key then type the symbol name. 

You can also click on the "Tools" icon (Next to time frame menu at the bottom of the chart) then type 

the new symbol name.  

If selecting the "Type a symbol..." doesn't work, try minimizing the main QuantShare form first.  

 

  

3. Panes 
  

Each chart is a collection of panes; a chart can contain one or several panes. 

Each pane contains a template and one or many formula files. 
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Example of chart with three panes: 

 

 

  

To maximize a pane, keep pressing on CONTROL then double click on it. To restore it, perform the 

same operation. 

 

 

  

4. Select Line 

There are three select tools available: 

 Line when chart clicked  
 Cross lines  
 Cross lines outside chart  

  

You can specify some settings like color, line width, Stick to (See Drawing tools)... 
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5. Time-Frames 
  

Available historical periods are day, week, month, year, and custom. 

Custom historical periods let you select the number of days to use as timeframe. 

 

Available intraday periods are 1 second, 1 minute, 5 minutes, 10 minutes, 15 minutes, 30 minutes, 1 

hour, 2 hours, 5 hours, and custom. 

Custom intraday periods let you select the number of seconds to use as timeframe. 

To switch from Historical to Intraday data, right click on a chart then select "Switch to Intraday" or 

"Switch to Historical". 

To change a chart timeframe, right click on a chart, select 'Chart Timeframe' in the menu and then 

select the timeframe. 

You can also update the current timeframe by selecting the option that is located at the bottom-left 

corner of the chart. 

 

Custom Periodicties: 

You can create a custom periodicity that are not time-based by right clicking on a chart then selecing 

"Periodicity" menu. (Extended menu) 

 

To create a new periodicity, right click on a chart, select "Periodicity" then "Periodicity Settings". 
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Different Periodicities are available: 

- Ticks per bar: A tick bar is based on a specific number of trades. A new bar is created when the 

number of specified ticks is reached. 

Example: In a 50-Tick periodicity, each bar represents 50 ticks/trades. 

- Volume per bar: A volume bar is bsaed on a specific traded volume value. A new bar is created 

when the sum of volume becomes equal or higher to the specified value. 

Example: In a 50,000-Volume periodicity, each bar contains trades that represent a volume of 50,000 

contracts. 

NB: This periodicity is customizable. This means that you can update the default formula: volume 

- Change per bar: A change bar is based on a security return. A new bar is created when the sum of 

the one-bar rate of return becomes higher or qual to the specified value. 

Example: In a 5-Change periodicity, each bar represnts a change of 5% in the price of the security. 

NB: This periodicity is customizable. This means that you can update the default formula: perf(close, 

1) 

- Range per bar:  A range bar is based on a specific price range. A new bar is created when the price 

range is broken. 

Example: In a 3-Range periodicity, each bar measure $3 (Measured from high to low). 

 

If "Multiple of ticks" is specified then a unit represents the tick size of the security. 

Example: In a 3-Range periodicity, each bar measures 3 ticks (Measure from high to low). 

For Apple stock, a tick size is 0.01 and therefore each measures $0.03. 

- Signal change per bar: A signal change bar is based on a signal/rule. A new bar is created when the 

signal or rule is TRUE (equal to 1). 

Exampel: In a (Close > Open) signal-change periodicity, a new bar is created when the close 

price becomes higher than the open price. 

NB: This periodicity is customizable. This means that you can update the default formula. 

Options: 

Do not show in menu: Check this option to disable the periodicity (It will not be visible in the list of 

periodicities that is displayed when you right click on a chart) 

 

  

6. Chart Type 

Besides Japenese Candlestick, Line and Bar charts, QuantShare allows you to create other 
chart types: 

- Point & Figure: More Info 
- Kagi: More Info 
- Heikin Ashi: More Info 

http://en.wikipedia.org/wiki/Point_and_figure_chart
http://en.wikipedia.org/wiki/Kagi_chart
http://en.wikipedia.org/wiki/Candlestick_chart#Heikin-Ashi_candlesticks
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Chart Type Settings: 
  

You can open the Chart Type Settings form by right clicking on a chart, selecting "Chart Type" 
then "Chart Type Settings". 

 
 
7. Drag & Drop 

 

You can drag and drop formulas from a pane to another one. 

If you right click on a curve or a bar, the application will detect which formula this curve or bar 

belongs to, you just have then to drag and drop this formula to another pane.  

Right click on a study then drag & drop to another pane 

 

 

 

You can also drag and drop a formula to the widget or bookmark panel. 

Note that unlike the majority of the other items (Trading systems, watch-lists, composites ...), when 

the drag & drop process completes, a copy is saved (not a reference). 

This means that if you drag and drop a chart formula to the bookmark panel, then you update the 

formula in that panel, the chart formula will not change. 

If you want to copy a formula, keep clicking on CONTROL then perform the drag & drop operation. 

 

 

8. Plot Formulas 
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Charts are based on formulas.  

You can create charts without writing any line of code, or you can create complex charts using the 

QuantShare Language. 

You can plot candlesticks, lines, bars, smoothed lines, step lines, symbols, and texts. 

There is also a special type of graphs called fixed graphs. 

 

You can plot for example something like "Average daily performance for each day of the week", or 

"number of days up and days down for each month"...  

Here is the formula syntax: 

PLOTFIXED(vector1, vector2, string vector, calculation function, description, color, ChartStyle, Style); 

Let us imagine we want to calculate the average closing performance for each day of week. 

 Vector1: (Day of week) (one means Monday, two for Tuesday...) 

1 2 3 4 5 1 2 3 4 5 

Vector2: (Close price) 

10 11 12 10 8 6 9 11 13 12 

Intermediate Vectors: 

X vector: 

1 2 3 4 5 

Y vector: 

10 11 12 10 8 

6 9 11 13 12 

Then if we have selected "Sum" as calculation function, we will have: 

Y vector 

16 

(10+6) 

20 23 23 20 

 

In our case, we want the average closing price, so Y vector will look like this:
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8  

(10+6)/2 

10 11.5 11.5 10 

 

At the end, we plot the graph with X vector in X-axis and Y vector in Y-axis. 

Example formula: 

// Average daily performance per by day of week 

// One day price change 

performance = perf(close, 1);  

// Day of week 

dayofw = dayofweek(); 

// Change day of week numeric values to text format 

text = StringReplace(dayofw ,0,"Sunday"); 

text = StringReplace(text,1,"Monday"); 

text = StringReplace(text,2,"Tuesday"); 

text = StringReplace(text,3,"Wednesday"); 

text = StringReplace(text,4,"Thursday"); 

text = StringReplace(text,5,"Friday"); 

// Plot fixed chart 

PLOTFIXED(dayofw, performance,text , iAvg,"Average daily performance per by day of 

week",colorGreen,ChartBar,StyleSymbolDiamond); 
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9. Formula Files 

Charts don't contain reference to formula files but instead contain formula contents. 

This means that even if you remove or update a formula file that a chart was build upon, the chart 

won't change. 

Right click on a chart, and then click on 'Edit formula' to edit a chart formula. 

Only the current chart will be affected if you update the formula or change its name. 

You can save the content of this formula to a file and use it later with other charts. 

 

 

10. Future Bars 

Future bars option has no effect on the prices series and studies. This option is used to 
display more empty bars on the right.  
 
To update the number of future bars in a chart: 
- Right click on a chart 
- Select "Tools" then "Set future bars" 
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- Type a number then click on "OK". 
 
Example of usage: 
Predict the date (in the future) when one trend-line crosses above another one. 
 
Chart without future bars: 
 

 

Chart with 30 future bars: 

 

 

 

  

11. Chart Scale 
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To change the chart scale from linear to logarithmic: 
- Right click on a chart 
- Select "Tools" then "Set Log Scale". 

 

 

12. Manage Charts 

Charts Manager tool allows you to save charts and manage them by this plug-in. 
 
Here are the different elements that are saved with the chart: 
- Different panes and formulas 
- Layout and templates 
- Drawing data 
- Chart settings 
 
To open the Charts Manager tool, select "Views" in the main menu then "Manage Charts" 
(Extended Menu). 

To save a chart: 
- Select the chart you want to save 
- Click on "Save Chart" button in the "Manage Charts" form 
- Type the chart name then click on "Save" 

To open a stored chart, double click on it 
Alternatively, you can right click on an item to open a menu. In this menu, you can 
open/delete the chart and manage categories. 

 

 

13. Additional Chart Settings  

The chart formula editor can be opened by right clicking on a chart then selecting "Edit 

Formula". 

The "UpdateSettings" formula allows you to update additional chart settings. 

Examples: 

UpdateSettings("Full Pane", 1); 

Removes the date, indicator values and icons from the pane and reduces the top and bottom 

pane's margins. 

UpdateSettings("Top-Bottom Chart Margin", 1); 

Removes the top and bottom pane's margins. 

UpdateSettings("Hide Formula in EOD Chart", 1); 
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Instructs the chart to hide the formula when EOD time-frame is selected. 

 

  

[TOP] 

1.3.1 Charts 

Charts 

  

1. Introduction 
 

 

2. Basic operations 
 

  

2.1. Open a chart 

Select "View" then "New chart". 

 

2.2. Update chart symbol 

Select a chart, and then select a symbol from the tool bar; the chart symbol will be automatically 

updated. 
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2.3. Arrange charts 
  

To arrange charts, click on the button shown below. 

 

You can also specify how to arrange charts by specifying the number of rows and columns.  

 
 

 

2.4. Create linked chart 
  

A linked chart is a chart that is linked with another one. 

You can link charts by symbol or by time-frame. 

 

If chart 'A' is linked by symbol to chart 'B', then if we change the chart 'B' symbol then the symbol of 

chart 'A' will be updated as well. 

If chart 'A' is linked by time-frame to chart 'B', then if we change the chart 'B' time-frame then the 

time-frame of chart 'A' will be updated as well. 

Linked Charts are those that have the same link index 

 

To link two charts by symbol, click on the "S" button (at the bottom of the chart) then select a link 

index. Linked charts must have the same link index. 
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To link two charts by time-frame, click on the "T" button (at the bottom of the chart) then select a 

link index. Linked charts must have the same link index. 

If you click on a given date on a chart A, that date will be displayed in charts that are linked to chart 

A. 

If you create or update a drawing item, then linked charts will be automatically updated. 

 

2.5. Shortcuts 

To display a list of shortcuts, click on 'Divers' in the bottom tool bar, then click on 'List of Shortcuts'. 

 

Other shortcuts: 

- Open a new chart from "Select a symbol" field (Main Window) by typing the symbol name in this 

field, then using ENTER + SHIFT shortcut. 

- Use mouse wheel to transalte a chart 

- Keep pressing on CONTROL and use your mouse wheel to zoom in and out 

- Press on CONTROL then double click on a pane to maximize it 

- To quickly change the chart symbol, keep pressing on the UP arrow and type a symbol 

- Type CONTROL+S to add a split to the current symbol for the selected data 

- Type CONTROL+B to add a dividend/bonus to the current symbol for the selected data 

- Type CONTROL+N to add a note to the current symbol for the selected data 

 

2.6. Zooming 

To zoom into a chart, click on CTRL then use the mouse wheel to zoom in and zoom out. 

 

2.7. Window Types 

There are three types of Chart Windows:  

- MDI Window: The chart can only be moved within the application 

- Owned Window: The chart is owned by the application but it can be moved outside of it. 

- Floating Window: Create a separate floating window. 

 

To update a chart window type, right click on a chart, select "Window Type" then select the type. 

You may notice that it is not possible to update the symbol of a floating chart (using "Select a 

symbol" field) if you already have more than one chart. 

To update a floating chart's symbol, keep pressing on "UP ARROW" key then type the symbol name. 

You can also click on the "Tools" icon (Next to time frame menu at the bottom of the chart) then type 

the new symbol name.  

If selecting the "Type a symbol..." doesn't work, try minimizing the main QuantShare form first.  
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3. Panes 
  

Each chart is a collection of panes; a chart can contain one or several panes. 

Each pane contains a template and one or many formula files. 

Example of chart with three panes: 

 

 

  

To maximize a pane, keep pressing on CONTROL then double click on it. To restore it, perform the 

same operation. 

 

 

  

4. Select Line 

There are three select tools available: 

 Line when chart clicked  
 Cross lines  
 Cross lines outside chart  

  

You can specify some settings like color, line width, Stick to (See Drawing tools)... 
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5. Time-Frames 
  

Available historical periods are day, week, month, year, and custom. 

Custom historical periods let you select the number of days to use as timeframe. 

 

Available intraday periods are 1 second, 1 minute, 5 minutes, 10 minutes, 15 minutes, 30 minutes, 1 

hour, 2 hours, 5 hours, and custom. 

Custom intraday periods let you select the number of seconds to use as timeframe. 

To switch from Historical to Intraday data, right click on a chart then select "Switch to Intraday" or 

"Switch to Historical". 

To change a chart timeframe, right click on a chart, select 'Chart Timeframe' in the menu and then 

select the timeframe. 

You can also update the current timeframe by selecting the option that is located at the bottom-left 

corner of the chart. 

 

Custom Periodicties: 

You can create a custom periodicity that are not time-based by right clicking on a chart then selecing 

"Periodicity" menu. (Extended menu) 

 

To create a new periodicity, right click on a chart, select "Periodicity" then "Periodicity Settings". 
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Different Periodicities are available: 

- Ticks per bar: A tick bar is based on a specific number of trades. A new bar is created when the 

number of specified ticks is reached. 

Example: In a 50-Tick periodicity, each bar represents 50 ticks/trades. 

- Volume per bar: A volume bar is bsaed on a specific traded volume value. A new bar is created 

when the sum of volume becomes equal or higher to the specified value. 

Example: In a 50,000-Volume periodicity, each bar contains trades that represent a volume of 50,000 

contracts. 

NB: This periodicity is customizable. This means that you can update the default formula: volume 

- Change per bar: A change bar is based on a security return. A new bar is created when the sum of 

the one-bar rate of return becomes higher or qual to the specified value. 

Example: In a 5-Change periodicity, each bar represnts a change of 5% in the price of the security. 

NB: This periodicity is customizable. This means that you can update the default formula: perf(close, 

1) 

- Range per bar:  A range bar is based on a specific price range. A new bar is created when the price 

range is broken. 

Example: In a 3-Range periodicity, each bar measure $3 (Measured from high to low). 

 

If "Multiple of ticks" is specified then a unit represents the tick size of the security. 

Example: In a 3-Range periodicity, each bar measures 3 ticks (Measure from high to low). 

For Apple stock, a tick size is 0.01 and therefore each measures $0.03. 

- Signal change per bar: A signal change bar is based on a signal/rule. A new bar is created when the 

signal or rule is TRUE (equal to 1). 

Exampel: In a (Close > Open) signal-change periodicity, a new bar is created when the close 

price becomes higher than the open price. 

NB: This periodicity is customizable. This means that you can update the default formula. 

Options: 

Do not show in menu: Check this option to disable the periodicity (It will not be visible in the list of 

periodicities that is displayed when you right click on a chart) 

 

  

6. Chart Type 

Besides Japenese Candlestick, Line and Bar charts, QuantShare allows you to create other 
chart types: 

- Point & Figure: More Info 
- Kagi: More Info 
- Heikin Ashi: More Info 

http://en.wikipedia.org/wiki/Point_and_figure_chart
http://en.wikipedia.org/wiki/Kagi_chart
http://en.wikipedia.org/wiki/Candlestick_chart#Heikin-Ashi_candlesticks
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Chart Type Settings: 
  

You can open the Chart Type Settings form by right clicking on a chart, selecting "Chart Type" 
then "Chart Type Settings". 

 
 
7. Drag & Drop 

 

You can drag and drop formulas from a pane to another one. 

If you right click on a curve or a bar, the application will detect which formula this curve or bar 

belongs to, you just have then to drag and drop this formula to another pane.  

Right click on a study then drag & drop to another pane 

 

 

 

You can also drag and drop a formula to the widget or bookmark panel. 

Note that unlike the majority of the other items (Trading systems, watch-lists, composites ...), when 

the drag & drop process completes, a copy is saved (not a reference). 

This means that if you drag and drop a chart formula to the bookmark panel, then you update the 

formula in that panel, the chart formula will not change. 

If you want to copy a formula, keep clicking on CONTROL then perform the drag & drop operation. 

 

 

8. Plot Formulas 
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Charts are based on formulas.  

You can create charts without writing any line of code, or you can create complex charts using the 

QuantShare Language. 

You can plot candlesticks, lines, bars, smoothed lines, step lines, symbols, and texts. 

There is also a special type of graphs called fixed graphs. 

 

You can plot for example something like "Average daily performance for each day of the week", or 

"number of days up and days down for each month"...  

Here is the formula syntax: 

PLOTFIXED(vector1, vector2, string vector, calculation function, description, color, ChartStyle, Style); 

Let us imagine we want to calculate the average closing performance for each day of week. 

 Vector1: (Day of week) (one means Monday, two for Tuesday...) 

1 2 3 4 5 1 2 3 4 5 

Vector2: (Close price) 

10 11 12 10 8 6 9 11 13 12 

Intermediate Vectors: 

X vector: 

1 2 3 4 5 

Y vector: 

10 11 12 10 8 

6 9 11 13 12 

Then if we have selected "Sum" as calculation function, we will have: 

Y vector 

16 

(10+6) 

20 23 23 20 

 

In our case, we want the average closing price, so Y vector will look like this:
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8  

(10+6)/2 

10 11.5 11.5 10 

 

At the end, we plot the graph with X vector in X-axis and Y vector in Y-axis. 

Example formula: 

// Average daily performance per by day of week 

// One day price change 

performance = perf(close, 1);  

// Day of week 

dayofw = dayofweek(); 

// Change day of week numeric values to text format 

text = StringReplace(dayofw ,0,"Sunday"); 

text = StringReplace(text,1,"Monday"); 

text = StringReplace(text,2,"Tuesday"); 

text = StringReplace(text,3,"Wednesday"); 

text = StringReplace(text,4,"Thursday"); 

text = StringReplace(text,5,"Friday"); 

// Plot fixed chart 

PLOTFIXED(dayofw, performance,text , iAvg,"Average daily performance per by day of 

week",colorGreen,ChartBar,StyleSymbolDiamond); 
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9. Formula Files 

Charts don't contain reference to formula files but instead contain formula contents. 

This means that even if you remove or update a formula file that a chart was build upon, the chart 

won't change. 

Right click on a chart, and then click on 'Edit formula' to edit a chart formula. 

Only the current chart will be affected if you update the formula or change its name. 

You can save the content of this formula to a file and use it later with other charts. 

 

 

10. Future Bars 

Future bars option has no effect on the prices series and studies. This option is used to 
display more empty bars on the right.  
 
To update the number of future bars in a chart: 
- Right click on a chart 
- Select "Tools" then "Set future bars" 
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- Type a number then click on "OK". 
 
Example of usage: 
Predict the date (in the future) when one trend-line crosses above another one. 
 
Chart without future bars: 
 

 

Chart with 30 future bars: 

 

 

 

  

11. Chart Scale 
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To change the chart scale from linear to logarithmic: 
- Right click on a chart 
- Select "Tools" then "Set Log Scale". 

 

 

12. Manage Charts 

Charts Manager tool allows you to save charts and manage them by this plug-in. 
 
Here are the different elements that are saved with the chart: 
- Different panes and formulas 
- Layout and templates 
- Drawing data 
- Chart settings 
 
To open the Charts Manager tool, select "Views" in the main menu then "Manage Charts" 
(Extended Menu). 

To save a chart: 
- Select the chart you want to save 
- Click on "Save Chart" button in the "Manage Charts" form 
- Type the chart name then click on "Save" 

To open a stored chart, double click on it 
Alternatively, you can right click on an item to open a menu. In this menu, you can 
open/delete the chart and manage categories. 

 

 

13. Additional Chart Settings  

The chart formula editor can be opened by right clicking on a chart then selecting "Edit 

Formula". 

The "UpdateSettings" formula allows you to update additional chart settings. 

Examples: 

UpdateSettings("Full Pane", 1); 

Removes the date, indicator values and icons from the pane and reduces the top and bottom 

pane's margins. 

UpdateSettings("Top-Bottom Chart Margin", 1); 

Removes the top and bottom pane's margins. 

UpdateSettings("Hide Formula in EOD Chart", 1); 
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Instructs the chart to hide the formula when EOD time-frame is selected. 

 

  

[TOP] 

1.3.2 Layouts 

Layouts 
 

  

1. Layouts 

 

A layout contains information such as: 

How many panes a chart have? 

What is the formula on each pane? 

What is the template associated with each pane? 

... 

  

2. Create a layout 
  

To create a layout from a chart, right click on that chart and click on 'Save layout as...' type a layout 

name then saves. 

 

3. Default layout 
  

The default layout is the layout that will be used when creating a new chart (View -> New chart). 

To set a layout as a 'Default layout', right click on a chart that contains the layout you want to use as 

a default layout then click on 'Set current layout as default'. 

NB: the default layout will be saved as 'Default.lay'. If this file is removed then the program will 

create a new default layout. 
  

4. Remove a layout 
  

Click on the button, in the toolbar, as shown in the picture, select 'Remove layout' and then choose 

the layout you want to remove. 
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5. Update a chart layout 
  

To update a chart's layout, right click on a chart, select 'Change layout' then selects the layout you 

want to use. 

 

 

  

6. Set the same layout to all charts 
  

To set a layout to all opened charts, click on the button, in the toolbar, as shown in the picture, select 

'Set layout to all charts', and then choose a layout. 
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[TOP] 

1.3.3 Templates 

Templates 
 

  

1. Templates 
  

Each chart contains one or more panes. A template is a pane visual setting; it defines the pane's back 

color, grid line width, the axis colors... 

 

You can easily create new templates, modify them, and associate them to other panes... 

A chart can also contain several panes; each pane can have a different template. 

 

 

  

2. Create a template 
  

On a chart's pane, right click then select 'Settings' in the menu. 



54 QuantShare | http://www.quantshare.com 

 

 

 

In the settings form, you can update any field by clicking on its value. 

When you finish, right click again on the chart's pane and click on 'Save template as...' 

Type in the template name then click on "Save". 
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3. Remove a template 
  

Click on the button in the toolbar as shown in the picture, select 'Remove template', and then choose 

the template you want to remove. 

 

 

  

4. Update a pane template 
  

On a chart's pane, right click then select 'Change template'; choose a template you want to apply for 

the selected pane. 

  

5. Update several panes' template 
  

Click on the button in the toolbar as shown in the picture. 
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To update the panes' template of the selected chart, select 'Set template to selected chart' then 

choose a template. 

To update the panes' template of all the charts, select 'Set template to all charts' then choose a 

template. 
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[TOP] 

1.3.4 Drawing tools 

Drawing Tools 
  

  

1. Drawing tools list 
  

List of the available drawing tools: 

         Line 

         Extended line 

         Horizontal line 

         Vertical line 

         Automatic support & resistance lines 

         Regression channel 

         Triangle 

         Ellipse (Keep clicking on SHIFT to create a circle) 

         Trend line 

         Pitchfork 

         Rectangle (Keep clicking on SHIFT to create a square) 

         Cycle line 

         Arc 

         Zigzag 

         Parallel lines 

         Arrow 

         Text 

         Pen 

         Marker 

         Gann fan 

         Gann square 
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         Fibonacci extension 

         Fibonacci retracement 

         Fibonacci time extension 

         Fibonacci time zones 

         Fibonacci arc 

         Fibonacci fan 

  

 

  

2. Usage of the drawing tools 

  

Select a drawing item then click on the chart, point the mouse to a second location then click on the 

left mouse button. 

Some drawing tools require three points or more. 

  

3. Drawing tools settings 
  

Each drawing tool has its own settings. You can update these settings by clicking on the right mouse 

button when the cursor is pointing on the drawing item. 

Some settings are common to all the drawing tools, while others are specific. 

 

The common settings are: 

Line color 

Line width 

Line style 

Locked or not 

Stick to (high, low, close, open, all and no stick) 

Stick only near candle 
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Examples of specific settings: 

Line: In the line tool, a setting named 'X axis distance' and another one named 'Y axis distance' let 

you draw distances on a chart.  

 

  

The line can be transformed to a 'Support resistance line'. 

On a support resistance line, the letter 'S' means that your line now is a support, while a letter 'R' 

means that the line is a resistance. 
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Regression channel: 

     

  

4. Remove a drawing tool 
  

Right click on a drawing tool to open the settings form; click on 'Delete'. 

To delete all the drawing tools, right click on the chart then select 'Delete all studies' in the menu. 

  

5. Saving drawing tools Settings 
  

To save a drawing tool settings: 
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 Right click on that drawing item  
 Update the settings according to your preference  
 Click on 'Save Settings' button to save setting for the selected drawing tool type (Example: 

Triangle)  
 Click on "Default" to get the default settings (As specified in the drawing tool toolbar) 

  
  

6. Save/Load drawing data 
  

To save drawing data of a specific pane: 

- Right click on the pane (chart) 

- Select "Tools" then click on "Save Drawing Data" 

- Type a file name then click on "Save" 

- Click on "Load Drawing Data" to load data from a file 

  

7. Shortcuts 
  

Copy Item: Select a drawing item then use CONTROL+C shortcut ("Drawing Item Copied" is displayed 

on the chart) 

Paste Item: Use the CONTROL+V shortcut ("Drawing Item Created" is displayed on the chart) 

Disable "Stick To": Use CONTROL to disable temporarily the "Stick To" option 

  

8. Custom Drawing Tools 
  

You can use the custom drawing tools plug-in to create your own drawing items. Please refer to the 

Plug-ins folder for more information. 

[TOP] 

1.3.5 Auto drawing tools 

Auto Drawing Tools 

 

Auto drawing is a feature that automatically draws on a chart whenever a chart symbol changes or a 

new chart window opens. 

 

You have to choose which drawing tools you want to use, then specify the number of days to use and 

the application will take care of the drawing. 

The drawing generated by this feature is locked. 

To unlock it, just right click on the drawing then uncheck 'lock position'.  



62 QuantShare | http://www.quantshare.com 
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[TOP] 

1.4 Symbols 

Symbols 

 

A symbol references a stock, an option, an index, a composite...  

 

1. Add Symbols 
  

To add symbols to your database (Symbol->Add Symbols) 

You can add symbols in two ways: 

1 – Insert comma separated symbols in the field then click on 'Add' 

2 – Specify a file that contains a list of comma separated symbols. 

 

You can also add symbols by downloading a list of symbols from the Sharing Server. 

List of symbols are a collection of symbols shared by other users. 

After you download a list of symbols. Select "Symbols" in the application main menu, then click on 

"Add-Remove from list of symbols". Click on "Select" to select a list, then click on "Add". 

  

2. Remove Symbol 
  

Select (Symbol -> Update Symbols) 

Browse through the symbols and click on 'Remove' on the symbol you want to delete. 

 

NB: Use the bulk symbol updater to remove many symbols at once. 

 

You can also remove symbols that belong to a list of symbols. To do so, select "Symbols" in the 

application main menu, then click on "Add-Remove from list of symbols".  Click on "Select" to select a 

list, then click on "Remove". 

  

3. Update Symbols 
  

Select (Symbol->Update Symbols) 
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You can update all symbols' information within this form. 

After you have done, click on 'Update'. 

NB: Use the bulk symbol updater to update many symbols at once. 

  

4. Manage Symbols (Bulk Updated) 

The Bulk Updater allows you to edit multiple symbols very quickly. (Symbol -> Manage Symbols) 
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- To open the Symbols Manager form, select "Symbol" in the main menu then click on 
"Manage Symbols". 

- You can filter symbols by updating fields under "Filter" panel. 

- Under the "Select" column, you can check one or several rows. You can then remove theses 
symbols by click on "Remove Selected Symbols". 

- To update one or several fields, select them using your mouse, set a value next to "Update 
Selected Cells" then click on "Update" or "Append". 

- You can select all columns fields, copy or replace data by right clicking on the symbols grid. 

- Once you are done editing symbols data, click on "Save Changes" button. 
 

5. Create a list of symbols (Export) 

 

There are two ways to create a list of symbols: 

  Select "Symbols" then click on "Create a list of symbols". Specify the symbols to 

include using the "Symbols Selection Control" then click on "Create"  



66 QuantShare | http://www.quantshare.com 

 

 Select "Symbols" then click "Create a list of symbols from a file". Type a separator then click 

on "Load file" to load a file that contains your symbols. The first row lets you specify the type 

of each column. For example: the symbol name should be associated with the keyword 

"name". After you finish, click on "Create List". 

You can use this list to add symbols in another account, or you can share this list, so other members 

can use it. They will thank you. 

 

6. Symbols View 

The Symbols View form displays the different symbol lists (Also called Symbols Filters) that you have 

created. 

You can for example create a list of NASDAQ Stocks, another one for Penny Stocks... 

These lists can be referenced in plug-ins such as Watchlist, Screener, Simulator... 

To open the Symbols View form: 

- Select "Symbol" then "Symbols View" (Extended menu) 

To create a new list: 

- Right click on the form 

- Click on "Create a new Symbols Filter" 

- To add a new condition, click on the "Add a condition" link 

- When done, click on "OK" 

- Click on "+" to display all symbols in your list 

You can also directly create new lists from the "Symbols Filter" control, by clicking on the "Save" link. 

To edit a list: 

- Right click on a list 

- Click on "Edit Symbols Filter" 

To remove one or several lists: 

- Right click on a list 

- Click on "Manage Symbols Filter" 

- Check one or several lists 

- Click on "+" to expand the menu (It not already done) 

- Click on "Remove Items" 

To remove a symbol from a list: 

- You can update the list and add a new condition 

- Or you can right click on a symbol and select "Remove Symbol from List" 

In the second solution, a new condition is automatically added to your Symbols Filter. 

To download data for all symbols in a list: 

- Right click on a list 
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- Select "Download Data" 

- Click on the appropriate downloader 

  

7. Auto-Manage Symbols 

Using this tool, QuantShare will track securities traded on selected exchanges and update 

your database automatically a new security is added, removed or updated. 

To open this control, select "Symbols" then "Auto-Manage Symbols". 

Force the update of symbol information: 

This will force the update of symbol information (Names, title, industry, indices...) for all 

securities in your database. 

Actions: 

This allows you to control the action to take when a new security is found, updated or removed: 

Add with confirmation: Display a confirmation box before adding new symbols 

Add without confirmation: Add new symbols silently 

Ignore: Do not add new symbols 

Symbol Names: 

Select the symbol name to store in the "Name", "Name1", "Name2" and "Name3" fields. 

 

Example: (Anglo American PLC) 

Exchange Symbol: AAUKF 

Yahoo Symbol: AAUKF.PK 

Google Symbol: AAUKF:PINK 

Bloomberg Symbol: AAUKF:PINKSHEETS 

Example: 

If you want to track U.S. Exchanges: 

 

- Check "American Stock Exchange", "NASDAQ" and "New York Stock Exchange" 

- Click on "Save". 

  

[TOP] 

1.4.1 Symbols 

Symbols 
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A symbol references a stock, an option, an index, a composite...  

 

1. Add Symbols 
  

To add symbols to your database (Symbol->Add Symbols) 

You can add symbols in two ways: 

1 – Insert comma separated symbols in the field then click on 'Add' 

2 – Specify a file that contains a list of comma separated symbols. 

 

You can also add symbols by downloading a list of symbols from the Sharing Server. 

List of symbols are a collection of symbols shared by other users. 

After you download a list of symbols. Select "Symbols" in the application main menu, then click on 

"Add-Remove from list of symbols". Click on "Select" to select a list, then click on "Add". 

  

2. Remove Symbol 
  

Select (Symbol -> Update Symbols) 

Browse through the symbols and click on 'Remove' on the symbol you want to delete. 

 

NB: Use the bulk symbol updater to remove many symbols at once. 

 

You can also remove symbols that belong to a list of symbols. To do so, select "Symbols" in the 

application main menu, then click on "Add-Remove from list of symbols".  Click on "Select" to select a 

list, then click on "Remove". 

  

3. Update Symbols 
  

Select (Symbol->Update Symbols) 
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You can update all symbols' information within this form. 

After you have done, click on 'Update'. 

NB: Use the bulk symbol updater to update many symbols at once. 

  

4. Manage Symbols (Bulk Updated) 

The Bulk Updater allows you to edit multiple symbols very quickly. (Symbol -> Manage Symbols) 
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- To open the Symbols Manager form, select "Symbol" in the main menu then click on 
"Manage Symbols". 

- You can filter symbols by updating fields under "Filter" panel. 

- Under the "Select" column, you can check one or several rows. You can then remove theses 
symbols by click on "Remove Selected Symbols". 

- To update one or several fields, select them using your mouse, set a value next to "Update 
Selected Cells" then click on "Update" or "Append". 

- You can select all columns fields, copy or replace data by right clicking on the symbols grid. 

- Once you are done editing symbols data, click on "Save Changes" button. 
 

5. Create a list of symbols (Export) 

 

There are two ways to create a list of symbols: 

  Select "Symbols" then click on "Create a list of symbols". Specify the symbols to 

include using the "Symbols Selection Control" then click on "Create"  



71 QuantShare | http://www.quantshare.com 

 

 Select "Symbols" then click "Create a list of symbols from a file". Type a separator then click 

on "Load file" to load a file that contains your symbols. The first row lets you specify the type 

of each column. For example: the symbol name should be associated with the keyword 

"name". After you finish, click on "Create List". 

You can use this list to add symbols in another account, or you can share this list, so other members 

can use it. They will thank you. 

 

6. Symbols View 

The Symbols View form displays the different symbol lists (Also called Symbols Filters) that you have 

created. 

You can for example create a list of NASDAQ Stocks, another one for Penny Stocks... 

These lists can be referenced in plug-ins such as Watchlist, Screener, Simulator... 

To open the Symbols View form: 

- Select "Symbol" then "Symbols View" (Extended menu) 

To create a new list: 

- Right click on the form 

- Click on "Create a new Symbols Filter" 

- To add a new condition, click on the "Add a condition" link 

- When done, click on "OK" 

- Click on "+" to display all symbols in your list 

You can also directly create new lists from the "Symbols Filter" control, by clicking on the "Save" link. 

To edit a list: 

- Right click on a list 

- Click on "Edit Symbols Filter" 

To remove one or several lists: 

- Right click on a list 

- Click on "Manage Symbols Filter" 

- Check one or several lists 

- Click on "+" to expand the menu (It not already done) 

- Click on "Remove Items" 

To remove a symbol from a list: 

- You can update the list and add a new condition 

- Or you can right click on a symbol and select "Remove Symbol from List" 

In the second solution, a new condition is automatically added to your Symbols Filter. 

To download data for all symbols in a list: 

- Right click on a list 
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- Select "Download Data" 

- Click on the appropriate downloader 

  

7. Auto-Manage Symbols 

Using this tool, QuantShare will track securities traded on selected exchanges and update 

your database automatically a new security is added, removed or updated. 

To open this control, select "Symbols" then "Auto-Manage Symbols". 

Force the update of symbol information: 

This will force the update of symbol information (Names, title, industry, indices...) for all 

securities in your database. 

Actions: 

This allows you to control the action to take when a new security is found, updated or removed: 

Add with confirmation: Display a confirmation box before adding new symbols 

Add without confirmation: Add new symbols silently 

Ignore: Do not add new symbols 

Symbol Names: 

Select the symbol name to store in the "Name", "Name1", "Name2" and "Name3" fields. 

 

Example: (Anglo American PLC) 

Exchange Symbol: AAUKF 

Yahoo Symbol: AAUKF.PK 

Google Symbol: AAUKF:PINK 

Bloomberg Symbol: AAUKF:PINKSHEETS 

Example: 

If you want to track U.S. Exchanges: 

 

- Check "American Stock Exchange", "NASDAQ" and "New York Stock Exchange" 

- Click on "Save". 

  

[TOP] 

1.4.2 Symbols Selection 

Symbols Selection 
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1. Symbols selection control 
  

You will often need to select certain symbols among the list of all available symbols. 

Whether it is for creating a composite, a trading system or a watch-list, selecting symbols from the 

"Symbols Selection" control is easy.  

We have created a unique control that is used by all the plug-ins. 

  

 
 

 

You can select symbols using a single or a combination of filters: 

  

         By group: Select symbols that belongs to specified groups 

         By sector: Select symbols that belongs to specified sectors 

         By Industry: Select symbols that belongs to specified industries 

         By Index: Select symbols that belongs to specified indexes 

         By Market: Select symbols that belongs to specified markets 

         Custom symbols (list): Enter manually the symbols you want to include. 

         Random Symbols:  Type a value from 0 to 100. Zero means select no symbols, and 100 

means select all symbols. 

         Internal List:  Select symbols from a watchlist or portfolio 

         Quotes:  Select symbols based on pre-calculated data (Example: Date of last quote, Close 

price...) 
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         Drawing:  Select symbols based on pre-calculated data (Example: Distance to support). 

Works only when you use the support/resistance drawing tool.  

         Symbols Info: Select symbols based on security information 

  

In order for a symbol to be selected, it must pass all the filters. 

You can also make the filter act differently (Opposite) by clicking on the icon as shown in the picture 

below. 

You can also add the "Union" condition between two filters so that symbols of each filter are added 

to the final list. 

 

 

  

Example: 

Total symbols: 8000. 

Filter1: Random; 50 percent. Number of symbols that passed the filter: 4000. 

Number of symbols selected: 4000 symbols. 

  

Filter2: Symbols whose names begin with 'a'. Number of symbols that passed the filter: 700. 

Number of symbols selected: 380 symbols. 
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Because of the way the 'Random' filter is used in this selection process, if you run these filters again, 

you may end up with slightly different number of symbols. 

  

  

2. Custom Filters (Quotes, Drawing and Symbols Info) 
  

When selecting a custom filter, you can use pre-calculated data to filter symbols. 

A Pre-calculated data can be a number, a text, a date or a boolean (true or false). 

For each type you have to enter or select one or more values in order to create the filter. 

  

Numeric: 

Example: number of drawing objects => Quotes Filter 

 

 
 

You have to specify the start and the end values. All symbols that have a number of drawing objects 

within these values will be selected. 

 

Date: 

Example: date of last quote => Quotes Filter 

 

 

You have to specify the start date and the end date. 

  

Boolean: 

Example: active symbols (active) => Symbols Info Filter 
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You have to choose between TRUE or FALSE. 

  

Text: 

Example: symbol name (name) => Symbols Info Filter 

 

You have to enter one or more values. Values are separated by semicolon. 

A value can contain the following characters: (multiply *), (point .) 

Examples: 

A: select the symbol which name is 'A'. 

A*: select symbols whose name start with 'A'. 

A.(1 point): select symbols whose names start with 'A' and have only two characters. 

A..(2 points): select symbols whose names start with 'A' and have only three characters. 

*A*: select symbols whose names contain the character 'A'. 

A*;B*: select symbols whose names start with 'A' or 'B'. 
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[TOP] 

1.4.3 Symbols by Industry/Sector 

Symbols by Industry/Sector 
 

1. Display Symbols by Industry/Sector 

This view displays the different sectors, industries, indices, markets and groups and shows stocks that 

belong to each item. 

To open this view, select "Symbol -> Symbols by Industry/Sector" 

Make sure your stocks are associated with the different industries, sectors or indices. 

You can do that manually (Symbol -> Update Symbol) or automatically using (Symbol -> Auto Manage 

Symbols -> Select some exchanges -> Check "Force the update of symbol information" -> Click on 

"Save") 

You can also filter symbols by clicking on the "Filter" button. In the new control, you can add one or 

several conditions to choose which stocks to display in the "Symbols by Industry/Sector" view. 

[TOP] 

1.5 Data 

Databases 

  

There are several types of databases: 

 Quote database  
 Intraday database  
 Tick database  
 Custom database  

  
The quote database contains EOD data 

The intraday database contains data from intraday time frames (Example: one-minute, 10-minute, 1-

hour...) 

The tick database contains tick data (Date, Price, Volume, Type {Last, Bid or Ask}) 

The custom database may contain any text or numeric data.  

Example: news database, fundamental database 

The custom database can be a daily or an intraday database. 

A daily database is a database where each row corresponds to a date while in an intraday database 

each row corresponds to a date and a time. 

  

1. Create a custom database 
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In 'Data' menu; click on 'Edit databases'. (Data->Edit databases) 

In the new form, click on the tab' name 'Creator'. 

 

Type in the name and the type (Historical or Intraday) of the database then click on 'Add new custom 

database'.  

 

  

2. Delete a custom database 
  

In 'Data' menu; click on 'Edit databases'. (Data->Edit databases) 

In the new form, click on the tab' name 'Creator'. 

Select a database in the 'Choose database name' combo box, then click on 'Delete'. 

 

  

3. View data contained in a custom database 
  

In 'Data' menu; click on 'Edit databases'. 

In the new form, select 'Custom' in the 'Choose a database' combo box, then select a database name 

in the 'Choose database name' combo box. 

Browse symbols by selecting a symbol in the 'Choose a symbol'. The database data, if any, should 

appears on the grid. 
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4. Add a field in your database 
  

- Select a custom database. 

- Type the field name in the text box near the button 'Add new field' 

- Select the field type in the combo box located above the text box 

- Click on 'Add new field'. A new field will appear in the grid. 

Descriptive name and snapshot 

The Snapshot feature instructs the application to save the last numbers/data of each custom 

database field. 

If you set the "Save last numbers (snapshot)" option to TRUE for a database field ("Field Info" panel 

in "Edit databases" form) then: 

- Each time new data is added to this field, the application saves the last value of each symbol in an 

internal database. 

The database will contain historical data and the internal database will get only the last values. 

This allows you to quickly access this data and select symbols (In "Symbols Filter" form) based on 

these numbers. 

The "Descriptive name" field allows you to specify a descriptive name for a database field. 

 

Example: 

- Download fundamental data from (http://www.quantshare.com/item-606-fundamental-valuation-

ratios-for-us-stocks) 

- Set the "SnapShot" feature to each field of the database created by the above downloader 

- Select "Analysis" then "Quick Screener" 

http://www.quantshare.com/item-606-fundamental-valuation-ratios-for-us-stocks
http://www.quantshare.com/item-606-fundamental-valuation-ratios-for-us-stocks
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- Add a new condition (based on the previous fundamental database) 

- Select "PEG" ratio 

- Select an internal (Max and min values) to find the stocks that meet this criteria 

  

Here is how to add the Snapshot feature to a database field: 

- Select "Data" then "Edit databases" 

- Select "Custom" then chooses a custom database 

- Select a symbol 

- In "Field Info" panel, select a field next to "Field Name" 

- Check "Save last numbers" 

- Type a descriptive name then click on "Save" to enable the Snapshot feature for the selected field 

  

5. Remove a field in your database 
  

Select a custom database. 

Click on the 'Remove this field' button, select the field you want to remove, and then click 'OK'. 

 

6. Fill a database field 
  

Select a custom database. 

Type a value on the text box near the button 'Fill field'. 

Click on the 'Fill field' button, select the field you want to fill then click 'OK'. 

 

 

7. Fill a custom database 
  

Right click on the grid then select 'add line' or 'add multiple lines'. 

 

8. Save and Undo changes 
  

Quotes and custom databases data can be modified manually in the grid. 

You have to click on 'Save' to save the new data. 

Click on 'Undo changes' button to undo all your previous changes. 

 

  

9. Export data 
  

The 'Export to CSV' button is used to export the current grid data to CSV.  

 

  

10. Delete data 
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Delete data for a single symbol 

- Select "Data" then "Edit Databases" 

- Select the "Quotes", "Tick", "Intraday" or a "Custom" database 

- Select a symbol in "Symbols" panel 

- Right click on the grid/table that contains the data and select "Remove all rows" 

- Click on "Save" 

 

Delete data from a database for a date range 

- Select "Data" then "Edit Databases" 

- Select "Manage databases" tab 

- In "Delete database data" panel, select a database, a list of symbols, the start and end dates 

- Click on "Delete" to remove data 

[TOP] 

1.5.1 Databases 

Databases 

  

There are several types of databases: 

 Quote database  
 Intraday database  
 Tick database  
 Custom database  

  
The quote database contains EOD data 

The intraday database contains data from intraday time frames (Example: one-minute, 10-minute, 1-

hour...) 

The tick database contains tick data (Date, Price, Volume, Type {Last, Bid or Ask}) 

The custom database may contain any text or numeric data.  

Example: news database, fundamental database 

The custom database can be a daily or an intraday database. 

A daily database is a database where each row corresponds to a date while in an intraday database 

each row corresponds to a date and a time. 

  

1. Create a custom database 
  

In 'Data' menu; click on 'Edit databases'. (Data->Edit databases) 

In the new form, click on the tab' name 'Creator'. 
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Type in the name and the type (Historical or Intraday) of the database then click on 'Add new custom 

database'.  

 

  

2. Delete a custom database 
  

In 'Data' menu; click on 'Edit databases'. (Data->Edit databases) 

In the new form, click on the tab' name 'Creator'. 

Select a database in the 'Choose database name' combo box, then click on 'Delete'. 

 

  

3. View data contained in a custom database 
  

In 'Data' menu; click on 'Edit databases'. 

In the new form, select 'Custom' in the 'Choose a database' combo box, then select a database name 

in the 'Choose database name' combo box. 

Browse symbols by selecting a symbol in the 'Choose a symbol'. The database data, if any, should 

appears on the grid. 
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4. Add a field in your database 
  

- Select a custom database. 

- Type the field name in the text box near the button 'Add new field' 

- Select the field type in the combo box located above the text box 

- Click on 'Add new field'. A new field will appear in the grid. 

Descriptive name and snapshot 

The Snapshot feature instructs the application to save the last numbers/data of each custom 

database field. 

If you set the "Save last numbers (snapshot)" option to TRUE for a database field ("Field Info" panel 

in "Edit databases" form) then: 

- Each time new data is added to this field, the application saves the last value of each symbol in an 

internal database. 

The database will contain historical data and the internal database will get only the last values. 

This allows you to quickly access this data and select symbols (In "Symbols Filter" form) based on 

these numbers. 

The "Descriptive name" field allows you to specify a descriptive name for a database field. 

 

Example: 

- Download fundamental data from (http://www.quantshare.com/item-606-fundamental-valuation-

ratios-for-us-stocks) 

- Set the "SnapShot" feature to each field of the database created by the above downloader 

- Select "Analysis" then "Quick Screener" 

http://www.quantshare.com/item-606-fundamental-valuation-ratios-for-us-stocks
http://www.quantshare.com/item-606-fundamental-valuation-ratios-for-us-stocks
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- Add a new condition (based on the previous fundamental database) 

- Select "PEG" ratio 

- Select an internal (Max and min values) to find the stocks that meet this criteria 

  

Here is how to add the Snapshot feature to a database field: 

- Select "Data" then "Edit databases" 

- Select "Custom" then chooses a custom database 

- Select a symbol 

- In "Field Info" panel, select a field next to "Field Name" 

- Check "Save last numbers" 

- Type a descriptive name then click on "Save" to enable the Snapshot feature for the selected field 

  

5. Remove a field in your database 
  

Select a custom database. 

Click on the 'Remove this field' button, select the field you want to remove, and then click 'OK'. 

 

6. Fill a database field 
  

Select a custom database. 

Type a value on the text box near the button 'Fill field'. 

Click on the 'Fill field' button, select the field you want to fill then click 'OK'. 

 

 

7. Fill a custom database 
  

Right click on the grid then select 'add line' or 'add multiple lines'. 

 

8. Save and Undo changes 
  

Quotes and custom databases data can be modified manually in the grid. 

You have to click on 'Save' to save the new data. 

Click on 'Undo changes' button to undo all your previous changes. 

 

  

9. Export data 
  

The 'Export to CSV' button is used to export the current grid data to CSV.  

 

  

10. Delete data 
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Delete data for a single symbol 

- Select "Data" then "Edit Databases" 

- Select the "Quotes", "Tick", "Intraday" or a "Custom" database 

- Select a symbol in "Symbols" panel 

- Right click on the grid/table that contains the data and select "Remove all rows" 

- Click on "Save" 

 

Delete data from a database for a date range 

- Select "Data" then "Edit Databases" 

- Select "Manage databases" tab 

- In "Delete database data" panel, select a database, a list of symbols, the start and end dates 

- Click on "Delete" to remove data 

[TOP] 

1.5.2 Application Objects 

Application Objects 
 

  

1. Introduction 

  

We use the word 'object' or 'item' to point out: 

  

         Trading systems 

         Watch-list 

         Composite indexes 

         List of rules 

         List of symbols 

         Simulator metrics 

         ... 

  

All these objects share some common controls.  

These controls are used to manage, save and load these objects. 
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Each object is stored in a specific file. 

To rename an object, double click on its name, and then type a new name. 

An object can either belong to a category or not. 

These objects can be shared, you can visit www.quantshare.com for a list of all shared objects. 

  

The majority of the plug-ins have drag & drop features that let you drag objects and drop them on 

widget or bookmark panels. 

 

2. Bookmark panel 

  

 

  

This panel hosts folders and objects (generally shortcuts of objects are used) 

Right click on the bookmark panel to open a menu. Using this menu, you can create a new folder, 

add an object or object shortcut, update a folder name... 

You can drag and drop objects within the bookmark panel to change their locations or to move them 

from a folder to another. 

http://www.quantshare.com/
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Right click on any object to display a menu. The menu content is specific to each object type. 

 

Example: 'Trading system' object menu. 
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[TOP] 

1.5.3 Metastock Plug-In 

MetaStock Plug-In 

 

1. How to Read MetaStock Data 

You can use the Metastock plug-in to read data from Metastock databases instead of QuantShare 

databases. 

To enable this plug-in: 

 

- Select "Download" then "External Database" 

- Check "Metastock Database" 

- Click on "Settings" 

- Click "Add Folder" then select one or several Metastock folders (QuantShare will read all sub-folders 

and add all the available Metastock databases) 

- Click "OK" 

  

In the next screen, you have the following options: 

Add new symbols to QuantShare: Check this field to add Metastock symbols to your QuantShare 

symbols list (If they do not already exist) 

Enable EOD data: Check this field to allow QuantShare to read EOD data from the Metastock 

database (Otherwise QuantShare EOD database will be used) 

Enable Intraday data: Check this field to allow QuantShare to read intraday data from the Metastock 

database (Otherwise QuantShare Intraday database will be used) 

- Click on "OK" to close the settings control 

- Click on "OK" to save settings 

Now, each time you read data from the Metastock database, a "Metastock" label appears on the 

chart (on the top-right corner). This tells you that the data of this security comes from the Metastock 

database. 

[TOP] 

1.6 QuantShare Language 

QuantShare Language 
  

  

1. Introduction 
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QuantShare language is a simple, complete and fast scripting language. 

It is a vector based language and contains more than 200 build-in functions and indicators. 

Example of a vector-based language: if you type 'a = 1'. 

The variable 'a' will be represented as an array of N elements (N represent the number of bars for a 

specific symbol) where each element of the array has a value of '1'. 

Other examples: 

c = close;  

This is the representation of the 'c' variable. 

 

 

 

The current symbol has 10 quotes (elements).  

The first column represents the first bar or bar number '0'.  

If we type now: c = close + 2; 

The representation of the 'c' variable will be: 

 

 

 

We added "2" to each element of the array. 

You can see these arrays at any time using the debugger tool. (Right click on the editor). 

 

In the next example, we will use a very common function 'ref', this function let you refer to old or 

future quotes.  

c = ref (close, 1) makes the array shift by one bar to the right. 

  

 

 

 

'NA' means that the element of the array contains no data. 

 

2. Basic Concepts 
  

A variable can be a number or a string.  

10.5 11 11.2 11 10.8 10.5 10 10 10.3 11.2 

12.5 13 13.2 13 12.8 12.5 12 12 12.3 13.2 

NA 10.5 11 11.2 11 10.8 10.5 10 10 10.3 



90 QuantShare | http://www.quantshare.com 

 

v1 = "test"; (assign the text 'test' to the variable 'v1'). 

v2 = 2; (assigns the number 2 to the variable v2). 

 

You cannot do math calculation using both numeric and text variables. 

v3 = v2 + 2; (Correct) 

v3 = v2 + v1; (Not Correct)  

To concatenate two string variables or a string and a numeric variables: use "." (Point) 

v3 = "test ".v2." test"; 

There are two types of functions: 

 Void function or function that does not return a value  
Example: 'Plot' function plots a time-series on a chart. 

 Functions that returns a numeric or a string array  
Example: 'Rsi' (Relative strength index indicator) returns a numeric array. 

  

3. Edit a formula 

 

Click on 'New Chart' in the 'View' menu to open a new chart. 

Right click on the chart and click on 'Edit Formula'; the formula editor will open. 

  

4. Add functions 
  

There are two ways to add a function:  

 You can add a function by typing it in the formula editor.  
 You can add a function by clicking on the 'Add Method' or 'Add Indicator' buttons; the 

'Function selector' form will appear. 
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5. Function Selection 

  

 



92 QuantShare | http://www.quantshare.com 

 

  

  

6. Functions to plot time-series 
  

Here is the list of the functions that let you plot data: 

 Plot: plots a vector; you can specify the color, the graph type...  
 Plot1: plots two vectors, example: higher and lower Bollinger bands.  
 PlotCandleStick: plots an OHLC chart  
 PlotFixed: plots a fixed chart, example: average performance per day of the week or volatility 

for the next ten days per Relative Strength Index values  
 PlotSymbol: plots symbols above or below other graphs.  
 SetMaxScale: sets the Y-Axis maximum value.  
 SetMinScale: sets the Y-Axis minimum value.  
 SetScale: sets the Y-Axis maximum and minimum value.  
 UpdateColor: updates a graph color, on certain X-Axis values.  

  

7. Update formulas dynamically 
  

Move the mouse over a graph then right click, a small form will appear. 

Tabs shown on that form refers to functions available in your formula. 

If for example your formula is: 

r = rsi (14); 

Plot(r, "RSI", colorRed, ChartLine, StyleOwnScale);  

Two tabs will be available (Rsi and Plot). 

Under Rsi tab there is a cell whose name is 'timePeriod'; this cell has a value of "14". 

Click on that value, and update it using the numeric text box or the track bar. 

See how the graph updates dynamically while you change this value. 

  

 

Click on the green button to make the form stick. 
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8. AutoComplete tool 
  

In the 'Formula Editor', press on CTRL+SPACE, a list of 'Void' functions appears. 

Now type something like 'a = ', then press on CTRL+SPACE, another list appears; this list contains all 

'Return' functions. 

 

  

There is also an 'AutoComplete' button on the 'Formula Editor'; click on that button, then type in 

something in the editor, the 'AutoComplete' list now appears each time you type in a letter.  

  

9. Tooltip information 
  

Tooltip shows you information about functions. 

There are two kinds of Tooltip; one that appear right after you type in '(', example: 'Plot ('. 

The other Tooltip appear when you move the mouse over a function. 
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10. Debugger 
  

The debugger displays the elements of the variables initialized within the formula. 

In the 'Formula Editor', right click on the editor. 

 

You can export debug data by right clicking on the table then selecting "Export Data". 

You will be promoted to enter the file name to save the table content in a CSV format. 

 

  

  

11. Formula errors 
  

When typing a formula, an icon located at the top shows you whether your formula syntax is correct 

or not, clicking on that icon shows you the formula errors if any. 

The icon is red when there is an error otherwise it is blue. 

The location of the error is underlined with a dotted line. 
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Click on "X" icon next to "Add Indicator" button to display the error message. 
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[TOP] 

1.6.1 QuantShare Language 

QuantShare Language 
  

  

1. Introduction 
  

QuantShare language is a simple, complete and fast scripting language. 

It is a vector based language and contains more than 200 build-in functions and indicators. 

Example of a vector-based language: if you type 'a = 1'. 

The variable 'a' will be represented as an array of N elements (N represent the number of bars for a 

specific symbol) where each element of the array has a value of '1'. 

Other examples: 

c = close;  

This is the representation of the 'c' variable. 

 

 

 

The current symbol has 10 quotes (elements).  

The first column represents the first bar or bar number '0'.  

If we type now: c = close + 2; 

The representation of the 'c' variable will be: 

 

 

 

We added "2" to each element of the array. 

You can see these arrays at any time using the debugger tool. (Right click on the editor). 

 

In the next example, we will use a very common function 'ref', this function let you refer to old or 

future quotes.  

c = ref (close, 1) makes the array shift by one bar to the right. 

  

10.5 11 11.2 11 10.8 10.5 10 10 10.3 11.2 

12.5 13 13.2 13 12.8 12.5 12 12 12.3 13.2 

NA 10.5 11 11.2 11 10.8 10.5 10 10 10.3 
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'NA' means that the element of the array contains no data. 

 

2. Basic Concepts 
  

A variable can be a number or a string.  

v1 = "test"; (assign the text 'test' to the variable 'v1'). 

v2 = 2; (assigns the number 2 to the variable v2). 

 

You cannot do math calculation using both numeric and text variables. 

v3 = v2 + 2; (Correct) 

v3 = v2 + v1; (Not Correct)  

To concatenate two string variables or a string and a numeric variables: use "." (Point) 

v3 = "test ".v2." test"; 

There are two types of functions: 

 Void function or function that does not return a value  
Example: 'Plot' function plots a time-series on a chart. 

 Functions that returns a numeric or a string array  
Example: 'Rsi' (Relative strength index indicator) returns a numeric array. 

  

3. Edit a formula 

 

Click on 'New Chart' in the 'View' menu to open a new chart. 

Right click on the chart and click on 'Edit Formula'; the formula editor will open. 

  

4. Add functions 
  

There are two ways to add a function:  

 You can add a function by typing it in the formula editor.  
 You can add a function by clicking on the 'Add Method' or 'Add Indicator' buttons; the 

'Function selector' form will appear. 
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5. Function Selection 
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6. Functions to plot time-series 
  

Here is the list of the functions that let you plot data: 

 Plot: plots a vector; you can specify the color, the graph type...  
 Plot1: plots two vectors, example: higher and lower Bollinger bands.  
 PlotCandleStick: plots an OHLC chart  
 PlotFixed: plots a fixed chart, example: average performance per day of the week or volatility 

for the next ten days per Relative Strength Index values  
 PlotSymbol: plots symbols above or below other graphs.  
 SetMaxScale: sets the Y-Axis maximum value.  
 SetMinScale: sets the Y-Axis minimum value.  
 SetScale: sets the Y-Axis maximum and minimum value.  
 UpdateColor: updates a graph color, on certain X-Axis values.  

  

7. Update formulas dynamically 
  

Move the mouse over a graph then right click, a small form will appear. 

Tabs shown on that form refers to functions available in your formula. 

If for example your formula is: 

r = rsi (14); 

Plot(r, "RSI", colorRed, ChartLine, StyleOwnScale);  

Two tabs will be available (Rsi and Plot). 

Under Rsi tab there is a cell whose name is 'timePeriod'; this cell has a value of "14". 

Click on that value, and update it using the numeric text box or the track bar. 

See how the graph updates dynamically while you change this value. 

  

 

Click on the green button to make the form stick. 
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8. AutoComplete tool 
  

In the 'Formula Editor', press on CTRL+SPACE, a list of 'Void' functions appears. 

Now type something like 'a = ', then press on CTRL+SPACE, another list appears; this list contains all 

'Return' functions. 

 

  

There is also an 'AutoComplete' button on the 'Formula Editor'; click on that button, then type in 

something in the editor, the 'AutoComplete' list now appears each time you type in a letter.  

  

9. Tooltip information 
  

Tooltip shows you information about functions. 

There are two kinds of Tooltip; one that appear right after you type in '(', example: 'Plot ('. 

The other Tooltip appear when you move the mouse over a function. 
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10. Debugger 
  

The debugger displays the elements of the variables initialized within the formula. 

In the 'Formula Editor', right click on the editor. 

 

You can export debug data by right clicking on the table then selecting "Export Data". 

You will be promoted to enter the file name to save the table content in a CSV format. 

 

  

  

11. Formula errors 
  

When typing a formula, an icon located at the top shows you whether your formula syntax is correct 

or not, clicking on that icon shows you the formula errors if any. 

The icon is red when there is an error otherwise it is blue. 

The location of the error is underlined with a dotted line. 
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Click on "X" icon next to "Add Indicator" button to display the error message. 
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[TOP] 

1.6.2 Composite Function 

Composite Function 

 

1. Introduction 

"Comp" is a very powerful function that lets you create indicators and rules based on 

aggregate data of several securities (quotes, technical indicators, fundamental data...).  

With a single line, you can for example instruct QuantShare to create a trading system that 

buys stocks when the difference between their close price and moving average is two times 

higher than the standard deviation of the same formula for all US stocks. 

For the difference between the composite function and the composite plug-in, please look 

at: 

http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-

composite-tools 

 

2. Functions Parameters 

The composite function name is "Comp" and it has several parameters: 

Array: This is the array or time-series that will be used when calculating the composite 

Calculation Method: The calculation method to use. Example: "Avg" computes for each 

trading bar the average value of the same bar (date/time) for all symbols included in the 

composite calculation. 

Group: Performs a separate calculation for each group. Example, by passing "Industry()" to 

this parameter, the calculation will be performed independently for each industry. 

Filter: Allows you to ignore securities during the calculation. Example: "close > 2" instructs 

the composite function to include only stocks that have a price higher than $2. 

Symbols Filter: Allows you to define a list of symbols to include in the composite calculation. 

By default, all symbols in an analysis are included. For example, if you are backtesting 

NASDAQ stocks, then when calling "comp" function, only NASDAQ stocks will be used. 

In this field, you can specify a symbols filter name (Symbol -> Symbols View) or a list of 

symbols separated by semi-colons (GOOG;MSFT;C;AAPL). 

 

3. Calculation Methods 

Count: For each trading bar, calculates the number of securities. 

Sum: For each trading bar, calculates the sum of the different values. 

Avg: For each trading bar, calculates the average of the different values. 

http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-composite-tools
http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-composite-tools
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Max: For each trading bar, gets the maximum value. 

Min: For each trading bar, gets the minimum value. 

Sdv: For each trading bar, calculates the standard deviation of the different values. 

Rank: For each trading bar, returns the rank of each stock. 

Percentile: For each trading bar, returns the percentile rank of each stock. 

!Rank: For each trading bar, returns the rank of each stock. Securities that have the same 

value get the same rank. For more information, please read the following article: 

http://www.quantshare.com/sa-179-new-ranking-and-percentile-composite-functions 

!Percentile: For each trading bar, returns the percentile rank of each stock. Securities that 

have the same value get the same percentile rank. 

 

Examples: 

Comp(1, "count") 

This creates a market indicator that calculates the number of stocks that have quotes for each bar. 

Comp(close > sma(30), "sum") 

Here is a market indicator that calculates the number of stocks that closed above their 30-bar simple 

moving average. 

Comp(rsi(14), "avg") 

This trading indicator calculates the average RSI or relative strength index value of all stocks or 

securities included in the analysis. You can then compare this composite to the oversold or 

overbought threshold levels and determine whether the market is bullish or bearish based on the 

relative strength index interpretation. 

Comp(GetData("fund", "mkcap") * close, "avg") 

Here is how to create a capitalization-weighted market index. Take the time-series that corresponds 

to the market capitalization data of your stock and then multiply that value by the close price. By 

applying the composite's average method to this formula, you can produce your custom 

capitalization-weighted index. 

Comp(perf(close, 1), "Max") 

A trading indicator that calculates the maximum stock increase from previous close, among all stocks 

in your list of symbols. 

Comp(perf(close, 1), "Sdv") 

This trading indicator calculates the standard deviation of the different one-bar stock's returns that 

occurred on the same date. This is a measure of volatility; the market indicator will show you how 

the volatility of the one-bar stock's returns evolves over time. 

Comp(perf(close, 1), "Rank") <= 5 

The above trading rule returns the top 5 stocks that have the highest one-bar rate of return. 

 

Comp(volume, "Percentile") >= 90 

This volume-based trading rule gets stocks that are in the top 10% of stocks with the highest volume 

http://www.quantshare.com/sa-179-new-ranking-and-percentile-composite-functions
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value. Unlike the above Rank function which returns only 5 stocks, the current one returns 10% (100 

- 90) of stocks included in the analysis. If you have included 5000 stocks in your trading system then 

this volume rule will return 500 stocks. 

 

For more information, please read the following articles: 

http://www.quantshare.com/sa-140-how-to-create-market-indicators-using-the-composite-function-

part-1 

http://www.quantshare.com/sa-144-how-to-create-market-indicators-using-the-composite-function-

part-2 

http://www.quantshare.com/sa-160-how-to-create-market-indicators-using-the-composite-function-

part-3 

http://www.quantshare.com/sa-175-trading-indicators-using-the-rank-and-percentile-functions 

http://www.quantshare.com/sa-179-new-ranking-and-percentile-composite-functions 

 

4. Limitations  

The sole problem with the composite function is that it doesn't work with some plug-ins and 

tools.  

You cannot use the composite function with the following tools: 

Charts: You cannot calculate and plot a composite, created with this function, on a chart. For 

this, you can use the composite plug-in. 

Watchlist: You cannot use the composite function when creating a dynamic watchlist. Use 

the Screener tool instead. 

[TOP] 

1.6.3 Advanced Rules 

Advanced Rules 
  

  

1. Searchfor 
  

Used to detect any complex pattern 

Used to create advanced trading rules 

Let you create unrestrictive rules 

  

Syntax:  

Searchfor syntax1 then syntax1 for (rule) set (special_rule)  

  

http://www.quantshare.com/sa-140-how-to-create-market-indicators-using-the-composite-function-part-1
http://www.quantshare.com/sa-140-how-to-create-market-indicators-using-the-composite-function-part-1
http://www.quantshare.com/sa-144-how-to-create-market-indicators-using-the-composite-function-part-2
http://www.quantshare.com/sa-144-how-to-create-market-indicators-using-the-composite-function-part-2
http://www.quantshare.com/sa-160-how-to-create-market-indicators-using-the-composite-function-part-3
http://www.quantshare.com/sa-160-how-to-create-market-indicators-using-the-composite-function-part-3
http://www.quantshare.com/sa-175-trading-indicators-using-the-rank-and-percentile-functions
http://www.quantshare.com/sa-179-new-ranking-and-percentile-composite-functions
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syntax1: special_rule after period within period all  

special_rule: Special rule (Supports QuantShare functions + special functions)  

rule: Normal rule (Any rule that could be created using the QuantShare language) 

  

Explanation: this function looks for successive events. 

Example: search for a stock that rises 20 percent within 30 bars, then drops by 10 percent for the 

next 10 – 20 bars. 

  

After (optional): specify that special_rule will be checked only after the number of bars specified 

after the keyword after 

Within (optional):  specify that special_rule  must be TRUE in at least one of the bars starting from 

‘current bar’ + ‘after value’ to ‘current bar’ + ‘after value’ + ‘within value‘ 

All (optional): specify that special_rule  must be TRUE for all the bars starting from ‘current bar’ + 

‘after value’ to ‘current bar’ + ‘after value’ + ‘within value’ 

For (optional): calculates the pattern only when the rule provided in (for) keyword is TRUE 

Set (optional): The Searchfor function returns 1 on bars where the pattern is found, if we specify a 

formula in (set) keyword, the Searchfor function will returns the result of this function instead of 1 

  

Special functions (that could be used in special_rule): 

  

         _perf (Array): Gets the percent of change from the specified array, from the bar where the 

previous condition occurred to the current bar.  

         _perf(Array, lag, length): Gets the percent of change from the specified array, from "the 

current bar minus lag minus length" to "the current bar minus lag". 

  

         _change (Array): Gets the raw change from the specified array, from the bar where the 

previous condition occurred to the current bar.  

         _change (Array, lag, length): Gets the raw change from the specified array, from "the current 

bar minus lag minus length" to "the current bar minus lag". 

  

         _avg (Array): Gets the average value of the specified array, from the bar where the previous 

condition occurred to the current bar. 
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         _avg(Array, lag, length): Gets the average value of the specified array, from "the current bar 

minus lag minus length" to "the current bar minus lag". 

  

         _min (Array): Gets the minimum value of the specified array, from the bar where the 

previous condition occurred to the current bar. 

         _min (Array, lag, length): Gets the minimum value of the specified array, from "the current 

bar minus lag minus length" to "the current bar minus lag". 

  

         _max (Array): Gets the maximum value of the specified array, from the bar where the 

previous condition occurred to the current bar. 

         _max(Array, lag, length): Gets the maximum value of the specified array, from "the current 

bar minus lag minus length" to "the current bar minus lag". 

  

         _sd (Array): Gets the standard deviation value of the specified array, from the bar where the 

previous condition occurred to the current bar. 

         _sd (Array, lag, length): Gets the standard deviation value of the specified array, from "the 

current bar minus lag minus length" to "the current bar minus lag". 

  

        _ref (Array , index_lag): Gets a value from the specified array on the bar where the condition 

"last condition index minus the specified index_lag" occurred. 

Index equals to 0 means get a value from the specified array on the bar where the last 

condition occurred. 

Index equals to 1 means get a value from the specified array on the bar where the next to 

last condition occurred. 

FRef (Array): same as the last function but uses zero as "index_lag" 

  

         _dis(index_lag): Gets the distance (in bars) between the current bar and the bar where 

condition "last condition index minus the specified index_lag" occurred. 

Index equals to 0 means get the number of bars between the current bar and the bar where 

the last condition occurred. 
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         _iff (condition, if_true, if_false): Evaluates and returns the result of the if_true formula if the 

condition is TRUE, otherwise evaluates and returns the result of theif_false formula. 

  

         _slope (Array): Gets the slope of the line that starts at the array value for the bar where the 

previous condition occurred to the array value of the current bar. 

         _slope (Array, lag, length): Gets the slope of the line that starts at the array value for "the 

current bar minus lag minus length" to the array value of "the current bar minus lag". 

  

         _aboveline (Array1, Array2): Returns TRUE if all the elements of the Array2 between the bar 

where the previous condition occurred to the current bar are ABOVE the line that starts at 

the Array1 value for the bar where the previous condition occurred to the Array1 value of 

the current bar. 

         _aboveline (Array1, Array2, lag, length): Returns TRUE if all the elements of the Array2 

between"the current bar minus lag minus length" and "the current bar minus lag" are ABOVE 

the line that starts at the Array1 value for "the current bar minus lag minus length" to the 

Array1 value of "the current bar minus lag". 

  

         _belowline (Array1, Array2): Returns TRUE if all the elements of the Array2 between the bar 

where the previous condition occurred to the current bar are BELOW the line that starts at 

the Array1 value for the bar where the previous condition occurred to the Array1 value of 

the current bar. 

         _belowline (Array1, Array2, lag, length): Returns TRUE if all the elements of the Array2 

between"the current bar minus lag minus length" and "the current bar minus lag" are 

BELOW the line that starts at the Array1 value for "the current bar minus lag minus length" 

to the Array1 value of "the current bar minus lag". 

  

  

Notes:  

Special functions start with "_" 

_change(close) is equivalent to _change(close, 0, _dis(0)) 

  

  

Example:  

Let us say we want to look for stocks that have the following pattern: 
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         Positive performance of at least 20 percent in the last 30 bars 

         Then a negative performance of at least -10 percent in a period between 10 and 50 bars, 

during this period the stock close price must be lower than the price at which the last 

condition occurred 

         Then a positive performance of at least 20 percent within the next 30 bars 

  

Here is the formula that describes this pattern: 

  

rule = Searchfor perf(close, 30) > 20 

then 

_perf(close) < -10 && _max(close) <= _ref(close) 

after 10 within 50 

then  

_perf(close) > 20 

within 30; 

  

  

Explanation: 

  

         Positive performance of at least 20 percent in the last 30 bars. "Perf" is a vector-based 

function, while "_perf" is a special function. 

perf(close, 30) > 20 

         Then a negative performance of at least -10 percent in a period between 10 and 50 bars, the 

_perf functions doesn’t need a period parameter as perf do, because it will use the (current 

bar - last condition bar) as the period parameter 

_perf(close) < -10 

during this period, the stock close price must be lower than the price at which the last 

condition occurred.  

Note the difference between close and _ref(close). Close references the close price for the 

current bar, while _ref(close) references the close price of the last condition bar. _ref(close, 
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1) references the close price of the next to last condition bar if it exists (otherwise it takes 

the last condition bar). Now, we only have one condition (perf(close, 30) > 20), because the 

current condition is not evaluated yet. 

_max(close) <= _ref(close) 

         Then a positive performance of at least 20 percent within the next 30 bars. 

_perf(close) > 20 within 30 

  

  

 

  

The first and the second panes contain the same ‘Searchfor’ formula. 

They do not look the same because if a ‘Searchfor’ rule is plotted on a pane where a candlestick chart 

is available then the signal and conditions will be shown as triangles marks. 

  

  

2. Output 
  

Used to simulate outputs 

References future bars 

Could be used to create custom outputs when analyzing trading rules or when creating prediction 

models 
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Syntax:  

Set syntax1 where syntax1 then syntax1 for (rule) 

  

syntax1: special_rule after period within period all  

special_rule: Special rule (Supports QuantShare functions + special functions) (look at Searchfor 

paragraph) 

rule: Normal rule (Any rule that could be created using the QuantShare language) 

(then syntax1) is optional. 

  

Special rules are the same as in Searchfor. 

  

Example: 

Select ‘Analysis’ in menu, then click on ‘Rules Manager’. 

Select or create some rules then click on ‘Analyze’. 

Select ‘Outputs’ on the left panel, and then click on ‘Select Outputs’ on the right panel. 

On the new ‘Output’ form, select ‘Custom output’ in the list, and then click on ‘Add’. 

On the right panel, select the newly created output and then click on ‘Edit’. 

Click on ‘click here to select an example’ and choose ‘… hedging with an option put’ 

 

This formula simulate an entry with a simultaneous buy of an option put. 

In the Where input, _dis(0) >= 60, means that we evaluate the output with the condition that the 

number of bars equals to 60, in other words we exit after 60 bars. 

In the Set input, we used a conditional statement to simulator the hedging strategy. 

If the instrument return is higher than -20 percent then we want to set the return minus the cost of 

the option (2 percent) as output. 

If the instrument return is lower than -20 percent then the output will be -20 percent (the maximum 

we can lose). 

The _perf(close) calculates the performance of the instrument from the current bar to the bar where 

the last condition occurred, and in this example the last condition is _dis(0) >= 60, so we get the 

return of the next 60 bars. 

 

This example is just a simulation of a hedge strategy and assumes: 

The option expires in 60 bars  

The option costs is 2 percent of the instrument price 

The option strike is at -20 percent of the current instrument price  

(If the price is 100$, the strike is at 80$, and the option price is 2$) 
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3. Controls 
  

Right click on a pane, and then select ‘Edit formula’ 

Type CONTROL+SPACE, then select ‘SEARCHFOR...THEN’ or ‘SET...WHERE...’ to have a form appears. 

You can type your rules directly in the inputs provided, or you can check the example provided. 

Click on ‘Disabled’ and select an item to enable inputs. 

When done, click on ‘OK’, your formula should appear in the formula editor.  
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4. Additional keywords 

NoJump: This keyword tells the application not to jump after a pattern is discovered. 
The default behavior (for speed purposes) is to jump to the bar where a pattern is discoverd, 
and to continue the search beginning from that bar. 
Example: Starting from bar 5, the "searchfor" function discovered a pattern at bar 50. 
The next search will begin at bar 51. However, if "nojump" were specified then the search 
would start at bar 6. 
What you need to know is that using "nojump" keyword enables the application to discover 
more patterns. However, the drawback is that the function will be much slower. 
The "NoJump" keyword works only with "Searchfor". The "Set" advanced rule uses the 
"nojump" automatically. This is because this function must return a value for each bar. 

Example of usage: (nojump must be placed just after the SEARCHFOR keyword) 
var1 = SEARCHFOR nojump gapup() THEN _perf(close) > 20 after 10 
within 100; 

Depth: This function tells the application to perform deep analysis of a particular condition. 
This will sometimes lead to the discovery of more patterns. By default, the application 
applies a depth of one. 
 
Example: 
var1 = SEARCHFOR gapup() THEN close > ref(close, 1) after 10 

within 100 depth(5) THEN gapup() depth(10); 

[TOP] 

1.6.4 Profile Graphs 

Profile Graphs  

 

1. Introduction 

The "PlotProfile" function of the QuantShare programming language allows you to plot profile 

graphs. 

Here are some examples of what you can plot: 

- Volume by price graph 

- 1 day volume profiles on weekly chart 

- 1 day volume profiles on intraday chart 

- RSI by price graph 

- 1 minute SMA profiles on daily chart 

   

2. Function Parameters 
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Formula: Defines the profile formula 

For a profile based on volume, simply type: "volume" 

For a profile based on 25-bar simple moving average, type: "sma(25)" 

 

New Profile Condition: Specify when to create a new profile 

To display only one profile for all bars, type: 0 

To display one profile for each trading bar, type: 1 

In daily chart, to display one profile per week, type: week() != ref(week(), 1) 

 

Time frame: Specify the time frame used to calculate "Formula" 

 

Number of buckets: The number of buckets for each profile 

 

Back Color: The back color of profiles 

 

Font/Border Color: The font and border color of profiles 

 

Style: Define one or several styles. To define several styles, separate them by '|' 

Here are the available styles: 

OperationAvg: calculate the average of the "Formula" values the belong to each bucket 

OperationMax: calculate the maximum of the "Formula" values the belong to each bucket 

OperationMin: calculate the minimum of the "Formula" values the belong to each bucket 

OperationRank: calculate the rank of the "Formula" values the belong to each bucket 

OperationSum: calculate the sum of the "Formula" values the belong to each bucket 

ShowBorder: Display profile borders 

ShowValues: Show the value of each profile bar 

UseRthOnly: Uses data from regular trading hours only (intraday) 

 

Note: If you have an EOD chart and you want to use intraday data in your profile graph, simply use a 

negative value as "Time frame". 
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For EOD data, time frame is expressed in days 

For Intraday data, time frame is expressed in seconds 

   

3. Implementation 

  

Right click on a chart, select "Edit Formula". After you change the formula, click on "Update Graph" 

button to update the chart. 

- Volume by price graph (daily chart) 

PlotProfile("volume", 0, 1, 100, colorRed, colorRed, OperationSum); 

 

 

- 1 day volume profiles on weekly chart (weekly chart) 

PlotProfile("volume", 1, 1, 5, colorRed, colorRed, OperationSum); 
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- 1 day volume profiles on intraday chart (one-minute chart) 

PlotProfile("volume", day() != ref(day(), 1), 60, 20, colorRed, colorRed, OperationSum); 

- RSI by price graph (daily chart) 

PlotProfile("rsi(14)", 0, 1, 100, colorBlue, colorBlue, OperationAvg); 

- 1 minute SMA profiles on daily chart (daily chart) 

PlotProfile("sma(25)", 1, -60, 10, colorBlue, colorBlue, OperationAvg); 

You can change the opacity of a color by changing for example: colorBlue to colorBlue|200 (Here, 

"250" defines the opacity - max value is 255) 

[TOP] 

1.6.5 Auto Support/Resistance 

Auto Support/Resistance   

 

1. Introduction 

QuantShare can detect supports and resistances automatically and programmatically. 

In QuantShare programming language, you have access to the "AutoSR" function. 

This function returns the support or the resistance/support level based on the last bar (Last bar 

mode) or on each trading bar (backtest mode). 



117 QuantShare | http://www.quantshare.com 

 

  

2. Last Bar Mode 

 

Function parameters: 

SR: Type "0" for support or "1" for resistance 

Lag and Length: Are used to define which trading bars are used to calculate the support or resistance 

lines. 

Example: 

Lag 0 and Lenght: 10 => Calculation based on the last 10 bars 

Lag 2 and Length: 15 => Calculation uses bars starting at (current bar - 17) and ending 2 bars ago 

Formula Example: 

a = AutoSR(0, 0, 10); 

 

3. Backtest Mode 

In backtest mode, the automatic support/resistance calculation is performed on each trading bar 

(instead of the last bar only). 

To enable backtest mode, you have to update the first parameter. Set "2" to calculate supports and 

"3" to calculate resistances. 

You can plot the following variables on a chart to see the difference: 

a = AutoSR(0, 0, 10); 

b = AutoSR(2, 0, 10); 

plot(a, "Normal", colorRed, ChartLine, StyleNoScale); 

plot(b, "Backtest Mode", colorGreen); 

 

More information about the "AutoSR" function can be found in the following blog posts: 

Detect chart patterns using the auto support/resistance indicator 

Backtesting chart patterns using the auto support and resistance indicator 

[TOP] 

1.7 Real-Time 

Realtime Feature 

  

  

1. Connect to a data provider 

  

http://www.quantshare.com/sa-437-detect-chart-patterns-using-the-auto-support-resistance-indicator
http://www.quantshare.com/sa-453-backtesting-chart-patterns-using-the-auto-support-and-resistance-indicator
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- Select "Accounts -> Connect" 
- Choose your data provider (Example: IQFeed) 
 

In the "Data Provider Settings", you can update settings such as login, password, backfill, 
base time frame, maximum symbols... 
For more information please check "Update Data Provider Settings" section. 
A data provider could be a broker (Interactive Brokers, MBTrading...) or a company that 
provides real time data (IQFeed, BarChart, Teletrader...). 
 

 

2. Disconnect a data provider 

 

- Select "Accounts -> Disconnect" 
- Choose your data provider (Example: IQFeed) 
 

 

3. Update Data Provider Settings 

 

At the bottom of QuantShare main window, are listed the active data feeds. 
  

 
  

Click on ".. Data Feed(s)" to open a new table. 
 

Here are the different fields of this table: 
Status: Green if the data feed is connected, Red if it is not 
Data Feed: The data feed name 
Enabled: Choose whether to enable or disable a data feed 
Connected: Tells you whether the data feed is connected or not 
Last Message: The last log message sent by the data provider 
Log: Click on this button to display log messages sent by the data provider 
Settings: Click on this button to update the data provider settings 

  

  

 

4. Open a real-time chart 

  

- Select “View -> New Chart” 

- Right click on the chart then select “Switch to Intraday” (if you are using a daily chart) 
- Right click on the chart again, select "Data Source" then choose your data source. 
- To disable real-time for that chart, select "No Data Source" 

  

 

5. Backfill 

 

Right click on the chart then select "Backfill" 
Note that the "Backfill" appears in the menu only if the data feed provides backfill 
capabilities. 
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6. Time & Sales 

 

In real time charts, there is an icon (circle) on the bottom/right corner. 
The circle is Green when the chart is steaming data. 
- Click on that circle 
- Select "Trading Tools" 
- Select "Time & Sales" 

 

 

7. Market Depth - Level 2  

  

In real time charts, there is an icon (circle) on the bottom/right corner. 
The circle is Green when the chart is steaming data. 
- Click on that circle 
- Select "Trading Tools" 
- Select "Market Depth" 

  

  

8. Real time Settings 

  

Select "Accounts -> Real-time Settings" 

  

Streaming: 
Maximum number of bars to load: Select the maximum number of bars to load when 
opening a real-time chart 
  

Charts: 
Backfill when a new symbol is selected: When this option is selected, a backfill is 
automatically performed each time you select a new security in a chart 
 

Analysis: 
Backfill when analyzing securities: Backfill securities before performing analysis (watchlist, 
portfolio...) 
Save data when closing a real time stream: Save real time data when the analysis ends 
(watchlist, portfolio...) 
  

 

9. Real time Monitor 

  

Select "Accounts" then "Real time Monitor" 

To select the default data feed, select a feed next to "Default DataFeed". 
The "Data Feeds" tab, displays for each provider, the current active symbols (streaming), 
time frames and number of listeners (Example: Chart, Watchlist, Alert...) 
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[TOP] 

1.7.1 Real-Time Features 

Realtime Feature 

  

  

1. Connect to a data provider 

  

- Select "Accounts -> Connect" 
- Choose your data provider (Example: IQFeed) 
 

In the "Data Provider Settings", you can update settings such as login, password, backfill, 
base time frame, maximum symbols... 
For more information please check "Update Data Provider Settings" section. 
A data provider could be a broker (Interactive Brokers, MBTrading...) or a company that 
provides real time data (IQFeed, BarChart, Teletrader...). 
 

 

2. Disconnect a data provider 

 

- Select "Accounts -> Disconnect" 
- Choose your data provider (Example: IQFeed) 
 

 

3. Update Data Provider Settings 

 

At the bottom of QuantShare main window, are listed the active data feeds. 
  

 
  

Click on ".. Data Feed(s)" to open a new table. 
 

Here are the different fields of this table: 
Status: Green if the data feed is connected, Red if it is not 
Data Feed: The data feed name 
Enabled: Choose whether to enable or disable a data feed 
Connected: Tells you whether the data feed is connected or not 
Last Message: The last log message sent by the data provider 
Log: Click on this button to display log messages sent by the data provider 
Settings: Click on this button to update the data provider settings 

  

  

 

4. Open a real-time chart 
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- Select “View -> New Chart” 

- Right click on the chart then select “Switch to Intraday” (if you are using a daily chart) 
- Right click on the chart again, select "Data Source" then choose your data source. 
- To disable real-time for that chart, select "No Data Source" 

  

 

5. Backfill 

 

Right click on the chart then select "Backfill" 
Note that the "Backfill" appears in the menu only if the data feed provides backfill 
capabilities. 
 

  

6. Time & Sales 

 

In real time charts, there is an icon (circle) on the bottom/right corner. 
The circle is Green when the chart is steaming data. 
- Click on that circle 
- Select "Trading Tools" 
- Select "Time & Sales" 

 

 

7. Market Depth - Level 2  

  

In real time charts, there is an icon (circle) on the bottom/right corner. 
The circle is Green when the chart is steaming data. 
- Click on that circle 
- Select "Trading Tools" 
- Select "Market Depth" 

  

  

8. Real time Settings 

  

Select "Accounts -> Real-time Settings" 

  

Streaming: 
Maximum number of bars to load: Select the maximum number of bars to load when 
opening a real-time chart 
  

Charts: 
Backfill when a new symbol is selected: When this option is selected, a backfill is 
automatically performed each time you select a new security in a chart 
 

Analysis: 
Backfill when analyzing securities: Backfill securities before performing analysis (watchlist, 
portfolio...) 



122 QuantShare | http://www.quantshare.com 

 

Save data when closing a real time stream: Save real time data when the analysis ends 
(watchlist, portfolio...) 
  

 

9. Real time Monitor 

  

Select "Accounts" then "Real time Monitor" 

To select the default data feed, select a feed next to "Default DataFeed". 
The "Data Feeds" tab, displays for each provider, the current active symbols (streaming), 
time frames and number of listeners (Example: Chart, Watchlist, Alert...) 
  

  

  

  

  

[TOP] 

1.7.2 DDE Connections 

DDE Connections 

 
1. What is DDE? 

DDE stands for Dynamic Data Exchange. It is a technology for interprocess communication 
under Microsoft Windows or OS/2. 

Several brokers and data providers allow exporting real time data through DDE. 
QuantShare can connect to any data provider who supports the DDE technology. 
 

2. Create a New DDE Connection 

- Select "Accounts -> Connection -> Add Connection" 
- Type a name and short name for your connection. Example: MyBroker and MB 
- Get DDE settings from your data provider and fill the "DDE Server" and "DDE Field 
Definitions" fields 
- Click on "OK" to save your connection 

Example settings for the Bloomberg DDE connection: 

Name: BLP 
Short Name: BLP 
DDE Server: BLP 
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Last: M!'{Symbol},[LAST_PRICE]' 
Last Size: M!'{Symbol},[SIZE_LAST_PRICE]' 
Ask: M!'{Symbol},[ASK]' 
Ask Size: M!'{Symbol},[ASK_SIZE]' 
Bid: M!'{Symbol},[BID]' 
Bid Size: M!'{Symbol},[BID_SIZE]' 
Time: M!'{Symbol},[TIME]' 
 

Note: If you have problems with DDE settings, you can always use Excel for debugging. 
 

3. Connect to a data provider using DDE 

To open a DDE connection: 
- Select "Accounts -> Connect" 
- Select one of your DDE connections (You can easily recognize it because its name always 
starts with "DDE_") 
- Click on "Close" 
 

4. Remove a DDE connection 

- Select "Accounts -> Connection -> Remove Connection" 
- Select your DDE connection then click on "Remove" 

[TOP] 

1.7.3 Real-Time Grids 

Real-time Grids 

  
 

 

1. Introduction 
 

 

The real-time grid is a tool that allows you to create excel-like sheets. The main advantage of 
this tool is that it makes referencing real-time and historical data very easy and also allows 
you to create QuantShare based scripts to manage/update the sheet. Note that this tool is 
very powerful and can be used to create any sort of grid/table. 
  
 

 

2. How to create a new grid 
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- In QuantShare, select “Tools -> Grid -> Grid Editor” 
 

 

This will automatically create a new grid. 
 

 

To create another new grid, save current grid and close it, use the “File” menu at the top. 
  
 

 

3. How to use the grid tool 
 

 

As we said, this tool creates grids like Excel sheets. You can select any cell and update its 
content by typing a value or a formula. 
 

 

You can right click on any cell to update its settings or use the toolbar menus at the top to 
update selected cell’s settings 
 

 

 

4. How to reference a formula in a cell 
 

 

To reference a formula in a cell, start by typing “=”. You can display the list of available 
functions, click on “Fx” button that is located above sheets. 
 

 

Examples: 
- Reference historical daily data (last close price) 
 

 

=GetCloseHisto("GOOG", 1) 
 

 

- Reference one-minute intraday data (close price before the last one) 
 

 

=GetClose("GOOG", 60)[1] 
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If real-time data for GOOG is available then this field will be updated as soon as QuantShare 
gets new ticks for it. To define a data feed for one or several cells, right click on the cell(s), 
select “DataFeed” then choose your data feed. 
If you have two or more data feeds, you can easily show side by side the real-time last price 
of a particular security for each data feed. 
 

 

- Reference current time: 
 

 

=Hour+":"+Minutes+":"+Seconds 
 

 

- Reference current bid price for a security (updated in real time) 
 

 

=GetBid("GOOG", 0) 
 

 

- Reference the last custom database field: 
 

 

=GetDataH("Fund", "Basic Eps - Total", "C")[0] 
 

 

- Reference market depth data: (second best ask price) 
 

 

=GetL2("GOOG", 1, "ask_price") 
 

 

 

 

Of course, every value in the formula can be updated by a cell reference. For example, you 
can set “GOOG” in the cell “A1”, and “1” in cell “A2” then type the following formula in cell 
“A3”: 
=GetCloseHisto(A1, A2) 
 

 

Each time, you update the value of cell “A1” or “A2”, the value of “A3” is automatically 
updated. 
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5. How to copy a cell 
 

 

You can copy one or several cells (select multiple cells using the mouse or by clicking on cells 
while pressing on CONTROL), using the “Edit” menu or by using CONTROL+C shortcut. To 
paste cells, use the CONTROL+V shortcut. 
 

 

Note that if one of your formulas references a cell then the cell value will be updated as well 
during the copy/paste. 
 

 

Example: 
 

 

Cell A1: =A2 (it references cell A2) 
 

 

If you copy cell A1 to B1 then the new formula of B1 will become B2 
 

 

Like excel, you can instruct QuantShare to not update cell references by adding “$” sign. 
 

 

Cell A: = $A$2 
 

 

When copying A1 to B1, the formula of B1 will stay the same: $A$2 

The “$” sign can be added to horizontal (1,2,3,4...) or vertical (A,B,C,D...) indices or both. 
 
 

  

6. How to create a QuantShare formula 
 

 

In the toolbar, click on “Formulas” then click on “Add Formula”. 
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The cell will display the last value of the time-series associated with the “cell” variable. 
 
Example: 
cell = rsi(14); 
 

 

This will display the 14-bar relative strength index. 
 

To display the RSI, update the formula name (set RSIF as name for example), select 
 “Historical” next to “Data Used” then click on “Compile”. 
Now, click on any cell in the grid then type: 
=Formula.RSIF("GOOG", 1) 
 

 

Each time you create a QuantShare formula, two parameters are automatically added 
(Symbol name and time frame) 
 

 

 

7. How to create a button 
 

 

You can replace the default cell by a button, a listbox or a checkbox. To do so, right click on a 
cell then select “Cell Type”. Choose “Button” for example then click on “OK”. 
 

 

You can update the button text by updating the field next to “Fx”. 
Right click on the button then select “Button Cell Function” 

To create a function that is executed each time the button is clicked, click on “Create 
Function”. 
Type your script then click on “Compile”. 
 
The script contains several default classes you can use. These classes are the same as the 
ones available in the “Global Script”. You can for example, get active charts, update charts, 
get watchlists, parse formulas... 
 

 

There are also two important variables you can use: 
cell: This variable allows you to update the value of the current cell (In this case, it is the 
button cell) 
 
Example: 
cell.Value = “My Button”; 
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cells: This variable allows you to update any cell’s value, to get cell’s content, add/remove 
cells... 
 

 

Example: (Get the number of open charts in cell A1) 
Cell a1 = cells.GetCell(1, 1); 
a1.Value = "Open Charts: " + Charts.NbCharts; 
 

 

Note that scripts are not necessary linked to buttons, listboxes and checkboxes. 
You can create a new script by clicking on “Formulas” button (Toolbar) then on “Add Script 
Formula”. 
 
You can reference the script on any cell by typing (format): 
Script.[Function Name]([Parameters]); 
 

 

If the script name is “MyScript” then type: 
Script.MyScript() 
 

 

 

 

8. Create a form from a grid 
 

 

- Save your grid (File -> Save) 
- In QuantShare, select “Tools -> Grid -> Open Grid” 

- Select the grid you want to display then click on “Load Selected Item” 
 

 

Here is how to update the form’s settings: 
- In the grid editor, open your grid then select “View -> Show Output” 

- Select the backcolor 
- Define whether to stretch rows and columns on resizing the form 

- Select whether it is permitted to add and remove rows 

- You can also define the original number of rows and columns by clicking on “Set Grid Size” 
button in the toolbar 
 

 

Note that in a form not all cells are editable by default. If you want to make a cell editable (A 
cell where you can type a symbol name for example), you should right click on the cell, select 
“Editable Cell” then “Yes” 
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9. How to update cells based on specific conditions 

 

 

Example of what you can create using this tool: 
- Real-time matrix correlation 

- Real-time news feed 

 

[TOP] 

1.8 Plug-ins 

Plug-ins 

  

A Plug-in is a program that interacts with the main program and brings him more functionality. 

 

This is the list of the currently available plug-ins: 

 Indicators  
 Custom Functions  
 Custom Drawing Tools  
 Composite  
 Watch List  
 Script Manager  
 Widget Panel  
 Sharing Server  
 Notes  
 Divers  
 Downloader  
 ASCII Importer  
 Data Viewer  
 Rules Manager  
 Ranking System Manager  
 Simulator  
 Monte Carlo Simulation  
 Advanced Money Management  
 Screener  
 Pivot Tables  
 Portfolio   
 Optimizer  
 Artificial Intelligence  
 Portfolio123  
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1.8.1 Indicators 

Formulas 
  

1. Introduction 
  

Formulas are created using the QuantShare vector-based language. A formula can contain one or 

several indicators, it can also contain functions such as plot, plotsymbol... 

More than 100 formulas are available: 

 Relative Strength Index  
 Aroon Oscillator  
 Bollinger Bands  
 Average True Range  
 Absolute Price Oscillator  
 On Balance Volume  
 ...  

  
Example:  Relative Strength Index  

indicator = Rsi(14); 
Plot(indicator,"Relative Strength Index",colorBlue,chartline,STYLESYMBOLNONE); 

The above formula creates a variable 'indicator' and assign it the Relative Strength Index time-series. 
The second line plots the 'indicator' variable (which is equal to the relative strength index). 
  

  

2. Open the formulas/indicator form 
  

Click on 'Formulas/Indicators' in the 'View' menu. 

Select a category, and then select an indicator. 

Right click on that indicator and a menu will show up. 

On that menu, you can edit the indicator files, rename them, create new ones and set the action to 

take when you double click on them.  

  

3. Drag & Drop formulas 
  

In the formulas form, click on an formula then drag & drop it to a chart. 

You can also drag any pane formula and drop it into another pane. 

  

4. Add a formula to a chart 
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Besides adding indicators by updating the chart formula, you can add indicators using the indicator 

form by either double clicking on an indicator or drag & drop the indicator to a chart. 

You can also right click on a chart, select 'Indicators' then click on 'Add study'. 

  

5. Create a new formula 
  

Rigth click on the 'Formulas' table then click on 'New Formula'. 
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1.8.2 Custom Functions 

Custom functions  

 

  

1. Introduction 
  

This plug-in lets you create custom function that you can use in your formulas. 

Functions are created using CSharp or JScript.Net languages. 

 

Let us say you created a function which have two numeric parameters and whose name is 

'MyFunction'. 

To use this function, open the formula editor (Right click on a chart, then click on 'Edit formula'), type 

for example 'a = ', then click on CTRL+SPACE; in the list box you will find your function 'MyFunction'. 

  

2. Create a new function 

Open the 'Create functions' form by clicking on 'Create functions' in the 'Tools' menu. 

In the 'Create functions' form, click on 'Add', type a name then save. 

Select the function, you have just created, in the 'Functions' panel, then move to the 'Script' panel. 

Press on 'CTRL+SPACE' to see the initialized variables. 

The application creates a variable for each parameter. 

'result' is the variable that your function will return to the application 

'result' is of type 'VectorD' if your function returns a numeric time-series or 'VectorS' if your function 

return a string time-series 

Example: to create a function that returns an array containing the value '2'. 

Type this code in your script panel: 

for(int i=0;i<result.Length;i++) 

{ 

    result.SetValue(i, 2); 

} 

You can add parameters to your function, by clicking on 'Add a parameter'. 

You can update the parameters name, type, default value and description. 

After adding a parameter, press on CTRL+SPACE to see the new variable in the list. 

Example: to create a function that adds one to the provided parameter (var1) and returns the new 

array. 
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double val = 0; 
for(int i=0;i<result.Length;i++) 

{ 

  val = var1.GetValue(i); 

  result.SetValue(i, val + 1); 

}  

When done, click on Save. 

  

3. Update a function 

Clicking on 'Save' button will compile the function and updates it. 

  

4. Remove a function 

Select a function, click on 'Remove' then confirm. 

  

5. Functions  

The 'cFunctions' class contains the symbol name, close, open, high, low, volume, open interest and 

date vectors of the symbol that is used when executing a formula.  

Example: To get the close vector, type:  

VectorD close = cFunctions.Close; 

 

Create an empty vector 

To create an empty numeric vector, type:   

VectorD vectorNumeric = cFunctions.CreateNumericVector(); 

 

To create an empty text vector, type:   

VectorS vectorText = cFunctions.CreateTextVector(); 

 

This class also contains three important functions:  

 

CompileFormula: This function compiles a QuantShare formula and returns a QSFormula class. This 

class can be used to extract vectors.  

Example: cFunctions.CompileFormula("a = rsi(14);").GetVectorDouble("a"); 

 

GetCustomDatabaseData: This function loads custom database data for the current symbol or 

another one and returns a VectorCustom class. 

The vectorCustom class is like the other vector classes with the difference that it can contain more 

than one element in a bar period. 
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If you execute a function on a daily timeframe and you reference an intraday database (news for 

example), then for a specific bar (date), you may have more than one news item. 

 

SetForwardAndBackwardBars: This function let you define how many backward and forward bars 

your formula use. 

Forward and Backward bars are used to optimize the execution of formulas.  

As an example, the RSI or relative strength index function (rsi(14)), uses 14 backward bars and 0 

forward bars. Because for each bar, it needs the previous 14 bars to perform its calculation and it 

does not require any future bar. 

 

 

6. Vector Operations 

Within the script/indicator editor, you can add, subtract, multiply, divide and compare vectors 

(VectorD class). 

 

Example: 

VectorD close = cFunctions.Close; 
VectorD copen = cFunctions.Open; 
VectorD sum = close + open; 

The above formula creates the "sum" vector. Each element of the "sum" vector is constructed by 

adding the close price to the open price. The element of the vector "sum" at index 0 is equal to the 

close + open prices at the same index. 

Example of other operations: 

VectorD vect = cFunctions.Close - cFunctions.Open; 
VectorD vect = cFunctions.Close / cFunctions.Open; 
VectorD vect = cFunctions.Close * cFunctions.Open; 
VectorD vect = cFunctions.Close > cFunctions.Open; 
VectorD vect = cFunctions.Close < cFunctions.Open; 
VectorD vect = cFunctions.Close >= cFunctions.Open; 
.... 

Note: The "VectorS" class supports the operator (+). It can be used to concatenate strings. 

 

 

7. Technical Analysis Object 

"TA" object allows you to use the indicators that are available in the QuantShare vector-based 

language.  

 

After you type "TA.", use CONTROL+SPACE to display the list of available functions. 
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The list contains several hundred indicators. 

Example 1: (C#) 

VectorD vect = TA.Rsi(cFunctions.Close, 14); 

This will create the RSI indicator and assigns the time-series to the "vect" variable. 

The equivalent of this line in QuantShare language: 
 

vect = rsi(close, 14); 

Example 2: (C#) 

VectorD vect = cFunctions.Close - TA.Sma(20); 

This will return the difference between the close price and its 20-bar simple moving average. 

The equivalent of this line in QuantShare language: 
 

vect = close - sma(20); 

 

 

8. Charts Object 

"Charts" object allows you to plot lines, bars and objects on a chart. 

After you type "Chart.", use CONTROL+SPACE to display the list of available functions. 

Example 1: 

Chart.Plot(cFunctions.Close, "Close Price", Color.Red, ChartType.ChartLine, 
Style.StyleSymbolNone); 

Plots the close price on the chart. 

Example 2: 

VectorD a = TA.Rsi(14); 
Chart.Plot(a, "RSI"); 

Plots the 14-bar Relative Strength Index on the chart. 

  

9. Parse a formula in a different time frame 

You can parse a formula based on QuantShare language in a different time frame. 
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Let us say that you are executing the following function in a daily trading system. Here is how to 

calculate the number of times the price crosses above its moving average using one-minute period 

(You must have of course one-minute data in your database) 

 

VectorCustomDouble a = cFunctions.CompileFormula("a = cross(close, sma(10));", 60, 

false).GetVectorDouble("a"); 

for(int i=0;i < a.Length;i++) // For each trading bar (daily) => Variable "a" is automatically 

synchronized with daily bars 

{ 

for(int j=0;j < a[i].Length;j++) // For each one-minute bar in the daily bar number "i" 
{ 
    if(a[i][j] > 0) 
    { 
          result[i]++; 
    } 
} 

} 

// You can also get the same result by typing 

result = a.ToVectorD("sum");  
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10. Auto Support/Resistance 

For an introduction to the "AutoSR" function, please go here. 

By creating a C# custom indicator (Tools -> Create Functions) and using the "TA.AutoSR" function, 

you can build advanced indicators based on the auto support and resistance feature. 

 

The "TA.AutoSR" function returns a "VectorCustomDouble" variable. 

 

For each trading bar, you will have an array that contains three values. 

 

Index 0: Support or resistance level (The value returned by "AutoSR" function of the QuantShare 

programming language) 

Index 1: Returns the "slope" of the support or resistance line 

Index 2: Returns the "intercept" of the support or resistance line 

 

Note: The equivalent "AutoSR" function in QuantShare programming language provides only the 

resistance/support level. 

Example: 

VectorCustomDouble d = TA.AutoSR(2, 0, 20); 
for(int i=0;i<result.Length;i++) 
{ 
        result[i] = d[i][1]; 
} 

// Calculates for each trading bar, the slope of the support line 

  

The "TA.AutoSR" function can also be used to calculate support and resistance lines of other time 

series.  

Note that by default (in case no time-series defined), the high/low price series are used. 

Example: 

VectorCustomDouble d = TA.AutoSR(2, 0, 20, TA.Rsi(14)); 
for(int i=0;i<result.Length;i++) 
{ 
        result[i] = d[i][0]; 
} 

// Calculates for each trading bar, the support level (based on the previous 20 bars) of the 14-bar 

relative strength indicator 
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11. Protect Your Code Source 

Here is how to protect a function with a password: 

- Click on "Manage" button at the top 

- Check your function 

- In the new control, click on "Tools" (Expand the top menu if necessary - Click on "+" button) 

- Select "Encrypt Checked Items" 

- Click "Yes" 

- Enter your password then click "OK" 

Your function is now protected. If you select it in the "Create Functions" form, a dialog box will 

prompt you to enter a password. If you do not enter the correct password then the function code will 

not be displayed. 

Note that you can still use protected indicators in your charts, trading systems... 

  

  

[TOP] 

1.8.3 Custom Drawing Tools 

Custom Drawing Tools 

 
This plug-in lets you create your own drawing tool. A drawing tool allows you to display 
objects, lines, texts in a chart (Example: Trend lines, Gann Square...) 

 

1. Presentation 
 
To open the custom drawing tool plug-in, select "Tools" in the main menu then click on "Custom 
Drawing Tools" (Extended menu) 
 
In the main form, you have: 
- Top Panel: Menu where you can add, remove and manage items 
- Top-Left Panel: List of available drawing items 
- Bottom-Left Panel: Description of the selected drawing item 
- Top-Right: Code control. Here you should type the script (CSharp or JScript.Net) that is executed 
each time the mouse cursor moves within the bounds of the chart. 
- Bottom-Right: Here you can manage the drawing item settings. You can for example add a color 
setting and then access this setting in your code so you can plot a line with the user specified color. 

 

2. Create a Custom Drawing Tool 
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- Click on "Add" 
- Type the custom drawing tool item name 
- Click on "Save Item" 

 

3. Remove a Custom Drawing Tool 

 
- Select a custom drawing tool 
- Click on "Remove" 
- Click on "Yes" 

 

4. Add a Custom Drawing Tool to the Bookmark Panel 

 
You should add a custom drawing tool to the bookmark panel so you can select it and use it. 
 
- Right click on the Bookmark Panel (Blue bar under the main menu - Just above Charts) 
- Select "Add Shortcut" 
- Select "Drawing Tool" and make sure "Create a shortcut for an existing item" is checked 
- Click on "OK" 
- Select a custom drawing tool then click on "Load Selected Item" 
- In the bookmark panel, double click on the newly added item to activate it then move the 
mouse pointer to the chart. 

 

5. Custom Drawing Tool Script 

 
For more information please refer to the "QuantShare CSharp" topic or click on "Help" under 
the script control in the custom drawing tool form. 

The script is executed when the custom drawing tool is selected and the mouse cursor moves within 
the bounds of the chart. 
 
You can detect the current state of the drawing tool by checking the following variables: 
- Functions.IsMoving: Specify whether the user is currently moving the item or not. 
- Functions.CursorPosition: The current mouse position on the chart (X, Y and Date) 
- Functions.ClickPositions: Array that contains positions of the clicked points (When user clicks 
on a chart and the item is selected) 

Example 1: 
- Displays the price above the mouse cursor (http://www.quantshare.com/item-449-close-
price-above-cursor) 

PointPosition pos = Functions.CursorPosition; 

double[] close = Functions.ChartData.GetTimeSeries("close"); // Get the "Close" time-series 

int barindex = (int)pos.X + Functions.ChartData.StartIndex - 1;  // Get the current bar index 

(under the mouse cursor) 

double closePrice = close[barindex];  // Get the close price 

TextObj text1 = Functions.PaneObject.DrawText("", "Close: " + closePrice + "\n\n", pos.X, 

pos.Y); // Create a TextObj to be displayed on the chart 

text1.FontSpec.Border.IsVisible = false;  // Update object settings 

text1.FontSpec.FontColor = Color.Blue; 

text1.FontSpec.Fill.Color = Color.Transparent; 

if(Functions.ClickPositions.Length > 0) 

{ 

http://www.quantshare.com/item-449-close-price-above-cursor
http://www.quantshare.com/item-449-close-price-above-cursor
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         Functions.FinishDrawing(); // Complete the drawing process (No more points can be 

added to the ClickPositions array) 

} 

Example 2: 
- Displays a trend line with the sum of volume (http://www.quantshare.com/item-989-volume-
accumulation-trend-line) 

if(Functions.ClickPositions.Length == 0) // No click on the chart -> Exit 

{ 

      return; 

} 

 

PointPosition point1 = Functions.ClickPositions[0]; // First click location 

PointPosition point2 = Functions.CursorPosition; // Second click set Mouse cursor 

if(Functions.ClickPositions.Length > 1) // There is a second click 

{ 

      point2 = Functions.ClickPositions[1]; // Second click associated with point2 

      Functions.FinishDrawing(); // Finish drawing after the second click 

} 

// Draw line using point1 and point2 locations 

LineObj line = Functions.PaneObject.DrawLine("Line1", point1.X, point1.Y, point2.X, 

point2.Y); 

// If point1 Y value is higher than point2 Y value then set the line color to Red 

if(point1.Y > point2.Y) 

{ 

      line.Line.Color = Color.Red; 

} 

else // Otherwise we set the line color to Green 

{ 

      line.Line.Color = Color.Green; 

} 

string text = ""; 

if((bool)Functions.GetSettings("Show Distance")) 

{ 

      text = Math.Abs(point2.X - point1.X) + " bar(s)"; 

} 

if((bool)Functions.GetSettings("Show Sum of Volume")) 

{ 

      double[] volume1 = Functions.ChartData.GetTimeSeries("volume"); 

      double volume = 0; 

      int start = Functions.ChartData.GetBarIndex(point1); 

      int end = Functions.ChartData.GetBarIndex(point2); 

      if(end > start) 

      { 

            for(int i=start;i<=end;i++) volume += volume1[i]; 

      } 

http://www.quantshare.com/item-989-volume-accumulation-trend-line
http://www.quantshare.com/item-989-volume-accumulation-trend-line
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      else 

      { 

            for(int i=end;i<=start;i++) volume += volume1[i]; 

      } 

      if(text == "") 

      { 

            text = text + "Ac. Volume: " + volume; 

      } 

      else 

      { 

            text = text + Environment.NewLine + "Ac. Volume: " + volume; 

      } 

} 

if(text != "") 

{ 

TextObj text1 = Functions.PaneObject.DrawText("Text1", Environment.NewLine + 

Environment.NewLine + text, point2.X, point2.Y); 

text1.FontSpec.Border.IsVisible = false; 

text1.FontSpec.Fill.Color = Color.Transparent; 

} 

[TOP] 

1.8.4 Composite 

Composite 
 

  

1. Introduction 

 

Create any kind of composite using this plug-in. 

 

Examples of composites:  

 Percentage of stocks trading above their 50-day moving average  
 Number of advancing stocks within a sector  
 Price to book ratio of the entire US stock market  
 Percentage of stocks that have an overbought RSI  
  

The composite plug-in automatically detect if there are new quotes and recalculate the composites if 

necessary.  

  

2. Create a composite 
  

Tools -> Composite 

Click on 'Add' to open a new form. 
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Select the symbols you want to include in the composite calculation. 

'Include composite tickers' check box is used to specify whether to include composite symbols or not. 

 

N.B: If there are two composites which have this box checked, a calculation error will appears in the 

case where composite 'A' symbols include composite 'B' and composite 'B' symbols include 

composite A.  

Type then the composite formula, choose the calculation function, the start and end periods, then 

the composite name, full name and description. 

The new composite will be added to the 'Composite' form's grid and the calculation will start. 
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3. Update a composite 
  

In the 'Composite form', select a composite item and then click on 'Update' button. 

  

4. Remove a composite 

 

In the 'Composite form', select a composite item and then click on 'Remove' button. 

 

5. Re-Calculate a composite 
  

In the 'Composite form', select a composite item and then click on 'Recalculate' button. 

To recalculate all the composites, click on 'Recalculate all' button. 

 

6. Composite Plug-in Settings 
  

In the 'Composite' form, select the 'Settings' tab. 

You can select whether the composite should be recalculated automatically on new data or not. 

7. Composite Function 

Difference between the composite function and the composite plug-in: 
http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-
composite-tools  

http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-composite-tools
http://www.quantshare.com/sa-136-create-a-stock-index-or-a-trading-indicator-using-the-composite-tools
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8. How to use "Composite" class in the script editor 

The "composite" class allows you to re-calculate a composite programmatically from the 

script editor. 

This is very useful for example if you want to create a real time composites. 

Example: 

while(true) 

{ 

      Composite.Calculate("MyComposite"); 

      App.Main.Sleep(1000); 

} 

 

 

[TOP] 

1.8.5 Watch List 

Watch List 
  

1. Introduction 
  

This plug-in displays symbols that meet your criteria. 

 

To open the watch list plug-in: 

         Click on menu 'Tools' 

         Click on item 'Watch List' 
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2. Create a simple watch list 
  

A simple watch list is a watch list where you can specify simple criteria based on symbol information, 

example: symbol names, symbol industry... 

To create a simple watch list: 

         Click on 'Create' link in the 'Watch-list' form 

         Click on 'Create a basic watchlist' then enter your conditions 

         Click on 'OK' 

  

3. Create a static watch list 
  

A static watch list is a watch list that contains a list of symbols.  

To create a static watch list: 

         Click on 'Create' link in the 'Watch-list' form 

              Click on 'Create a static watchlist' then type one symbol per line 

    Click on 'OK' 

 

If you want to create a static watch list from the active watch list, click on 'Create' link then 

'Create from the current watchlist symbols'. 
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You can add a symbol to a static watchlist by dragging it from a chart then dropping it to the 

watchlist window. Drag and drop operation is performed using the right mouse button. 

When the operation is completed, a menu will appear. You can then select to which static 

watchlist you want to add the dragged symbol (Chart symbol). 

 

To remove a symbol from a static watchlist, perform the latter drag & drop operation while 

pressing on the [CONTROL] key. 

  

4. Create a dynamic watch list 
  

A dynamic watch list is a watch list where you can specify advanced criteria. 

Dynamic watch-lists update its list of symbols dynamically on new data. 

To create a dynamic watch list: 

 Click on 'Create' link in the 'Watch-list' form  

 Click on 'Create a dynamic watchlist'  
 In the new form, set the symbol filters  
 Click on 'Next'  
 Type your formula and make sure it is correct by clicking on 'Compile'  
 Click on 'Finish'  
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Note: If you want to create a real-time watchlist, make sure you select an intraday time frame next to 

"Select a time frame". 

After that, check "Real-time - Data Source" and select a real-time data provider. 

Check "Analyze on each incoming tick" if you want the watchlist formula to be analyzed on each tick 

(instead of each minute if for example you select a one minute time frame). 

 

After clicking on "Finish", the watch list plug-in will display all the symbols and start the calculation 

process. 
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When the calculation process is done, symbols that fail to pass the criteria are removed. 

The dynamic watch list will calculate the variable 'filter' for each symbol and if this variable is false or 

equal to zero then it will reject the symbol. 

Example: Select overbought symbols (Relative strength index superior to 70) 

filter = rsi(14) > 70; 

 

More Settings: 

Click on 'Show more settings' to display additional settings. 

The 'Display symbols that pass the rules' option allows you to specify whether to account for the last 

bar/date only or for a specific number of past bars/days. 

 

Example of a real-time watchlist: 

filter = ask == bid; 

AddColumn("Bid", bid); 

AddColumn("BidSize", bidsize); 

AddColumn("AskSize", asksize); 

AddColumn("Ask", ask); 

Show assets that have a bid price equal to the ask price. (Make sure you check "Analyze on each 

incoming tick") 

  

5. Add columns to a dynamic watch list 
  

You can add column to a dynamic watch list, the watch list grid will shows you these columns with 

their values for each symbol. 

To add a column, use the function 'AddColumn' or select an already created columns set. 

Example: 

filter = rsi(14) > 70; 

AddColumn("RSI", rsi(14)); 
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This will create a column named 'RSI' that will contain the value returned by the formula rsi 

(14).                 

  

6. Update a watch list 
  

 

Click on 'Select Watchlist', select the watch list you want to update then click on the button 'Update'. 

   

7. Watch lists grid colors 
  

The grid line color is white when data for the corresponding symbol is up to date. (The last quote 

date corresponds to the current date). The line color changes depending on the date difference 

between the last quote date and the current date. 

  

8. Watch lists Settings 

 

To update settings: 

 

Rigth click on the watch list grid then select 'Settings'. 

 

You can specify whether the watch list performs update automatically or not. 

  

9. Switch between watch lists 
  

To change the current watch list, click on 'Select Watchlist' link then double click on a watch list. 

  

10. Value Column 
  

The last grid's column contains Pre-Calculated values. 

Right click on the grid then select 'Value'; choose the item you want to use for this column. 

Example of use: Select the item 'Distance from support' to see the distance between the last symbol 

quote and the support you have drawn for this symbol (if any). 
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11. Associate a Layout to a Watchlist 
  

By associating a layout to a watchlist, every time you select a security in this watchlist, the selected 

layout will be automatically applied to the active chart. 

- Select your watchlist 

- Right click on the watchlist table 

- Select "Settings" then set the layout name in the "Chart layout to use when selecting a symbol" field 

You can check available layouts by right clicking on a chart then selecting "Layout". 

  

12. Open several watchlists at the same time 

 

- Open the Watchlist manager (Tools -> Watchlist) 

- Select a watchlist 

- Right click on the watchlist table 

- Click on "Create a new Watchlist Window" 

Repeat the same process to open as many watchlists as you want. 

  

[TOP] 
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1.8.6 Alerts Tool 

Alerts Tool 

 
 
The alerts tool allows you to create alerts based on specific conditions. Each time these conditions 
are met for a specific symbol, the alert is triggered and you will be notified by message, sound, 
email... 
  
  

1. Create daily, weekly, intraday and real-time alerts 

  
Select “Tools” then “Alerts Manager” to display the alerts control. 
  
This control displays all your alerts. 
Click on “Show” to select whether to display working alerts, triggered alerts, alerts with error and 
disabled alerts. 
  
Working Alerts: Alerts that are currently active. 
Triggered Alerts: Alerts that are triggered (not active anymore) 
Alerts with Errors: Alerts that have errors (probably errors in the condition’s formula) 
Disabled Alerts: Alerts that are currently disabled.  
  
  
To create a new alert: 
- Click on “New Alert” 
- Type one or several symbols for which you want to apply the alert (symbols must be separated by a 
semi-colon) 
If you want to apply the alert for several symbols, you can click on “Add Symbols” then specify one or 
several conditions for symbols selection. 
- Next to “Select a time frame”, specify the period you want to use for this alert (Daily, Weekly, 
Hourly...) 
You can define a real-time alert (Alert that will check real-time data for the specified symbols) by 
checking the “Real time - data source” option. After that, you can select the data provider to use. 
- Check “Analyze on each incoming tick” to verify the alert each time a new tick is detected. 
Otherwise, the alert will be verified on each new bar (Example: Once a minute for a 1-minute time 
frame). 
- In “Conditions” panel, click on “Add” to add a new condition and on “Remove” to remove the 
selected condition. 
- Next to this control, specify the rule for the selected condition. 
Example: Close > Open 
or: (Value) rsi(14) > 90 
  
Set “Value” if you want to define a custom indicator/formula. 
  
- In the bottom panel, select “Notifications” then define how you want to be notified each time an 
alert is triggered. 
  
Popup Message: Displays a popup message informing you that an alert was triggered. 
Color: Font color of the message 
Back color: Back color of the popup control 
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Duration: The number of seconds to keep the popup active 
Custom Message: Define a custom message to display 
Example: [SYMBOL] closes above $10 
[SYMBOL] is a keyword that is replaced the symbol name of the security that is triggered. 
  
  
Chart Message: Displays a message on the active chart 
Color: Font color of the message 
Duration: The number of seconds to keep the popup active 
Custom Message: Define a custom message to display 
Example: [SYMBOL] closes above $10 
[SYMBOL] is a keyword that is replaced the symbol name of the security that is triggered. 
  
 
Play Sound: Plays a sound each time an alert is triggered 
File Path: Specify the location of the sound file to play 
  
  
Speech: Text to speech 
Volume: Defines a volume from 0 to 100 
Custom Message: Define a custom message to speech 
Example: [SYMBOL] closes above $10 
[SYMBOL] is a keyword that is replaced the symbol name of the security that is triggered. 
  
 
Send Email: Sends an email to a particular email address each time an alert is triggered 
Profile: Specify a profile number to save your current email settings 
SMTP Server: smtp.gmail.com (Gmail Example) 
Port: 25 (Gmail Example) 
Secure Connection: TRUE (Gmail Example) 
Email: username@gmail.com (Gmail Example) 
Username: username@gmail.com (Gmail Example) 
Password: Specify your email password (Password is hidden and encrypted) 
Custom Message: Define a custom message to speech 
Example: [SYMBOL] closes above $10 
[SYMBOL] is a keyword that is replaced the symbol name of the security that is triggered. 
  
 
Execute Script: Executes a QuantShare script (Tools -> Script Editor) each time an alert is triggered 
Script Path: Define the file location of the script to execute 
  
 
At the bottom of this control, you can check “Disable” to disable the current alert. 
Click on “Add Alert” or “Update Alert” to save settings. 
  
  

2. Alerts Settings 

  
Create a new alert or update an existing one by selecting it then clicking on “Update” in the “Alerts 
Manager” form. 
  
Select “Settings” tab at the bottom panel. 

mailto:username@gmail.com
mailto:username@gmail.com
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Auto Reset: When checked, this field instructs QuantShare to reset the alert (Set it to working state 
again) in case it is in “Triggered” state and the conditions of the alert are no longer met. 
  
 

3. Alerts Log 

  
Create a new alert or update an existing one by selecting it then clicking on “Update” in the “Alerts 
Manager” form. 
  
Select “Alert Log” tab at the bottom panel. 
Specify the log message and color. 
  
The log messages are displayed each time an alert is triggered. If the Auto Reset option is set then 
the alert messages can be displayed multiple times. 
 
Example: 
You can define the following alert message (Stock Overbought) with the following condition: rsi(14) > 
80 
  
“Stock Overbought” message will be displayed each time the RSI of a tracked security crosses the 80 
threshold. 
To open the log control, click on “Log” button in the “Alerts Manager” form. 
At the bottom of the form, you have 2 settings: 
Alert Menu: Specifies for which alerts to display the log messages 
Color: Specifies the back color of the log messages. 
 
NB:  
- If an alert condition is met for two securities then 2 log messages will be displayed (one for each 
security) 
- You can dock log control by moving them while pressing on ALT key. 
 
  

[TOP] 

1.8.7 Script Manager 

Script Manager 
  

1. Introduction 
  

The script manager is a tool that let you write, update and manage your scripts. 

Scripts are used to perform tasks and to control application behavior. 

Scripts use CSharp or JScript.Net as programming languages.  

  

2. Create a new Script 
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In 'Tools' menu, click on 'Script Editor'. Click then on 'File', then 'New'. Type a file name, and then 

click on 'OK'.  

CTRL+SPACE shortcut shows you the available functions and variables. 

Script Example: 

 

Chart chart = Charts.GetSelectedChart(); 

for(int i=0;i<1000;i++) 
{ 
      chart.ScrollBarIndex = i; 
      App.Main.Sleep(30); // Sleep 30 milliseconds 
} 

  

3. Open an existing script 
  

To open an existing script in the 'Script Manager', click on 'File', then click on 'Open' and then select a 

file; a new tab will appears. 

  

4. Execute a script 
  

To compile and execute a script within the 'Script Manager', select the script you want to execute 

then click on 'Execute' in the menu bar 

  

[TOP] 

1.8.8 Widget Panel 

Widget Panel 
  

1. Introduction 
  

The widget panel is a container where you can add application object shortcuts or widgets. You can 

drag and drop objects like a pane formula, a trading system, a composite... to a widget panel.  

You can also add widgets or .Net controls to the 'Widget Panel'. 

  

2. Manage panels 
  

You can create a docked widget panel or dashboard by selecting Tools -> Dashboard -> Docked 

Dashboard 

You can create a floating dashboard by selecting Tools -> Dashboard -> New Dashboard 

 

In the 'Widget Panel' form, click on 'Menu' then click on 'Add panel' to create a new panel. 
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To rename a panel, double click on its name as shown below, then type a new name. 

 

 

 

  

3. Create a shortcut 

 

Click on 'Menu' then select 'Create Shortcut' 

Select an item type 

Check the check box if you want  to get a shortcut for an existing item, otherwise you will create a 

shortcut for a new item 

Follow the instructions, then click on 'Finish' 

A shortcut will appears on your panel 
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4. Add a widget 
  

You can add a widget or .Net control. 

 

Click on 'Menu' then select 'Add Widget'. 

Select the control you would like to add then click on 'Finish'. 
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5. Drag & Drop 
  

You can create a shortcut directly in your widget panel by dragging and dropping objects. 

Example: 

Create a chart then click on a time-series line or bar within that chart, drag & drop it to a widget 

panel, a shortcut will appears inside this panel. 

 

  

  

6. Panel Menu 
  

Right click on the panel to make the panel menu appears. 
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This menu contains the following options: 

         Create new panel for the selected items 

         Add shortcut 

         Add widget 

         Assign a new name for the selected items 

         Arrange all the items 

         Arrange the selected items 

         Remove all the items 

         Remove the selected items 

         Select everything 

         Select only shortcuts 

         Select only widgets 

  

7. Shortcut and Controls Menu 
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Click on the Red Cross to remove this item. 

Click on the arrow icon to drag this object, you can drag it to another panel or to a chart pane if the 

shortcut you are selecting is a formula.  

Edit a shortcut name by clicking on its name. 

Resize a shortcut by clicking on the blue line. 

Right click on shortcut to make a menu appears. 

 

Example: the menu of a trading system shortcut 
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1.8.9 Sharing Server 

Sharing Server 
  

1. Introduction 

All the data used in the application except the databases, can be shared. 

You can share and upload trading systems, list of rules, watch lists... and download others users 

items. 

The sharing server is the place where you can search, comment, rate other users items. 

The website we have developed is a combination of a sharing server and a social network. 

You can communicate with others users, create and join groups, discuss about your favorite 

subjects,  monitor which objects or items others users are downloading or uploading, download your 

favorite items, search for the most rated items... 

 

2. Sharing Website 
  

Sharing website benefits:  

 See what others users are uploading and downloading  
 Search for specific objects  
 Create alerts and be informed when new objects that meet your criteria are uploaded  
 Review, rate and report shared objects  
 Send messages to others members  
 Create and join groups  
 Discuss with other users about your favorite topics.  

  

3. Share an object 

 Open the 'Share Items' form (Tools -> sharing server)  
 Click on the 'Share' button at the top  
 Select the item type  
 Select an item, then click on the 'Share selected item' button, which is located on the right  
 Read the guidelines  
 Update the description if necessary  
 Click on 'Share' 

It is important that you follow the guidelines, because any shared object that does not meet the 

guidelines will be deleted. 

 

4. Download an object 

  

 Open the 'Share Items' form (Tools -> sharing server)  
 Click on the 'Download' button at the top  
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 Select the item type  
 Select the item that you want to download, then click on the 'Download' button, which is 

located on the right  
 The 'Status' column shows updates about the downloading process  
 Once the object is downloaded, the 'Save an item' dialog will appear  
 Select a name and a category (not necessary) for this object, then click on 'Save'  

  
Now, you can use this object in your application 
 

  

5. Bookmarks 

In the download panel and in the panel "My Lists", click on "Bookmarks" to see all the objects that 

you have bookmarked. 

 

6. Sharing Server Website 

QuantShare 

http://www.quantshare.com/
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1.8.10 Notes 

Notes Tool 

 

 

1. Introduction 

 

The Notes tool allows you to write custom notes.  

Each note is associated with a security and a date.  

Notes are stored in a custom intraday database, which name is "_notes". This database is 

automatically created (The name of automatically created databases are preceded with "_"). 

 

2. Create a new note 

- In a chart, move your mouse over a specific date/bar then type CONTROL+N 

- In the "Notes" form, type something then click on "Add Note" 

 

You can update the date of the note by updating the "Date" field. 

You can see the number of notes and the current symbol next to "Info" field (bottom) 

You can display a note, by selecting an item next to "Select Note" field. 

You can instruct QuantShare to change automatically the active symbol by checking "Auto" 

field 

3. Remove a note 

In "Notes" form: 

- Select a note 

- Delete the note text (Blank note) 

4. Update a note 

In "Notes" form: 

- Select a note 

- Update the note text (Changes are automatically saved) 
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5. Display notes 

To display all notes for one or several symbol: 

 

- Use the "Database Viewer" tool 

- Select "Tools" then "Database Data" 

- Select "_notes" database 

 

6. Use notes in other plug-ins 

As with any custom database, you can reference notes data within the QuantShare 

programming language. 

The functions you can use includes: GetData, GetDataCount, GetDataCountInside, 

GetDataExtern... 

To display the number of notes of a specific security in a chart, type the following formula: 

a = GetDataCount("_notes", "note"); 

plot(a, ""); 

[TOP] 

1.8.11 Divers 

Excel 
  

  

1. Excel 
  

You can open an excel form within your application. To do so, click on 'Divers' menu then on 'Excel'. 
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2. Internet explorer 
  

You can open an internet explorer form within your application. To do so, click on 'Divers' menu then 

on 'IExplorer'. 

 

  

  

3. Output 
  

Output form is a small form that displays text in a text-box.  

You can add text to this form using the .Net function 'App.AddToOutput', or the QuantShare 

function: 'Output'.  

  

4. Output list 
  

Output form is a small form that displays text in a grid.  

You can add text to this form using the .Net function 'App.AddToOutputList', or the QuantShare 

function: 'OutputList'. 
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1.8.12 Replay Tool 

Replay Tool 
  

1. Introduction 

The replay tool is a QuantShare feature that allows you to replay historical and intraday bars. 

You simply select a time frame, a start date and an end date and the replay tool will make 

bars appear one by one. 

This tool is ideal for practicing and learning. 

Please note that the replay or playback is simulated on the chart, which means that the tool 

reads data from your internal database but it does not update or modify it. 

 

2. Open the Replay Tool 

Select "Tools" then "Replay Tool" 

 

3. Replay Tool Settings 

Dates: Select when to start and stop the simulation. 

Click on "Default" to use the start and end date of the active chart symbol's data. 

Period: Select the time frame to use during the replay of the trading bars. 

If you select "Daily" period then each update will increase the replay date by one day.  

If you select "One-minute" period then each update will increase the replay date by one 

minute. 

Note that weekends are skipped and that the playback will occur only during the intraday 

session.  

To visualize or update the open and close time of the intraday session of a security, click on 

the circle located at the right-bottom corner of the chart then select "Exchange Settings". 

Use selected chart time frame: Check this field if you want to use the period that is currently 

used by the active chart. 

 

Select "Settings" tab to get more options: 

Replay all charts: Check this to replay all active charts. Otherwise, only the selected chart is 

replayed. 

Reset Settings: Initialize replay settings with default data. 
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Load Settings: Load settings from a file 

Save Settings: Save settings to a file 

 

4. Start the Replay Tool 

To start replaying chart(s), click on "Start" button at the bottom. The active date is available 

next to "Current Date". 

You can "Pause" the replay by clicking on "Pause" button. 

You can "Stop" the replay by clicking on "Stop" button. 

Forward/Backward: 

Click on "Forward" to move the chart forward. 

Click on "Backward" to move the chart backward. 

The number of bars to move is determined by the "bars" field. 

If set this field to 10, replay daily data then click on "Forward", the chart will move forward 

by 10 days. 

 

Speed: This field allows you to define the speed of the replay. The higher the value the 

quicker the replay tool will playback bars. 

 

5. Simulated Trading with the Replay Tool 

When the replay tool starts, you will see two buttons on each working chart (Chart used by 

the replay tool). 

The "Buy" button allows to enter long the current security. 

The "Short" button allows you to enter short long the current security. 

After clicking on "Buy" (Short), you can exit the position by clicking on the "Sell" (Cover) 

button. 

You can see trade entry arrows on chart. You can also see trade details after selecting the 

"Trades" tab of the "Replay Tool" form. 

To create an advanced report (Like the simulator report) from trades generated by the 

replay tool, select "Trades" tab, click on "Menu" item at the bottom then click on "Show 

Advanced Report". 

In "Settings -> Trades" tab of the replay tool, you define how to enter buy, sell, short and 

cover orders. 
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Next bar open: Trade will be executed on the open of the next bar 

Current bar close: Trade will be executed on the close of the current bar 

Limit: Trade will be executed when it reaches the % limit defined by you 

  

  

  

[TOP] 

1.8.13 Data 

ASCII Importer 
  

  

1. Introduction 
  

The ASCII Importer is used to parse text or CSV files and include the parsed content into the 

application's databases. 

The ASCII imported has many settings that let you import any kind of data into quotes or custom 

databases. 

 

N.B. the downloader plug-in use the ASCII Importer engine to parse the downloaded data. 

  

2. Import Text or CSV data 
  

To import data into the application's databases, click on 'Data' in the menu, then select 'ASCII 

Import'.  

Once the import form opens, select one or many files by clicking on 'Pick files'. 

If there are no reference to symbols in your files then you have to associate each file with a symbol 

name. To do so, just select a file in the list box, then type in a symbol name in the text box nearby the 

button 'Update symbol name', click on that button to associate a symbol to the file.  

Note that you do not have to do that if there are references to symbols in your files content. 

Click on 'Next' to go to the next screen. This screen let you define how to parse the content of your 

files, extract dates, symbols, execute script before or after parsing, associate symbols to groups, 

markets... 

 

Let us take an example; we are going to show you how to parse the current lines:  

A;01/12/08;12.2;13.3;11.5;12.1;1200 

A;01/13/08;12.2;13.3;11.5;12.1;1200 

A;01/14/08;12.2;13.3;11.5;12.1;1200  

First, we have to define the separator, in this case its ';'. 
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We do not need to escape any lines. 

We have to choose '/' as a separator for dates. 

Since the date format is Month/Day/Year, we then choose MDY as 'Date type'. 

Now we are going to create columns by clicking on the button 'Add Column'; we need to create 

seven columns.  

For each column, we select 'Quotes' as database. 

The first column field will be 'Symbol', the second one 'Date', the third 'Open', the forth 'High', the 

fifth 'Low', the seventh 'Close', the eighth 'Volume'. 

 

Click on 'Next' to go to the 'Input & Output' panel. You will get a sample of your files content as well 

as a sample of the parsed content.  

You have to click on 'Database->Field' items to see what the output will look like. 

Click again on 'Next', so that the application can parse your files. After parsing the data, you will get 

the number of errors if any, the number of symbols that will be added... If during the parsing the 

engine finds errors, go back to the previous panel and correct the errors; if there are no errors then 

click on 'Next' to start the importing process. 

  

3. Columns 
  

The columns are used to parse the content of the files. Look at the 'Import Text or CSV data' 

paragraph for an example. 
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Click on the Red Cross to remove a column. 

You can associate a column to a quote or a custom database; double click on the cells that belong to 

the 'Database' column to see the available databases. 

You can set 'Skip' as a field to skip the current column. 

  

4. Import Settings 
  

 Automatically add new symbols:  Add the new symbols the parser finds.  
 "Disable 'Associate new symbols to ...'": Make sure symbols will not be associated with any 

market, industry, group or index.  
 "Replace data if same date": Override the existing data if data of the same date is found  
 "Remove old data from database if exists": Before parsing, remove all the available content 

for the symbols that are going to be used in the import process.  
 "Continue parsing even if there are errors": Continue the parsing process even if there are 

errors.  
 "Text Qualifiers": Text between text qualifiers is treated as a single element.  

Example: (comma as separator and double quotes as text qualifiers) 
12,"12,5" -> element 1: (12) and element 2: (12,5). 
If we haven't specified text qualifiers, we would have: element1 : (12), element 2: ("12) and 
element 3: (5")  

  
  

5. Advanced Date Format 
   

In the 'ASCII Import' form, set 'Data type' to custom. 

 

   

The date format is defined as: [Y]/[M]/[D] [h]:[m]:[s]:[i] 

[Y]: year with four digits, example: 2008. 

{Y}: year with two digits, example: 08. 

[M]: month 

[D]: date 
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[h]: hour 

[m]: minute 

[s]: second 

[i]: milliseconds 

If the date you want to parse if for example: 12 01 2002 20:10, then set the date format to [D] [M] [Y] 

[h]:[m]. 

 

Exclude button:  

Exclude keywords from a date. 

Example: If your date is "Monday 12/01/2004", before parsing this date, you should get rid of the 

word 'Monday'. To do so, click on 'Exclude button' and insert the word 'Monday'.  

Replace button:  

Replace a keyword with another one. 

Example: If your date is "2001M1" and M1 means January. You should click on replace button, and 

then click on 'Add row'. In that row, you have to type 'M1' under the 'old' column and type '/01/01' 

under the 'new column'. The date value will be "2001/01/01". 

 

 

  

6. Pre-Parsing Script 

 

Pre-Parsing Script is used to modify content before parsing begins. 
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Example:  

Your content looks like this: 

A;01/01/2008;A was upgraded by JP Morgan 

B;01/01/2008;B was upgraded by JP Morgan 

C;02/01/2008;C was downgraded by JP Morgan 

D;01/01/2008;D was upgraded by JP Morgan  

You want to create a column that contains data indicating whether the stock was downgraded or 

upgraded. 

 

First, we should create four columns; set the databases and fields. 

Now click on "Pre-Script" button.  

At any moment you can press on 'CTRL+SPACE' to see the available variables. 

In the Pre-Parsing script, we have one variable: "Content". 

"Content" is of type "PreScript" 

"Content" contains the content of each row or line. It also contains two functions: 

 

AddRow: Add a new row or line. You must pass the elements to be added as parameters. The 

number of elements must be equal to the number of elements in the orginal content. There are 

three elements in our example. 

Example of how to use "AddRow": 
Content.AddRow("GOOG","01/01/2008","GOOG was upgraded then downgraded"); 

 

GetURLORFileName: Gets the URL of file name of the content we are going to parse.  

 

Each row contains two variables: 'Data' and 'IsIgnoreLine' 

 

"Data" is an array of string: Contains the parsed line data. In our example: (for line number 1) Data[0] 

contains 'A', Data[1] contains '01/01/2008'... 

"IsIgnoreLine" is a Boolean: Specify whether to accept or ignore the current line or row. 

The Pre-Script is executed for each file or document.  

In our example, we want to check if the column number three (referenced by Data[2] -arrays start 
with the index zero-) contains the word 'Upgraded'. 
 
Here is the script:  
 
for(var i:int = 0;i<Content.Rows.Length;i++) 

{ 

if(Content.Rows[i].Data[2].Contains("Upgraded")) 

{ 

Content.Rows[i].Data[3] = "1"; 

} 

else 

{ 

Content.Rows[i].Data[3] = "0"; 

} 

}  
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The fourth column value is '1' if the stock is upgraded, otherwise its value is '0'. 

You can remove the 'else' statement in the script and set a default value of '0' in the fourth column. 

  

7. Post-Parsing Script 
  

Post-Parsing Script is used to modify parsed content. 

Example of usage: Look at the parsed symbol quotes and correct bad ticks. 

 

The Post-Parsing Script contains one variable: "Data"  

"Data" is of type "PostScript" 

"Data" contains the parsed content for each date. 

 

Each row contains two variables: 

Date: A date 

Data: An array of objects (could be numeric 'double' or 'text') for the date referenced by the variable 

'Date'  

IsIgnoreLine: Specify whether to ignore the current row or not.  

The Post-Script is executed for each symbol.  

 

If your columns are defined like this:  

Column 1: Symbol 

Column 2: Date 

Column 4: Open 

Column 5: High 

Column 6: Low 

Column 7: Close 

Column 8: Volume  

In addition, your file content is: 

A;13/12/2008;11;11;11;11;100 

A;12/12/2008;12;12;12;12;200 

 

Then variable 'Data' (of type PostScript) will contain two rows. 

In the first row, the variable 'Date' will have '13/12/2008' as value and the variable 'Data' will be an 

array. 

Data[0] = 11 

Data[1] = 11 

Data[2] = 11 

Data[3] = 11 

Data[4] = 100 
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1.8.13.1 Downloading Data 

 

 

 

 

Downloading Data 

 

 

1. Downloader 

 

The downloader plug-in is a powerful tool that allows you to automatically download data 

from the Internet, parse it then add it to your quotes or custom databases. 

 

A download item is an object created using the downloader plug-in. It contains the URLs, 

scripts and the logic that lets you get your favorite data automatically. 

 

There are hundreds of download items freely available on QuantShare Sharing server. 

If you want to create your own download item, please go to the "Downloader" section of 

this documentation. 

 

 

 

2. Download data wizard 

 

The download data wizard is a tool that allows you to download automatically a list of 

symbols and one or several downloaders for the selected exchange/market. 

The list of symbols and downloaders are available in the sharing server. 
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To open the download data wizard: 

- Select "Download" then "Download Data Wizard". 

- After the form is opened, the list of items is downloaded from our servers. 

- You can use the "Search" field to find a specific exchange/market. 

- Select an exchange to display the list of items that will be downloaded from the sharing 

server. 

Once you click on the "Download" button, the following steps are performed: 

- A new account is created 

- The objects are downloaded from the sharing server 

- The objects are installed and executed 

 

If you want to add the symbols in the current account, check the "Install the package in the 

same account" field. 

 

Example of available markets: (+40 Markets/Exchanges are available) 

US Stock Market 

US Delisted Stocks 

US Options 

Forex Market 

Exchange-Traded Funds 

Futures Market 

Russian Stock Market 

Amsterdam Stock Exchange 

 

Note that not all markets are available. In this case, you should visit the sharing server to 

find a specific data downloader for your market. 

 

 

 

3. Auto-Download quotes 
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"Auto-Download" is a feature that automatically downloads EOD and Intraday data when 

you open a new chart or select another symbol for an active chart. 

 

QuantShare automatically detects the downloader that was previously used to get data for 

the current symbol and then use it to get new data. 

 

To enable "Auto-Download" feature, select "Download" then "Auto-Download Quotes". 

Perform the same action to disable this feature. 

 

 

 

4. Download from watchlist 

 

- Select one or several securities in your watchlist 

- Right click on the grid/table 

- Select "Download data for selected symbols" 

- Select the appropriate downloader 

 

There are two categories of downloaders (Name in grey) 

- Historical/Intraday: Downloaders that save data in historical/intraday/tick databases 

- Custom: Downloaders that save data in custom databases 

 

You can download data for all securities in a watchlist by selecting "Download data for all 

symbols" (In the context menu after you right click on the watchlist grid/table) 

 

 

5. Download from chart 

 

To download data for a security directly from a chart: 
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- Click on the circle icon located at the bottom-right corner of the chart 

- Select "Download Data for..." 

- Select the appropriate downloader 

 

The chart is automatically updated when the downloading process is completed 

 

 

 

 

[TOP] 

1.8.13.2 ASCII Importer 

ASCII Importer 
  

  

1. Introduction 
  

The ASCII Importer is used to parse text or CSV files and include the parsed content into the 

application's databases. 

The ASCII imported has many settings that let you import any kind of data into quotes or custom 

databases. 

 

N.B. the downloader plug-in use the ASCII Importer engine to parse the downloaded data. 

  

2. Import Text or CSV data 
  

To import data into the application's databases, click on 'Data' in the menu, then select 'ASCII 

Import'.  

Once the import form opens, select one or many files by clicking on 'Pick files'. 

If there are no reference to symbols in your files then you have to associate each file with a symbol 

name. To do so, just select a file in the list box, then type in a symbol name in the text box nearby the 

button 'Update symbol name', click on that button to associate a symbol to the file.  

Note that you do not have to do that if there are references to symbols in your files content. 

Click on 'Next' to go to the next screen. This screen let you define how to parse the content of your 

files, extract dates, symbols, execute script before or after parsing, associate symbols to groups, 

markets... 

 

Let us take an example; we are going to show you how to parse the current lines:  
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A;01/12/08;12.2;13.3;11.5;12.1;1200 

A;01/13/08;12.2;13.3;11.5;12.1;1200 

A;01/14/08;12.2;13.3;11.5;12.1;1200  

First, we have to define the separator, in this case its ';'. 

We do not need to escape any lines. 

We have to choose '/' as a separator for dates. 

Since the date format is Month/Day/Year, we then choose MDY as 'Date type'. 

Now we are going to create columns by clicking on the button 'Add Column'; we need to create 

seven columns.  

For each column, we select 'Quotes' as database. 

The first column field will be 'Symbol', the second one 'Date', the third 'Open', the forth 'High', the 

fifth 'Low', the seventh 'Close', the eighth 'Volume'. 

 

Click on 'Next' to go to the 'Input & Output' panel. You will get a sample of your files content as well 

as a sample of the parsed content.  

You have to click on 'Database->Field' items to see what the output will look like. 

Click again on 'Next', so that the application can parse your files. After parsing the data, you will get 

the number of errors if any, the number of symbols that will be added... If during the parsing the 

engine finds errors, go back to the previous panel and correct the errors; if there are no errors then 

click on 'Next' to start the importing process. 

  

3. Columns 
  

The columns are used to parse the content of the files. Look at the 'Import Text or CSV data' 

paragraph for an example. 
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Click on the Red Cross to remove a column. 

You can associate a column to a quote or a custom database; double click on the cells that belong to 

the 'Database' column to see the available databases. 

You can set 'Skip' as a field to skip the current column. 

  

4. Import Settings 
  

 Automatically add new symbols:  Add the new symbols the parser finds.  
 "Disable 'Associate new symbols to ...'": Make sure symbols will not be associated with any 

market, industry, group or index.  
 "Replace data if same date": Override the existing data if data of the same date is found  
 "Remove old data from database if exists": Before parsing, remove all the available content 

for the symbols that are going to be used in the import process.  
 "Continue parsing even if there are errors": Continue the parsing process even if there are 

errors.  
 "Text Qualifiers": Text between text qualifiers is treated as a single element.  

Example: (comma as separator and double quotes as text qualifiers) 
12,"12,5" -> element 1: (12) and element 2: (12,5). 
If we haven't specified text qualifiers, we would have: element1 : (12), element 2: ("12) and 
element 3: (5")  

  
  

5. Advanced Date Format 
   

In the 'ASCII Import' form, set 'Data type' to custom. 

 

   

The date format is defined as: [Y]/[M]/[D] [h]:[m]:[s]:[i] 

[Y]: year with four digits, example: 2008. 

{Y}: year with two digits, example: 08. 

[M]: month 

[D]: date 
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[h]: hour 

[m]: minute 

[s]: second 

[i]: milliseconds 

If the date you want to parse if for example: 12 01 2002 20:10, then set the date format to [D] [M] [Y] 

[h]:[m]. 

 

Exclude button:  

Exclude keywords from a date. 

Example: If your date is "Monday 12/01/2004", before parsing this date, you should get rid of the 

word 'Monday'. To do so, click on 'Exclude button' and insert the word 'Monday'.  

Replace button:  

Replace a keyword with another one. 

Example: If your date is "2001M1" and M1 means January. You should click on replace button, and 

then click on 'Add row'. In that row, you have to type 'M1' under the 'old' column and type '/01/01' 

under the 'new column'. The date value will be "2001/01/01". 

 

 

  

6. Pre-Parsing Script 

 

Pre-Parsing Script is used to modify content before parsing begins. 
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Example:  

Your content looks like this: 

A;01/01/2008;A was upgraded by JP Morgan 

B;01/01/2008;B was upgraded by JP Morgan 

C;02/01/2008;C was downgraded by JP Morgan 

D;01/01/2008;D was upgraded by JP Morgan  

You want to create a column that contains data indicating whether the stock was downgraded or 

upgraded. 

 

First, we should create four columns; set the databases and fields. 

Now click on "Pre-Script" button.  

At any moment you can press on 'CTRL+SPACE' to see the available variables. 

In the Pre-Parsing script, we have one variable: "Content". 

"Content" is of type "PreScript" 

"Content" contains the content of each row or line. It also contains two functions: 

 

AddRow: Add a new row or line. You must pass the elements to be added as parameters. The 

number of elements must be equal to the number of elements in the orginal content. There are 

three elements in our example. 

Example of how to use "AddRow": 
Content.AddRow("GOOG","01/01/2008","GOOG was upgraded then downgraded"); 

 

GetURLORFileName: Gets the URL of file name of the content we are going to parse.  

 

Each row contains two variables: 'Data' and 'IsIgnoreLine' 

 

"Data" is an array of string: Contains the parsed line data. In our example: (for line number 1) Data[0] 

contains 'A', Data[1] contains '01/01/2008'... 

"IsIgnoreLine" is a Boolean: Specify whether to accept or ignore the current line or row. 

The Pre-Script is executed for each file or document.  

In our example, we want to check if the column number three (referenced by Data[2] -arrays start 
with the index zero-) contains the word 'Upgraded'. 
 
Here is the script:  
 
for(var i:int = 0;i<Content.Rows.Length;i++) 

{ 

if(Content.Rows[i].Data[2].Contains("Upgraded")) 

{ 

Content.Rows[i].Data[3] = "1"; 

} 

else 

{ 

Content.Rows[i].Data[3] = "0"; 

} 

}  
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The fourth column value is '1' if the stock is upgraded, otherwise its value is '0'. 

You can remove the 'else' statement in the script and set a default value of '0' in the fourth column. 

  

7. Post-Parsing Script 
  

Post-Parsing Script is used to modify parsed content. 

Example of usage: Look at the parsed symbol quotes and correct bad ticks. 

 

The Post-Parsing Script contains one variable: "Data"  

"Data" is of type "PostScript" 

"Data" contains the parsed content for each date. 

 

Each row contains two variables: 

Date: A date 

Data: An array of objects (could be numeric 'double' or 'text') for the date referenced by the variable 

'Date'  

IsIgnoreLine: Specify whether to ignore the current row or not.  

The Post-Script is executed for each symbol.  

 

If your columns are defined like this:  

Column 1: Symbol 

Column 2: Date 

Column 4: Open 

Column 5: High 

Column 6: Low 

Column 7: Close 

Column 8: Volume  

In addition, your file content is: 

A;13/12/2008;11;11;11;11;100 

A;12/12/2008;12;12;12;12;200 

 

Then variable 'Data' (of type PostScript) will contain two rows. 

In the first row, the variable 'Date' will have '13/12/2008' as value and the variable 'Data' will be an 

array. 

Data[0] = 11 

Data[1] = 11 

Data[2] = 11 

Data[3] = 11 

Data[4] = 100 
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1.8.13.3 Downloader 

Downloader 
 

  

The downloader plug-in downloads CSV, text, excel, compressed (ZIP), or RSS data from any website, 

parses it, transforms it, and then imports it to your databases. 

N.B. the downloader plug-in uses the ASCII Importer engine to parse the downloaded data. 

1. Introduction 
  

Each download item is associated with one or sereral URLs, and each URL can contain any number of 

fields. 

 

If for example you want to import stock quotes for the server 'www.example.com', and the complete 

URL to get stock quotes for the symbol "goog" is "www.example.com/quotes.php?id=goog". 

In addition, you have to login using the following URL  

"http://www.example.com/login.php?user=xx&pass=yy" before being able to download any quotes. 

 

Given this example, your download item, should contains two URL: 

1 – "http://www.example.com/login.php" 

2 – "http://www.example.com/quotes.php" 

The first URL should contain two fields, one for the login and another one for the password. 

The second URL should contain a field named 'id', you have to set this field's type to 'Symbol'. 

  

2. Create a download item 
  

Open the download manager by clicking on 'Download' in the menu bar, then 'Download Manager'. 

Click on 'Add', in the download manager. 

  

2.1. Download Steps 
  

'Download Steps' are the URLs that the downloader must visit in order to download your content. 

Click on 'Add URL' to add a new download step. 
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2.2. Fields 
  

You can associate one or more fields to each 'Download Step' or URL. 

First, add a new URL, and then click on the button 'Fields' under the 'Fields' column. Fields are used 

as parameters. 

 

To add new fields, click on 'Add Field'. 

To remove a field, select one, and then click on 'Remove Selected Field'. 

To close the fields form, click on 'Close'. 

When adding a field, you should specify four things: 

         Field name: The name that will be used in the URL 

         Field value: The value that will be used in testing and in static fields like the login and 

password fields; the value of a dynamic field is automatically updated in the downloading 

process. 

         Field Type: The type associated with the field. 

         Field visibility: Indicate whether to display the field as a URL parameter or not. Check the 

box to hide the field. You still can use the fields data (please refer to how to use brackets). 
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Example:  

URL: "www.example.com/test.php?a=2" 

Field Name: b 

Field Value: test 

Field Type: Custom 

 

In the testing process, the software will use this URL: www.example.com/test.php?a=2&b=test. 

In the downloading process, if you put the following values (EX1 and EX2) in the text box inside the 

tab associated with the field "b": 

The downloader will use theses URLs to download your content: 

"www.example.com/test.php?a=2&b=EX1" 

"www.example.com/test.php?a=2&b=EX2"  

 

How to use brackets: 

In order to use a field inside a URL you should insert the field name inside brackets. 

Let us take the last example: "www.example.com". 

You can display the value "2" that corresponds to the field "a", using the following text: [a] 

Example: "www.example.com/test_[a].php". 

 

Keywords: 

[DATE]: displays the date 

[SYMBOL]: displays the symbol 

[field_name]: displays any field value 

  

2.3. Ordering URLs 
  

Open the 'Update Download Item' form. 

Click on the icon within the 'Up' column. 

  

2.4. CSV, Excel, RSS, ZIP 
  

After you have added the URL, specified the fields, and depending on the content you are parsing, 

click on the cell within the 'Parser' column and select the appropriate content type. 

Click on 'Parser' to open the 'Parser' form. 

This form will upload some content to help you fill in the appropriate parsing settings. 

Look at the 'ASCII Import' plug-in for more information. 

 

Excel: Download excel file and parse the content of every sheet. 

RSS: Download RSS feed then transform it to CSV. 

Zip: Download a compressed archive and parse every file included inside the archive. 

http://www.example.com/test.php?a=2&b=test
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2.5. Settings 

 

Click on the "Settings" cell to open the settings form. 

Within this form you can specify: 

Whether to submit the fields data with a POST or GET method. 

Whether to execute the URL-Script once or for each combination of fields. 

For more information on the URL-Script, please visit the appropriate section. 

 

The URL-Script is executed before downloading any data. This script lets you define dynamic URLs. It 

is executed for each combination of fields, which means that if for example you are using 10 symbols 

and a custom field with 2 custom data, this script will be executed 20 times, once for each "Symbol - 

Custom data" combination. If you check the above element (execute the URL-Script once), then the 

script will be executed only one time. You will have to define the URLs inside this script. 

2.6 Test 
  

In the 'Update Download Item' form, there is a button named 'Test'. 

Click on this button to see how the application will browse your URLs to import your content. 

This tool is designed to help you find and correct possible problems. 

  

2.7. Detect 
  

In the 'Update Download Item' form, there is a button named 'Detect'. 

Click on this button to open a browser page. Visit your content pages URLs to look for all the form 

fields names. 

This tool is designed to help you create your download item. 

  

3. Download Settings 
  

3.3. Settings 

 Maximum number of download threads to allow: specify how many concurrent threads to 
use during the downloading process.   

 This item should download data every: You specify here a number of days for your download 
item, and the application will alert you each time a download item needs to be run. A column 
named 'Need a run', in the 'Download Manager' form, tells you if the download item needs a 
run or not.  

 Number of seconds to wait between requests  
 Database to use for the 'last symbol date': Use this option to download only missing quotes 

or data. Select a database so the downloader can grab the last date from the symbol data in 
the specified database.  

  
3.4. Proxies 

Specify a list of proxy URLs to use when downloading data. 

Each line represents a proxy URL. 
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3.5. Symbol translation table 
  

Translate symbols before downloading data. 

Change the symbol name in the URL that will be used to download data. 

Each line represents the source and destination symbol pair. 

3.6. Offset dates 
  

The "offset dates" button let you offset dates components. 

If for example yahoo wants the month component to vary from 0 to 11, 0 means January and 11 

means December, then in the 'Offset Dates', set the 'Offset Month' numeric box to one. 

 

 
 

4. Using the downloader 
  

To open the downloader form, select "Download -> Download Manager". 

Select a download item then click on "Open".  

Click on the button "Start" to begin the downloading process. 

The progress column shows you the download progression and each time a download is complete, 

the corresponding row is unchecked. 

 

In the "download items" grid, the "Last" column indicates the number of days since the last 

execution of the corresponding item. 
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4.1. Symbols 
  

If you have specified a symbol field in the 'Update Download Item' form, then a 'Symbols' tab will 

appear. 

Select the symbols you would like to download. 

 

  

4.2. Dates 
  

If you have specified a Date field in the 'Update Download Item' form, then the 'Dates' tab will 

appears. 
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In this tab, select the start date, the end date, the format, the interval, then click on 'Save'. 

The 'Dates' text box, will show you the dates that are going to be used in the downloading. 

Format text box: 

[Y]: year, example: 2008 

[Y2]: year, example: 08 

[M]: month, example: 01 or 10 

[M2]: month, example: 1 (without the 0) or 10 

[D]: day, example: 01 or 22 

[D2]: day, example: 1 (without the 0) or 22 

In 'Update Download Item' form, you can also specify dates component within the URL. 

Example for yahoo: 

http://ichart.finance.yahoo.com/table.csv?a=[2M2]&b=[2D2]&c=[2Y]&d=[M2]&e=[D2]&f=[Y]&g=d&i

gnore=.csv 

 

Dates format are a little bit different here:  

[Y], [Y2], [M], [M2], [D], [D2] refers to first date (FROM), while [2Y], [2Y2], [2M], [2M2], [2D], [2D2] 

refers to second date (TO). 

 

 

4.3. Start and end dates 

 

If you have specified date components within URLs, a 'Start & End Dates' tab will appears in the 

'Download Data' form. 

Select 'Last symbol data' to download only missing quotes or data.  

The database that will be used to get the last downloaded date for a particular symbol can be set in 

the 'Download Settings' form. 

http://ichart.finance.yahoo.com/table.csv?a=%5b2M2%5d&b=%5b2D2%5d&c=%5b2Y%5d&d=%5bM2%5d&e=%5bD2%5d&f=%5bY%5d&g=d&ignore=.csv
http://ichart.finance.yahoo.com/table.csv?a=%5b2M2%5d&b=%5b2D2%5d&c=%5b2Y%5d&d=%5bM2%5d&e=%5bD2%5d&f=%5bY%5d&g=d&ignore=.csv
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4.4. Custom fields 
  

If you have specified a custom field in the 'Update Download Item' form, then a tab containing a text 

box will appear. 

Each line inside this text box corresponds to a value. 

 
  

4.5. Description 

 

In this control, the description of the download item is displayed. 

 

To update the description: 

 

- Select the download item 

- Click on "Update" 

- Type the description under "Description" panel 

- Click on "OK" 

 
  

4.6. Settings 

 

There are two settings you can update here: 

 

- Send updates every (n) minutes:  If this option is disabled then the downloader waits until the 

downloading process is completed before informing plug-ins of new data. Otherwise it informs plug-

ins (Composites, Watchlists...) of new data every (N) minutes. 

 

- Refresh charts after download: If this option is enabled then charts are automatically refreshed 

when the downloading process is completed. 
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5. Downloader Scripts 
  

 

5.1. URL-Script 

 

If you need to dynamically specify the URL to download then you have to use the URL-Script to 

programmatically specify what URLs or URLs paths to use. 

A URL path is a sequence of URLs. It is used if for example before loading a URL, the website requires 

that you load some other pages, login... 

A URL is added using the following function: 

Functions.AddURL 

 

A URL path is added using the following functions: 

Functions.CreateURLPath: creates an URL path. 

AddURL: adds an URL to an URL path. 

Functions.AddURLPath: adds an URL path.  

 

The (Functions.Net) class contains different methods to download, extract and parse HTML 

documents.  

 

5.2. Summary 

The engine will look for URLs specified in the URL-Script; it downloads them and split the content 

using the parser settings. It then passes the split content to the Pre-Script. This script allows you to 

modify the provided data. Finally the content is parsed and before added to the quotes or custom 

databases, it is passed to the Post-Script. 
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1.8.13.4 Data Viewer 

Data Viewer 
 

  

1. Introduction 
  

The data viewer lets you display database data inside a table. 

  

 

  

2. Show database data 
  

To open the 'database data' form; select the 'Tools' menu then click on 'Databases Data'. 

To display database data, you need to select a database by selecting one in the 'Database' combo 

box, then click on the icon next to Filters and select for which symbols you want to display data. If 

you select 'Selected chart', then the grid content will be automatically updated each time the select 

chart symbol changes. 
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Click on the watch icon, depending on the period of time you select, the plug-in will only display data 

that meets the time constraint. 

 

  

  

3. Filter database lines 
  

You can filter database data, by typing a keyword in the 'Search' text box and by selecting a database 

field. 

  

4. Data Viewer Settings 
  

Each grid line has a different color depending on the age of the data. You can choose the colors by 

selecting the 'Settings' tab in the 'Data Viewer' form. 

 

  

  

5. Plot data on the chart 
  

To plot data on a chart, click on 'Show data on chart' in the 'Data Viewer' form. 
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Click on the chart rectangle or circle to display information. 

You can control how to display data on the chart in the 'Settings' tab panel. 
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6. Action on row double click 

By right clicking on the data table, you can select the default action to take when a row is 
double clicked. 

Nothing: No action is taken 
Change the selected chart: Associates the selected symbol to the current active chart and 
displays the bar where the data entry occurred. 
Open a new chart: This will open a new chart for the selected symbol 

  

[TOP] 

1.8.14 Analysis 

Rules Manager 

  

1. Introduction 

The Rules manager allows you to manage and create easily and quickly as many rules as you want. 

A rule is a formula that can be used in charting, simulation...  

A list of rules is a list that contains one or many rules. 

A rule can have one or several iterations.  

You can create undefined variables within a rules and specify the start, the end and the increment 

value of these variables. 

This process makes it easy to create hundreds of rules. 

List of rules can be used in many situations. 

Examples:  

You can back-test rules to see how each rule performs. 

You can use the optimizer, and run a genetic algorithm process on a list of rules to see which 

combination of rules performs best.  
When creating a trading system, you can define already created rules as buy, sell, and short or cover 

entries.  

2. Create a rule 

Open the rule manager (Analysis -> Rules Manager)  

Click on 'Add' to create a list of rules 

Select the list of rules you have just created. 
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Here is how to create a rule. 

If you rule is something like x > y or x = y, you just have to type the first component in the first input 

box, and the second one in the second input box. 

 

Example: rsi (14) > 50  

 

  

A red flag means that there is an error in the formula, if everything is ok then the red drag will turn 

into a green one. 

In the combo box you can select NA, and then type directly the formula in the first input 

 

  

When you click on the icon next to the red flag, a small form will appear. 

This form contains all functions definitions and parameters, use it to select the function you would 

like to include in your formula then click on OK. 
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The grid below the inputs boxes is used to transform one rule into several ones. 

Example: instead of specifying "rsi (14) > 50", you can type "rsi (14) > a", a line in the grid will appear. 

 

Type in the minimum, the maximum and the step value 

In this example, we set a min of 50, a max of 90 and a step of 10, and this rule became a five 

iterations rule. 
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3. Rules Manager 
  

Open the rule manager (Analysis -> Rules Manager) 

 

  

 Add: Create a list of rules, a dialog box will show up, you just have to enter a name and click 
on OK  

 Remove: Select a list of rules from the list of rules List then click on "Remove" to delete this 
list  

 Analyze: Analyze a list of rules (See below)  
 Mass Rules: Create mass rules (See below)  
 Close: Close the 'Rules Manager' form  

  

4. Drag and drop 

You can drag and drop rules or list of rules by selecting a rule or a list of rules and dragging it to the 

clipboard. 

From the clipboard, you can drag the posted rules by clicking on 'copy'. 
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5. Mass Rules 

'Mass rules' is a tool that will help you create many rules very quickly using masks. 

 

Click on 'Mass Rules' button; a dialog box will appears. 

Now you have two ways to add functions: 

 Add button  
 Add from time-series button   

  

The added functions will appear on the left list. 

In our example, we added two functions: Inside() and Outside() 
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You can now create your masks and specify variables within masks if needed. 

Type for example: mask > ref(mask, a) then click on Create, and make variable "a" vary from one to 

10 with one as a step. We are about now to create 20 rules (2 rules and ten iterations for each rule) 

After clicking on "Create Rules", two rules will be created (with 10 iterations for each rule) 

Inside() > ref(Inside(), a) 
Outside() > ref(Outside(), a) 

  

6. Analyze rules 

Analyze rules is a tool that will let you back-test your rules one by one before using them in ranking 

systems, simulation, neural networks... 

 

The rules analyzer is not limited to analyzing the performance of trading rules,  it can also be used to 

analyze any market behavior that occur after the trading rule signal become valid. 

If you are trading options, you can for example analyze which rules or combination of rules lead to a 

security higher volatility. 

Select a list of rules then click on Analyze, the settings dialog box will appear. 

  

 

6.1. Symbols & Periods 

 

Specify the symbols and the simulation period. 

  

 

6.2. Filter 

 

Specify upper and lower limits for a position output; every position with an output value outside 

these limits will be rejected. 

You can also specify limits by selecting a maximum number of standard deviation for position 

outputs. 

  

 

6.3. Outputs 

 

Outputs are formulas that the back-tester calculates when he enters a new position. Example: 

Performance for the next 10 bars which corresponds to the formula "perf(open, -10)"  

The outputs form appears once you click on the "Select Outputs" button. 
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Defined outputs:  

Performance, use a trailing stop: Enter a position then exit when drawdown reach –X Percent 

(Trailing stop) 

Performance, use N-Bars stop: Enter a position then exit after X bars (N-Bars stop) 

Performance, custom rule for exit + trailing stop: Enter a position then exit when drawdown reach –X 

Percent or when the specified rule is TRUE. 

Performance, exit when rule is false: Enter a position then exit when the rule is no longer TRUE or 

valid. 

 

The "Custom Output" lets you add your own advanced formula. 

See (HELP: Advanced Rules; Output) for an example 

  

 

6.4. Fixed Rule 

You can specify a fixed rule that will be added to the rules to be analyzed. 

Fixed rule can contain iterations. 

Example: 

Let us say we want to analyze theses rules: 

 RSI (14) > 10  
 Perf (close, 10) > a, where "a" varies from two to four, with a step of two 

   
As a fixed rule, we have: 

"close > cl" , where "cl" varies from 10 to 20 with a step of 10. 

You will end up with a total of "1 + (1 * 2)" rules multiplied by 2 (fixed rules) for a total number of six 

rules. 

Here is the list of all the rules that will be analyzed: 

close > 10 && Rsi(14) > 10 

close > 10 && Perf(close, 10) > 2 

close > 10 && Perf(close, 10) > 4 

close > 20 && Rsi(14) > 10 

close > 20 && Perf(close, 10) > 2 

close > 20 && Perf(close, 10) > 4 

  

 

 

6.5. Metrics 
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CSharp or JScript.Net languages are used to create metrics. 

Example of metric formula: 

 
Fitness = OutputPerBar * (NbPositions > 100); 

Set the output to zero if the number of position generated by the rules is lower than one 

hundred. 

For each "metric formula", you can add additional metrics using the following function: 
Functions.AddMetric 

  

6.6. Results 

When analyzing rules completes, a grid containing the results appears. 

 

 

 

Each line represents a rule or iteration. 

 

Columns abbreviations:  

         Out PB: Average position outputs per bar 

         Output: Average position outputs 

         Bars held: Average number of bars per position 

         Positions: Number of positions 

         PP: Percentage of positive position output 

         Best: Best position output 
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         Work: Worst position output  

         SDV: Standard deviation of position outputs 

You can easily create new list of rules from the analyzed rules. 

 

On the "Rules" column click on the right mouse button to make a menu appears. 

Search:  

Search for rules that contain a specific keyword, found rules will be checked. 
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Graph per Output: 

Displays a chart that plots the analyzer results per output. The average of all rule outputs for each 

output type will be calculated. 
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Group results per variable: 

Displays a chart that plots the analyzer results per variable value. The average of all rule outputs for 

each variable value will be calculated. 
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1.8.14.1 Rules Manager 

Rules Manager 

  

1. Introduction 

The Rules manager allows you to manage and create easily and quickly as many rules as you want. 

A rule is a formula that can be used in charting, simulation...  

A list of rules is a list that contains one or many rules. 

A rule can have one or several iterations.  

You can create undefined variables within a rules and specify the start, the end and the increment 

value of these variables. 

This process makes it easy to create hundreds of rules. 

List of rules can be used in many situations. 

Examples:  

You can back-test rules to see how each rule performs. 

You can use the optimizer, and run a genetic algorithm process on a list of rules to see which 

combination of rules performs best.  
When creating a trading system, you can define already created rules as buy, sell, and short or cover 

entries.  

2. Create a rule 

Open the rule manager (Analysis -> Rules Manager)  

Click on 'Add' to create a list of rules 

Select the list of rules you have just created. 

Here is how to create a rule. 

If you rule is something like x > y or x = y, you just have to type the first component in the first input 

box, and the second one in the second input box. 

 

Example: rsi (14) > 50  
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A red flag means that there is an error in the formula, if everything is ok then the red drag will turn 

into a green one. 

In the combo box you can select NA, and then type directly the formula in the first input 

 

  

When you click on the icon next to the red flag, a small form will appear. 

This form contains all functions definitions and parameters, use it to select the function you would 

like to include in your formula then click on OK. 
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The grid below the inputs boxes is used to transform one rule into several ones. 

Example: instead of specifying "rsi (14) > 50", you can type "rsi (14) > a", a line in the grid will appear. 

 

Type in the minimum, the maximum and the step value 

In this example, we set a min of 50, a max of 90 and a step of 10, and this rule became a five 

iterations rule. 
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3. Rules Manager 
  

Open the rule manager (Analysis -> Rules Manager) 

 

  

 Add: Create a list of rules, a dialog box will show up, you just have to enter a name and click 
on OK  

 Remove: Select a list of rules from the list of rules List then click on "Remove" to delete this 
list  

 Analyze: Analyze a list of rules (See below)  
 Mass Rules: Create mass rules (See below)  
 Close: Close the 'Rules Manager' form  

  

4. Drag and drop 

You can drag and drop rules or list of rules by selecting a rule or a list of rules and dragging it to the 

clipboard. 

From the clipboard, you can drag the posted rules by clicking on 'copy'. 
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5. Mass Rules 

'Mass rules' is a tool that will help you create many rules very quickly using masks. 

 

Click on 'Mass Rules' button; a dialog box will appears. 

Now you have two ways to add functions: 

 Add button  
 Add from time-series button   

  

The added functions will appear on the left list. 

In our example, we added two functions: Inside() and Outside() 
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You can now create your masks and specify variables within masks if needed. 

Type for example: mask > ref(mask, a) then click on Create, and make variable "a" vary from one to 

10 with one as a step. We are about now to create 20 rules (2 rules and ten iterations for each rule) 

After clicking on "Create Rules", two rules will be created (with 10 iterations for each rule) 

Inside() > ref(Inside(), a) 
Outside() > ref(Outside(), a) 

  

6. Analyze rules 

Analyze rules is a tool that will let you back-test your rules one by one before using them in ranking 

systems, simulation, neural networks... 

 

The rules analyzer is not limited to analyzing the performance of trading rules,  it can also be used to 

analyze any market behavior that occur after the trading rule signal become valid. 

If you are trading options, you can for example analyze which rules or combination of rules lead to a 

security higher volatility. 

Select a list of rules then click on Analyze, the settings dialog box will appear. 

  

 

6.1. Symbols & Periods 

 

Specify the symbols and the simulation period. 

  

 

6.2. Filter 

 

Specify upper and lower limits for a position output; every position with an output value outside 

these limits will be rejected. 

You can also specify limits by selecting a maximum number of standard deviation for position 

outputs. 

  

 

6.3. Outputs 

 

Outputs are formulas that the back-tester calculates when he enters a new position. Example: 

Performance for the next 10 bars which corresponds to the formula "perf(open, -10)"  

The outputs form appears once you click on the "Select Outputs" button. 
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Defined outputs:  

Performance, use a trailing stop: Enter a position then exit when drawdown reach –X Percent 

(Trailing stop) 

Performance, use N-Bars stop: Enter a position then exit after X bars (N-Bars stop) 

Performance, custom rule for exit + trailing stop: Enter a position then exit when drawdown reach –X 

Percent or when the specified rule is TRUE. 

Performance, exit when rule is false: Enter a position then exit when the rule is no longer TRUE or 

valid. 

 

The "Custom Output" lets you add your own advanced formula. 

See (HELP: Advanced Rules; Output) for an example 

  

 

6.4. Fixed Rule 

You can specify a fixed rule that will be added to the rules to be analyzed. 

Fixed rule can contain iterations. 

Example: 

Let us say we want to analyze theses rules: 

 RSI (14) > 10  
 Perf (close, 10) > a, where "a" varies from two to four, with a step of two 

   
As a fixed rule, we have: 

"close > cl" , where "cl" varies from 10 to 20 with a step of 10. 

You will end up with a total of "1 + (1 * 2)" rules multiplied by 2 (fixed rules) for a total number of six 

rules. 

Here is the list of all the rules that will be analyzed: 

close > 10 && Rsi(14) > 10 

close > 10 && Perf(close, 10) > 2 

close > 10 && Perf(close, 10) > 4 

close > 20 && Rsi(14) > 10 

close > 20 && Perf(close, 10) > 2 

close > 20 && Perf(close, 10) > 4 

  

 

 

6.5. Metrics 
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CSharp or JScript.Net languages are used to create metrics. 

Example of metric formula: 

 
Fitness = OutputPerBar * (NbPositions > 100); 

Set the output to zero if the number of position generated by the rules is lower than one 

hundred. 

For each "metric formula", you can add additional metrics using the following function: 
Functions.AddMetric 

  

6.6. Results 

When analyzing rules completes, a grid containing the results appears. 

 

 

 

Each line represents a rule or iteration. 

 

Columns abbreviations:  

         Out PB: Average position outputs per bar 

         Output: Average position outputs 

         Bars held: Average number of bars per position 

         Positions: Number of positions 

         PP: Percentage of positive position output 

         Best: Best position output 
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         Work: Worst position output  

         SDV: Standard deviation of position outputs 

You can easily create new list of rules from the analyzed rules. 

 

On the "Rules" column click on the right mouse button to make a menu appears. 

Search:  

Search for rules that contain a specific keyword, found rules will be checked. 
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Graph per Output: 

Displays a chart that plots the analyzer results per output. The average of all rule outputs for each 

output type will be calculated. 
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Group results per variable: 

Displays a chart that plots the analyzer results per variable value. The average of all rule outputs for 

each variable value will be calculated. 

 

 

 



217 QuantShare | http://www.quantshare.com 
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[TOP] 

1.8.14.2 Ranking System Manager 

Ranking System Manager 

  

1. Introduction 

A Ranking System takes a list of symbols and assigns a value to each symbol within this list. 

Generally, a symbol value ranges from zero to 100. 

 

2. Create a ranking system 

 

To create a ranking system, open the ranking system manager, Analysis->Ranking System Manager, 

click on the 'Add' button and then type a name. 

Now select the ranking system you have just created and start adding formulas and nodes. 

 

Add parent node: Add a top node  

Add node: Add a node within the selected node 

Add formula: Add a formula within the selected node  

Nodes and formula have in common: the name and the weight properties. 

Right click on a node or formula to open a menu. 

You can assign a different weight to each node or formula to give them more or less importance. 

Formulas have some others properties: 

 Formula: a rule or formula you want to use. The red flag nears the formula input box and the 
circle in the tree view indicates whether the formula is correct (green) or incorrect (red).  

 Factor: multiply the formula result by the provided value  
 Description: the description of the formula  
 Maximum and minimum levels: The maximum and minimum value the formula can have, if 

a formula return 110 while the maximum level is set to 100, then the application will use a 
value of 100.  

  

Auto update factor: If this item is checked, the application will decide which factor to apply to the 

formula. The chosen value is not always accurate, so it is better to update the 'factor' field manually. 

Generally if the formula return values between 0 and 100, for example an indicator like the relative 

strength index (rsi), then a factor of one should be used; if the formula return either zero or one (Ex : 

close > 20), then a factor of 100 should be used. 

 

Calculation example: 
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Let us make some calculation using this above ranking system as an example. 

As you can see, this ranking system contains two nodes. 

The first node contains one node which contains two formulas. 

The second node contains one formula. 

 

The calculation begins with the formulas. 

Formula: rsi (14) 

Bars 1 2 3 4 5 

Values 45 46 50 52 54 

 

Formula: rsi (7) 

Bars 1 2 3 4 5 

Values 20 23 29 20 19 

 

Formula: rsi (21) 

Bars 1 2 3 4 5 

Values 60 61 60 50 45 

 

The values equals the rsi value multiplied by the factor value of the formula, we took here a factor 

value of one. 

Now the software will calculate the parent node of theses formulas. 

For each bar, the software takes the value of each node's children (formula or node), multiply it by 

the formula or node's weight, add all the values, and then divide the result by the sum of the 

children's weights. 

 

For the bar number one and for the node 'Node1 – 1' 

S = sum of children's weights: 10 + 10 = 20 

rsi(14)  value = 45 * 10 = 450 

rsi(7)  value = 20 * 10 = 200 

rsi(14) value + rsi(7) value = 450 + 200 = 650 

'Node 1 – 1' value = 650 / 20 = 32.5. 
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Node: Node1 - 1 

Bars 1 2 3 4 5 

Values 32.5 34.5 39.5 36 36.5 

 

We make the same calculation for the 'Node2'. 

Because the 'Node2' has only one child, it will get the same values as its child. 

 

Node: Node2 

Bars 1 2 3 4 5 

Values 60 61 60 50 45 

 

Node: Node1 (same as Node1 – 1) 

Bars 1 2 3 4 5 

Values 32.5 34.5 39.5 36 36.5 

  

Now, the software will calculate the 'Top Node' (Ranking system values) which has two children 

(Node1 and Node2). 

The same calculation as described above applies. 

Top Node = ((Node1 * Node1_weight) + (Node2 * Node2_weight)) / (Node1_weight + 

Node2_weight). 

 

Therefore, for the first bar it will be: 

Top Node bar1 = ((32.5 * 100) + (60 * 50)) / (100 + 50) 

Top Node: (Ranking system values) 

Bars 1 2 3 4 5 

Values 41.67 43.33 46.33 40.67 39.33 

 

NB:  

If you want to ignore a node or formula you can uncheck it, only checked nodes are evaluated. 

  

3. Create a ranking system from a list of rules 
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Select a node, right click on it and then click on 'Add rules from list of rules'. 

You just have to select a list of rules then your ranking system will be populated with these rules. 

 

  

4. Analyze Ranking System 

To analyze or back-test a ranking system, click on 'Analyze Ranking System'. 

The 'Analyze Ranking System Settings' form will appears, update settings then click on 'Analyze'. 

 

The ranking system analyzer settings are the same as in the 'Analyze List of Rules Settings'. 

However, there are two more fields:  

         Number of buckets: Let you specify the number of buckets you want to create 

Let us say, our ranking system returns values from zero to 100, if we specify 10 as the 

number of buckets, then the application will back-test or analyze ten systems. 

The first system will be the one that have values between 0 and 10, the next one with values 

between ten and 20... (If you choose Normal Ranking as a Ranking Calculation) 

        Ranking calculation:  

 

Same number of positions in each bucket: The boundary between states are choosen so that 

each state is assigned the same number of positions. 

 

Normal Ranking: The boundary between states are choosen so all the states have the same 

size. 

Example: number of buckets = 10; bucket 1 will contains all the positions that have a rank 

between zero and ten, bucket 2 will contains all the positions that have a rank between ten 

and twenty and so on. 

 

Ranking on each rebalance date: For each rebalance period, calculate the values, sort 

symbols by their value and assign a rank to each symbol (distance between the ranks will be 

equal). 

Example: For a specific date, we have four symbols with the following ranks: 11, 10, 20, and 

90; we first sort these symbols then assign a new rank to each one, we will end up with the 

following new ranks: 0, 25, 50, and 100, where symbol number one have a rank of 25, symbol 

number two have a rank of 0 and so on. 

(The trading system back-tester uses this type of ranking) 

 Rebalance every:  The analyzer starts at the start date and advance by a number of days as 
specified in this field. For each period, a rebalance is done (old positions are closed and new 
ones are taken). 
Unlike the 'Rules Analyzer', which rebalance or taking a new position occur only after the old 
position is closed, the 'Ranking System Analyzer' takes new positions after a specific number 
of days; this position is then assigned to a bucket depending on the value of the ranking 
system at this date.  
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5. Analyze Ranking System Report 

  

The 'Analyze Ranking System Report' contains all the back-testing results related to your ranking 

system. 
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6. Analyze Nodes 

 

Instead of analyzing a ranking system, you can also analyze each node of a ranking system separately; 

this will let you know which nodes perform well. 

To analyze ranking system nodes, select a ranking system then click on 'Analyze Nodes'. 

 

7. Analyze Nodes Report 
  

The 'Analyze Nodes Report' contains all the back-testing results related to your ranking system 

nodes. 

 

Each line represents a node, as you can see in the picture below.   

 

Click on the charts to display additional back-testing information. 

 

8. Ranking System & Formulas 
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You can access a ranking system from the QuantShare language by using this function:  
Ranking("ranking system category", "ranking system name"); 

This function will return the ranking system value of the current symbol. You can use it to create 

rules and then apply them to the rules analyzer, ranking system analyzer (Ranking system based on 

another ranking system), trading systems and prediction models... 
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[TOP] 

1.8.14.3 Simulator 

Simulator 
 
  

1. Introduction 
  

The Simulator lets you test strategies or trading systems under historical market conditions to 

determine whether certain scenarios would have worked well in the past. The idea is that if a trading 

strategy would have performed well previously, it may be worth considering today. 

A trading system includes: 

 Buy rules  
 Sell rules  
 Short rules  
 Cover rules  
 Capital settings  
 Stops  
 Money management rules  
 Long and short ranking systems  

 

  

2. Create a Trading System 
  

Open the 'Simulator' (Analysis->Simulator) 

         Click on 'New' 

         Set entries and exits 

         Set the capital settings 

         Set stops 

         Set money management rules 

         Set symbols that are going to be used in this trading system 

         Set a ranking system 

Finally, click on 'Create trading system'.  

 

3. Entries, Exits and Stops 
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System Type: specify whether to create a long, a short or a long/short trading system 

 

Number of positions: Specify the maximum number of positions in the portfolio. You can use the 

advanced money management script to dynamically change the number of positions in your 

portfolio. 

 

Entries and exits settings: If a label is underlined when the mouse is over it, click on the mouse left 

button to display a small menu. You can also update values directly using the mouse wheel.  

 

Order Types: This is where you specify the default order type to use when entering a buy, sell, 

short or cover position. Click on the label next to "Buy", "Sell"... to open a menu. Select the 

order type then specify additional fields (for certain order types). 

 

Available orders: 

Market at open: Execute the order at bar open 

Market at close: Execute the order at bar close 

Limit Order: A Stop Limit order instructs the application to submit a buy or sell limit order 

when the user-specified stop trigger price is hit. 

Stop Order: A Stop order is an instruction to submit a buy or sell market order when the 

user-specified stop trigger price is attained or penetrated. 
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Stop Limit Order: A Stop Limit order instructs the application to submit a buy or sell limit 

order when the user-specified stop trigger price is hit. The order has two settings: the stop 

price and the limit price. When a security reaches the stop price, the order is transformed to 

a limit order and it is submitted at the limit price. 

 

 
 

 

Entries and exits rules: Click on a rule or on "add rule" to update, add, remove and manage rules. 

Specify the stops to apply to the trading system by clicking on the appropriate icon: 

         Maximum loss stop: Exit a position if the symbol's performance (points or percent) falls 

below this level 

         Profit target stop: Exit a position if the symbol's performance reaches this level 

         Trailing stop: Exit a position if the symbol's drawdown falls below this level 

         N-bar stop: Exit a position after a specific number of bars  

 

  

4. Capital Settings 
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The Capital settings include: 

 Initial equity  
 Periodicity: rebalance period  
 Reference symbol: generally an index like the SP500  
 Risk free rate  
 Percent of capital to invest: Specify the percentage of capital to invest  
 Activate stop immediately: If activated then when exiting a trade because of a stop, uses the 

stop value as the trade exit price, otherwise exit as defined in the sell or cover price and 
delay settings)  

 Reverse entry forces exit: When checked, the back-tester will close a long position if he 
encounter a short signal for the same symbol and close a short position if he encounters a 
long signal for the same symbol.  

 Volume filter: tell the back-tester to enter position only if there is enough liquidity.  
 Order are valid for: The number of bars to keep limit orders. After this period, entry orders 

are canceled and exit orders are transformed into market orders.  
 Pending Orders:  Specify which order types are used in the calculation of available cash and 

positions in the portfolio.  
 Margin: a factor to specify the margin you want to allow for this trading system (A value of 2 

means that the amount of money you are allowed to use within this trading system is twice 
your current equity value)  

 Minimum shares: This is the minimum number of shares you can buy or short. (The position 
will not take place if the number of shares to buy or short is less that this value)  

 Minimum position value: The same as 'Minimum shares', but we use here the position value 
or volume.  

 Commissions: Brokerage commissions  
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 Slippage: specify the average slippage associated with each trade. (Difference between the 
simulated entry price and the real entry price)  

 Allow penny stocks: Reject a trade or a position if the stock price is lower than 2. Use this 

field only if you are trading stocks.  

  

5. Futures Settings 

To open the futures settings control, select "Settings" tab then click on "Futures Settings" button. 

There you can define the default value for the following fields: 

 

Tick Size: The minimum price move of a given security 

 

Random Lot Size: A normal unit of trading or multiple units of trading of a security 

 

Point Value: The amount of profit generated by one contract for one point increase in price 

 

Margin Deposit: The amount of money required to open a single contract position 

Instead of specifying a fixed margin deposit amount, you can specify a variable amount that depends 

on the contract price. 

To do this, type a negative value in the margin depost field. 

For example:  

Type "-20" to tell QuantShare that margin deposit should be equal to 20% of the contract price. 

 

Disable Futures Mode: Check this field to ignore "Point Value" and "Margin Deposit" options during 

the backtesting process 

 

Note that you can define a different value for each symbol. For that, select "Symbol -> Update 

Symbol" in the main menu then update the corresponding fields. 

By default, the backtester will search for values that are specific to each symbol. If one of these fields 

is set to "0" then it will search for the corresponding global value defined in this control. 

  

6. Money Management 

See Advanced Money Management topic   
 

7. Optimize a trading system 
  

You can optimize a trading system using the optimizer plug-in or using the simulator optimizer. 

The optimizer plug-in uses complex algorithms to find the best trading system, while the integrated 

simulator optimizer use bulk optimization (that is, the simulator will back-test all the possibilities)  
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Optimize trading system settings: 

- Create or update a trading system 

- Select "Optimize" icon 

- Click on "Optimization" 

- Click on "Add Item" 

- Select a variable. For example: Number of symbols. 

- Specify the min, max and step values 

 

If you select "Number of symbols", 1 as Min, 10 as Max and 4 as Step then the optimization 

will create three trading systems: 

Trading System 1: Maximum number of symbols is equal to 1. 

Trading System 2: Maximum number of symbols is equal to 5. 

Trading System 3: Maximum number of symbols is equal to 9. 

Optimize trading system formula: 

 

To optimize a trading system formula, use the "Optimize" function. 

 

Example: 

Optimize("level", 60, 80, 10); 

buy = rsi(14) > level; 

The first instruction will create an optimizable variable whose name is "level". 

The second line instructs the trading system to buy a security if its relative strength index 

value is higher than "level" variable. 

 

This will create three trading systems: 

 

Trading System 1: buy = rsi(14) > 60; 

Trading System 2: buy = rsi(14) > 70; 

Trading System 3: buy = rsi(14) > 80; 

 

  

8. Run or optimize a simulation 

 

To run a simulation, first select a trading system, and then click on "Simulation". 

To optimize a simulation, first select a trading system, and then click on "Optimize".  
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9. Create a portfolio from a trading system 

  

A portfolio that uses a trading system allows you to generated trading signals (buy, sell, short and 

cover orders)based on this trading system, money management logic and latest data.  

You can create a portfolio using the Portfolio plug-in (Portfolio -> Portfolio), or you can directly 

created a trading system-based portfolio from the simulator form. 

 - Select a trading system 

- Click on "Create Portfolio" (at the bottom) 

- Update portfolio settings 

- Click on "Update Portfolio" 

- Type portfolio name then click on "Save item". 

 

  

10. Trading System Report 

  

10.1 Introduction 

 

The "Trading System Report" analyzes all the signals generated by the simulation and gives you a 

detailed report. 

The report of each simulation is saved and you can review it at any time by clicking on the 

"Optimization Report" button. 

10.2 Grid 

  

The grid control shows you the simulation basic statistics. 

When using optimization, this grid shows all generated simulations, a column for each variable shows 

you what value were used for each simulation. 

 

 

Double click on the 'Report' column icon to open the report of the selected simulation. 
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10.3 Chart 

 

Plot equity, drawdown and others time-series graphs. 

Right click on the chart to open a menu. 

You can create new panes, remove panes, and remove a graph from a pane... 

 

 

To add a graph to a pane, select a time-series from the combo box as shown below then click on 

'Drag' icon then drag the time-series and drop it into a chart's pane. 

 

 

  

By default, each time series uses its own scale. 

To have time series use the same scale, right click on a time series, select "Selected Graph -> Use 

default scale". 

Repeat this process for each time series you want to associate with the default scale. 

  

To plot entry and exit signals in a symbol chart, check 'Plot Entries & Exits on chart' then select a 

symbol that was used in the simulation. 
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The symbol chart will look like the picture below. Click on the arrows to display the position details. 

 

 

  

10.4 Statistics 

  

Capital: 

Initial Capital – The size of your account before the simulation started 

End Capital – The size of your account after the simulation ended 

Net Profit – The profit generated by the trading system 

Net Profit in Percentage – The profit generated by the trading system in percentage 

Exposure – The percentage of your account that was invested for all bars 

Net Risk Adjusted Return – Net profit % divided by Exposure % 

Annual Return – Compounded annual return % 

Risk Adjusted Return - Annual return % divided by Exposure % 

Average Profit/Loss - (Profit of winners + Loss of losers)/(number of trades) 
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Average Profit/Loss in Percentage - (% Profit of winners + % Loss of losers)/(number of trades) 

Average Bars Held - sum of bars in trades / number of trades 

 

Winners: 

Total Profit – Total profit generated by winning trades 

Number of Winners – The number of winning trades 

Average Profit - Average profit of the winning trades 

Average Profit in Percentage – Average profit of the winning trades in percentage 

Average Bars Held For Winners 

Max Consecutive Winner 

Largest Winner 

Number of Bars in Largest Winner 

 

Losers: 

Total Loss – Total loss generated by loosing trades 

Number of Losers – The number of loosing trades 

Average Loss - Average loss of the loosing trades 

Average Loss in Percentage – Average loss of the loosing trades in percentage 

Average Bars Held For Losers 

Max Consecutive Loser 

Largest Loser 

Number of Bars in Largest Loser 

 

Drawdown: 

Maximum Trade Drawdown - The largest peak to valley decline experienced in any single trade 

Maximum Trade Drawdown In percentage - The largest peak to valley decline in percentage 

experienced in any single trade 

Maximum system drawdown in dollar - The largest peak to valley decline experienced in portfolio 

equity 
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Maximum system drawdown in percentage - The largest peak to valley decline in percentage 

experienced in portfolio equity 

Recovery factor - Net profit divided by Maximum system drawdown 

CAR/MaxDD - Compound Annual percentage return divided by Maximum system percentage 

drawdown 

RAR/MaxDD - Risk Adjusted Return divided by Maximum system percentage drawdown 

 

Misc: 

Number of trades – The total number of trades generated by the simulation 

Percent of winners – The percentage of trade's winners 

Annual turnover – Example: a value of 100% means that the average holding period of a trade is one 

year; a value of 200% means that the average holding period of a trade is six months 

Total trading costs – The sum of all the trading costs generated by the simulation 

Volume activity – The sum of all the positions size generated by the simulation 

Percent trading cost of volume - Total trading costs / Volume activity 

Percent positive days – The percentage of positive days in the simulation equity 

Percent positive months - The percentage of positive months in the simulation equity 

Percent positive years – The percentage of positive years in the simulation equity 

Average daily return 

Average weekly return 

Average monthly return 

 

Stats: 

Ulcer index - Square root of sum of squared drawdown divided by number of bars 

Ulcer performance index – This indicator is used to measure the riskiness of an investment 

K Ratio - A ratio that is used in the performance evaluation of an equity relative to its risk. The ratio 

examines the consistency of equity's return over time. Higher is better 

Standard deviation - A measure of the dispersion of a set of data from its mean. The more spread 

apart the data, the higher the deviation. Standard deviation is calculated as the square root of 

variance. 
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Downside standard deviation - The downside standard deviation from the ordinary standard 

deviation insofar as the sum is restricted to those returns that are less than the mean 

Sharpe ratio - The Sharpe ratio tells us whether a portfolio's returns are due to smart investment 

decisions or a result of excess risk, the higher the better 

Sortino ratio - The Sortino ratio is similar to the Sharpe ratio, except it uses downside deviation for 

the denominator instead of standard deviation, the higher the better 

Profit factor - Profit of winners divided by loss of losers 

Payoff ratio – Ratio of average wins / average loss 

 

Performance Vs Benchmark: 

Beta - A measure of the volatility, or systematic risk, of a security or a portfolio in comparison to the 

market as a whole; if a stock's beta is 1.2, it is theoretically 20% more volatile than the market.  

Alpha - A measure of performance on a risk-adjusted basis, a positive alpha of 1.0 means the fund 

has outperformed its benchmark index by 1%. Correspondingly, a similar negative alpha would 

indicate an underperformance of 1%. 

R Squared – The percentage, of a fund or security's movements, that can be explained by 

movements in a benchmark index. R-squared values range from zero to 100. An R-squared of 100 

means that all movements of a security are completely explained by movements in the index 

Correlation - a statistical measure of how the security and the benchmark move in relation to each 

other 

  

10.5 Trades 

 

Realized trades: This window shows you the list of all realized trades. 

Trades flow: This window shows you the list of all the trade's entries. 
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10.6 Detailed trades 

 

This control shows you a snapshot of your portfolio for any date. It displays, for each date, the 

portfolio statistics, the current positions, the opened positions and the closed positions.  

It also shows you the orders that were created for each date, and the orders that were rejected along 

with the reason of the rejection. 

 

 

  

10.7 Performance Per 

 

This window shows you the performance of the trading system per day, week, month and year. 
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10.8 Symbols 

 

The Symbols tab contains the list of the symbols that were used by the simulation. 

  

10.9 Formula 

 

The formula tab contains the formula that was used to create the trading system. 

  

10.10 Profit distribution 

 

Display a graph that shows you the profit distribution. 

 

 

  

10.11 MAE/MFE 
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Display two graphs, one for maximum adverse exclusion and the other for the maximum favorable 

exclusion. 

You can also display the MAE/MFE data in a scatter plot. 

To do this, click on the listbox available next to "Chart Type" then select "Scatter". 

More info about scatter plot: 

http://en.wikipedia.org/wiki/Scatter_plot 

 

 

  

 

  

10.12 Custom graphs 

 

Create custom graphs, could be Trade/MAE or Drawdown/MFE... 

  

10.13 S.I.M.I 

 

Shows you the position symbols distribution over markets, industries, sectors and indexes. 

http://en.wikipedia.org/wiki/Scatter_plot
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10.14 Reference symbol 

 

The symbol used as reference, usually an index such as "^GSPC". 

  

10.15 Exit rules 

 

Shows you the exit rules distribution and the average trade's performance for each exit rule. 

 

 

  

10.16 Monte Carlo Simulation 

 

For more information please visit: Monte Carlo Simulation 

  

10.17 Report settings 

 

The Report settings tab allows you to define the default graph interval values. 
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10.18 Errors Tab  

 

This tab displays the errors, if any, that occurred during the execution of the money management 

scripts.  

The tab name will change to "No errors" if no error occurs during the money management scripts 

execution or if no money management rules are defined.
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11. Trading System Templates 

  

A trading system template is a basic trading system used as a start point to create new 

trading systems. 

For example, you can create a template that contains your broker commissions settings. 

To create a new template: 

- Create a new trading system 

- Click on "Save As Template" button 

- Type the template name then click on "Save Item" 

 

To create a new trading system based on a template: 

- In "Simulator Manager", click on the arrow next to "New" 

- Select "New From Template" 

- Select a template name then click on "Load Selected Item" 

  

12. Load trading system report from file 

 

In the "Simulator Manager", click on "Tools -> Trading System Report -> Show report from 

file" (Click on "+" icon to expand top menu if necessary) 

You can save any trading system report to a file, by backtesting your trading system, 

selecting "Report Settings" tab in the simulator report then clicking on "Save Report". 

  

13. Walk-Forward Testing 

 

Walk-Forward testing is a tool that helps you create robust trading systems. 

This technique requires a trading system with optimizable variables. 

 

Here is how it works:  

- Your strategy is optimized with the in-sample period 

- The strategy that has the best return (or any custom measure) is selected 

- The previously selected strategy is backtested with the out-of-sample period 

- The in-sample period is moved by X days 

- The process is repeated 
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Walk-forward testing shows us how a trading system performs under various market 

conditions. It helps us detect whether the performance of a trading system is due to curve 

fitting or not. 

We can consider that the strategy result is realistic if it performs well on out-of-sample data. 

 

 

Perform a walk-forward testing 

 

- Open the simulator manager by selecting "Analysis -> Simulator" 

- Select a trading system 

- Click on "Optimize" (top-right corner) then select "Walk-Forward Testing" 

 

 

Walk-Forward Settings 

 

Follow previous instructions to bring the Walk-Forward settings control. 

 

In-Sample/Out-of-sample Tests: 

Start Period: The start date of the first in-sample or out-of-sample period 

Anchored: Makes the start date of each sample constant 

End Period: The end date of the first in-sample or out-of-sample period 

Last Date: The start date of each sample should not be higher than the last date 

Use Today: Sets today as last date 

Step Period: On each iteration moves the in-sample or out-of-sample period by the step 

period 

Step Interval: Defines the interval of each step 

 

Note that when you update one of these fields, the in-sample or out-of-sample periods are 

automatically displayed on the corresponding tables. 

 

Metric: Select the metric that will be used to select the best trading system among the 

different in-sample optimizations. The default metric is the Annual Return. 

 

To start walk-forward testing, click on "OK" button. 

 

 

Walk-Forward Testing Report 

 

During the execution of the walk-forward testing, the result of each sample is added to the 

simulation report table. 

When testing is completed, the walk-forward report is displayed. 
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The report displays the result of each iteration (In-Sample + Out-of-sample). 

It also displays the best, worst, average, annual return and efficiency of each iteration. 

 

The walk-forward efficiency measure is calculated by comparing annualized returns of in-

sample and out-of-sample tests. 

This measure can help you quickly detect the robustness of a trading system. As a rule of 

thumb, a walk-forward efficiency above 60% indicates that you have a robust trading 

system. 

 

 

  

14. Combine Trading Systems Tool 

 

This tool allows you to combine several trading systems and see which combination 

performs best. 

- In the simulator manager, select "Tools" then "Combine Trading Systems". 

- Click on "Add Trading Systems" 

- Check several trading systems then click on "Load Checked Items" 

- Click on "Analyze" to start the analysis. 

If you select 3 trading systems (S1, S2 and S3) then this tool will backtest the following 

combinations: 

S1 

S2 

S3 

S1 + S2 

S1 + S3 

S2 + S3 

S1 + S2 + S3 

For example for the last trading system, the tool will allocate $10, 000 to each strategy and 

perform the backtesting. The result will be displayed on the report table. You can display the 

advanced report of each combination by clicking on the "Report" button. 

  

[TOP] 

1.8.14.4 Monte Carlo Simulation 
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Monte Carlo Simulation 
 

1. Introduction to Monte Carlo 

 

Monte Carlo simulation is a computerized mathematical technique that allows traders and 

investors to account for risk in quantitative analysis and decision-making. 

The main function of a Monte Carlo Simulation is to determine the robustness of a system. 

Monte Carlo simulation creates equity curves that use the same data than the original equity 

curve but they are calculated in random ways. It creates thousands of equity curves and lets 

you examine the values and distribution of the returns, annual returns, drawdowns and 

Sharpe ratios. 

To run a Monte Carlo simulation, backtest a trading system, select "Monte Carlo" tab in the 

"Report" form then click on "Start Simulation". 

  

2. Simulation Types 

 

Reordering: 

The equity curve is split into several blocks where each block contains a fixed amount of bars 

(Specified by user). 

In each simulation, blocks are randomly re-arranged and a new equity curve is computed. 

Because blocks are only re-arranged, each equity curve has the same return than the original 

equity curve (The equity curve that results from the backtest of your trading system). 

Reordering creates equity curves with different maximum drawdowns. 

Replacement: 

The equity curve is split in several blocks (N), where each block contains a fixed amount of 

bars (Specified by user). 

In each simulation, N blocks are taking randomly (with replacement) and these blocks are 

used to compute the new equity curve. 

This means that a block can be used twice or more and this creates equity curves that have 

different returns and maximum drawdowns. 

 

3. Simulation Settings 
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Number of simulations: This is the total number of simulations that must be created by the 

Monte Carlo plug-in. 

Maximum number of graphs to display: This is the maximum number of graphs to display in 

the "Monte Carlo Simulation" graph. Keep this value low to use less computer resources. 

Bars per sample: This is the number of bars that makes up a block. See "Simulation Types" 

for more information. 

Seed value: This is the random seed value. Set to zero to generate a random seed otherwise 

set a fixed value to get repeatable results. 

Example:  

By specifying 150 in the seed value input, you will always get the same results, for a specific 

equity curve, when running a Monte Carlo Simulation. 

 

4. Monte Carlo Graphs 

 

Monte Carlo Simulation: 

This chart displays the different equity curves that were generated by the Monte Carlo 

Simulation 

Distributions: 

This chart displays the distribution of several measures: Return, Annual Return, Maximum 

Drawdown and Sharpe Ratio. 

Use the slider (right) to increase or decrease the distribution interval. 

Confidence Level: 

To display confidence level values, select the "Confidence Level" tab. 

Example: 

If you set the confidence level to 95% then the Monte Carlo plug-in will tell you the 

following: 

95% of the simulation's tests have an equity curve with an annual return higher than X%. The 

higher the value of X, the more robust the trading system. 

You will also get information for following measures: Return, Maximum drawdown and 

Sharpe ratio. 
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[TOP] 

1.8.14.5 Advanced Money Management 

 Advanced Money Management 
  

 

1. Introduction 

 

The Money management plug-in let you take deep control over which instruments to buy, sell, short 

or cover, at which price and for which amount. 

It will also let you you create advanced metrics to assess and evaluate any trading system. 

Unlike many other products, QuantShare's money management tool is not applied after the 

simulation process. The different events are executed during the simulation; this allows you to use 

different portfolio metrics, such as the current equity or drawdown, and to control/manage new 

orders, existing positions, stops, number of positions, exposure... 

 

You can also create variables within your advanced money management script and use the simulator 

optimizer to optimize these variables.  

 

2. Create money management rules 

 

In the 'Update trading system' or 'Create trading system' form, click on 'Advanced money 

management'; these money management rules you are about to create will be associated with the 

current trading system.   

 

You can also create money management rules by selecting (Analysis -> Advanced Money 

Management) 

 

3. Money management events 

 

There are six money management events: 

 OnNewPosition: Called before the application opens a position 

 OnClosePosition: Called before the application exits a position 
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 OnEndPeriod: Called at the end of a period (On historical back testing a period is a day, a 

week or a month, depending on the time frame)  

 OnStartSimulation: Called just before the simulator starts 

 OnEndSimulation: Called just after the simulator ends 

 Global: This part is used to initialize variables and functions to be used in other events. You 

should only declare variables and functions there. 

  

Each event has also its own variables and functions; you can create a script for each event. 

Example (OnEndPeriod Event): 

We are going to create a script that will order the simulator not to take new positions for the next 30 

bars if the portfolio drawdown is below -20 percent. 

 

The Script:  

if(Portfolio.Drawdown < -20) 
{ 
// If portfolio drawdown is less than 20 percent, then we order the simulator 
// not to take new positions for the next 30 bars 
Functions.SkipPeriods(30); 

}  
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Examples: 

 

Reject an signal if the RSI value is lower than 50: 

You can create directly this rule as a sell rule or you use the OnNewPosition event of the money 

management script. 

TimeSeries t = Data.ParseFormula("a = 

rsi(14);").GetTimeSeries(NewPosition.Symbol ,"a"); 

if(t[0] < 50) 

{ 

     Functions.RejectPosition(); 

} 

Pair trading: In OnEndPeriod event 

if(Your rule) 

{ 

     MMPosition pos = Portfolio.GetPosition(symbol_1); 

     if(pos != null && !pos.IsLong) 

     { 

          // Exit positions 
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          Functions.CloseAllPositions(0); 

     } 

     // Buy symbol_1 & Short symbol_2 

     Functions.AddLongPosition(symbol_1, 0, Orders.OpenMarketOrder()); 

     Functions.AddShortPosition(symbol_2, 0, Orders.OpenMarketOrder()); 

} 

else 

{ 

     MMPosition pos = Portfolio.GetPosition(symbol_1); 

     if(pos != null && pos.IsLong) 

     { 

          // Exit positions 

          Functions.CloseAllPositions(0); 

     } 

     // Buy symbol_2 & Short symbol_1 

     Functions.AddLongPosition(symbol_2, 0, Orders.OpenMarketOrder()); 

     Functions.AddShortPosition(symbol_1, 0, Orders.OpenMarketOrder()); 

} 

  

Using the Global Event: 

Let us say that you want to calculate the number of times the "OnNewPosition" event was called. 

To do this, simply create a variable in the "Global" event: 

int ct = 0; 

And increment that variable in the "OnNewPosition" event: 

ct = ct + 1; 

// No need to initialize the "ct" variable in the "OnNewPosition" event, because this variable was 

already initialized in the "Global" event. 

 

4. Money management Categories
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There are two default categories in QuantShare's money management tool: Long and Short 
categories. 
The "Long" category deals with long trades while the "Short" category deals with short 
trades. 
 
Each category has two main properties: 
- Percentage to invest: The percentage of capital associated with a specific category 
- Number of positions: The maximum number of positions to buy/short in a specific category 

If you want to buy a stock based on the available cash and positions (You do not specify a 
number of shares to buy). The money management tool will calculate the number of shares 
to buy based on the number of positions and cash available in the "Long" category. 
Example: (OnEndPeriod event) 
Functions.AddLongPosition("GOOG", Orders.OpenMarketOrder()); 

 
5. Custom Categories 
 

You can create a custom category by calling the "Portfolio.UpdateCategorySettings" 
function. 
 
Example: 
Create a long1 category. This allows us to create two strategies within the same trading 
system. 
Each strategy could have its own buy and sell rules and we can easily modify the capital 
associated with each category using the "Portfolio.UpdateCategorySettings" function. 

Example: 
Portfolio.UpdateCategorySettings("long", 50, 10, null); // 50% and 10 maximum positions to 
"long" category 
Portfolio.UpdateCategorySettings("long1", 50, 5, null); // 50% and 5 maximum positions to 
"long1" category 

Article: 
http://www.quantshare.com/sa-308-how-to-combine-long-short-and-custom-portfolio-
strategies-within-a-trading-system 

 

Trading Object: 
http://www.quantshare.com/item-529-rebalance-combine-backtest-two-trading-strategies 

[TOP] 

1.8.14.6 Screener 

Screener 
  

http://www.quantshare.com/sa-308-how-to-combine-long-short-and-custom-portfolio-strategies-within-a-trading-system
http://www.quantshare.com/sa-308-how-to-combine-long-short-and-custom-portfolio-strategies-within-a-trading-system
http://www.quantshare.com/item-529-rebalance-combine-backtest-two-trading-strategies
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1. Introduction 

The screener plug-ins let you scan symbols quotes using defined criteria. 

To open the screener tool, select "Analysis" then "Screener". 

The "Screens" list displays all the available screens. You can download click on a screen to run it. 

  

2. Create a Screen 

Click on "Create a new screen".  

1- Select whether to screen by date or bar. When bar (0) is set then the screener will check the 

criteria against the last bar of each asset. 

2- Click on "Select Symbols" to select the symbols to include in this screen 

3- Select a time frame (Daily, monthly, one-hour, one-minute...) 

4- In the Formula Filter, type your formula (criteria)  then click on "Start" to run the screen. 

Example: 

Close > 10 

 

  

3. Edit a Screen 

 

In "Screens" list, select a screen then click on "Edit Screen". Changes are automatically saved. 

  

4. Stats 

Stats grid takes each column and calculate the maximum, minimum and average values. 

 

 

To display the "Stats" grid, click on "Show Stats" (at the bottom of the screener) 

 

5. Columns 
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You can add columns to your screen by clicking on the "Add Column" link (Wizard view) or by 

using the "AddColumn" function. 

Example: the following formula will add a column whose name is 'Perf 1D' and will show "the 

performance of the security for one day" on the screener report. 

AddColumn ("Perf 1D", Perf (close, 1)); 

Another option would be to create a column set and reference it from the "Add Columns" 

tab. 

(Analysis -> Columns Set)  
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[TOP] 

1.8.14.7 Pivot Tables 

Pivot tables 

 

1. Introduction 

A pivot table is a data summarization tool that counts, sums and averages data from one or 

several symbols and dates..  

This tool allows you to create simple tables and pivot tables from your databases using 

quotes and/or technical/fundamental indicators data. 

 

To create a pivot table, you must open a dashboard first. 

- Select "Tools", "Dashboard" then "New Dashboard" 

- Type the dashboard name then click on "Save Item" 

- Right click on the dashboard then select "Create Pivot Table" (A black rectangle is added) 

- Right click on that rectangle then select "Update Rows/Columns/Values" 

 

For more information about dashboards or widget panels, please look at the "Widget Panel" 

topic. 

 

2. Pivot Table Example 

In this pivot table, we will display the RSI values of two stocks for the last 5 trading days. 

- Click on "+" next to rows then select "Dates" tab 

- Click on "+" next to columns then select "Symbols" tab. Click on "Add Symbols" then add 

two symbols (Example: GOOG;MSFT). 

- Select the existing "Values" item then set the following formula: rsi(14). Type "RSI" under 

"Name" panel 

- Under "Select Dates" panel, select "Last 5 Days" then click on OK 

- Right click on the Pivot table then select "Perform Calculation" 
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You must have the latest EOD data in order to see Google and Microsoft RSI values for the 

last 5 trading days. 

Additional Information: 

http://www.quantshare.com/sa-141-pivot-tables-in-quantshare-trading-software 

[TOP] 

1.8.14.8 Portfolio 

Portfolio 

 
This tool allows you to create portfolios and manage your positions. 
You can enter trades manually or automatically based on a trading system. 

 

1. Portfolio View 

To open the portfolio view: Click on "Portfolio" in the menu, then "Portfolio". 
The Portfolio manager contains all your portfolios. When you select a portfolio, the right 
panel displays several metrics as well as current positions info and pending orders. 

 

2. Create a portfolio 

There are two types of portfolios: Simple portfolios and strategy-based portfolios. 
The former allows you to enter manual orders and positions. The latter automatically create 
orders based on the trading strategy you have associated with it. You can also manually 
enter orders in a strategy-based portfolio. 
 
To create a portfolio, click on "New" in the Portfolio View. 
Click on "Click here to associate it with a strategy" to link the portfolio to a trading system. 
 
Here is a description of the different portfolio settings: 
Capital: The initial capital allocated to the portfolio. 
Number of positions: The maximum number of positions in the portfolio (Applicable when a 
trading strategy is defined). 
Past Days: Specify the number of past days to look for signals (Applicable when a trading 
strategy is defined). Default value is 0, which means that the portfolio will look for signals 
that occur on the rebalance day. 

Example: 
Rebalance date is today and past days is set to 0. 
Stock "A" buy signal occurred yesterday. When you execute "Get Signals", you will get no 
signals. 
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If you set "Past days" to one, the portfolio will also look for yesterday' signals and you will 
then get one order to buy Stock "A". 

 

3. Get Trading Signals 
 

The rebalance day is the day that is used to check for new buy/sell/short/cover signals. 
Usually in End-of-day trading, the rebalance day is the last trading day. 
In the "Pending Orders" tab, specify a date near the "Get Signals" button and then click on 
that button. 
By default, the rebalance date is set to the last quote's date. 

 

4. Pending Orders 
 

Orders created manually or automatically after a rebalance are added to the "Pending 
Orders" View. It displays the Orders that should be executed. 
To execute an order, simply on "Buy", "Sell", "Short" or "Cover", select the execution price, 
number of shares and commissions amount then click on "Confirm". 

 

5. Add an order manually 

- In "Pending Orders", click on "Add Order Manually". 
- Select the symbol, number of shares, action and order type. 
- Click on "Add Order" 

 

6. Rejected Orders 

The "Rejected Orders" tab contains the orders that were rejected from the "Pending Orders" 
grid (An order is rejected when you click on delete -X- icon). 

You can then click on "Get Signals" again to get new orders or to replace the rejected orders. 

To delete a rejected order, select the "Rejected Orders" tab then click on the "+" icon (Cells 
under the last column). 

Once you delete the rejected order, you can get orders for the underlying symbol on the 
next rebalance. 

 

7. Add Bulk Positions 

 

There are two ways to add several positions from a file. 
 
Solution 1: Add several positions to your portfolio 
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- Click on "Add Positions" at the bottom 
- Select "Add Several Positions" tab 

Solution 2: Create several historical trades/transactions then automatically execute them 
- Select your portfolio 
- Click on "Tools" then "Import Trades" 

Choose the second solution if you want to import historical positions/trades. 

 

8. Portfolio's positions 
 

The "Positions" tab displays the current portfolio's positions.  
Click on the (i) icon, to display more information regarding the position. 
Click on the (x) icon to remove or close the position. 

 

9. Update portfolio's categories 
 

Categories are used to separate different strategies within a trading system. In a long/short 
trading system, positions that are entered long are associated with the "long" category, 
while positions that are entered short are associated with the "short" category.  
Using the money management script, you can create as many categories as you want. 

Click on "Categories" tab to display the available categories for the portfolio, as well as the 
remaining cash and positions for each one of them. 
The "Adjust Cash" button automatically adjusts the available cash based on the current 
portfolio equity and the percent of equity to invest for the category. 
You can change the amount of cash, the percent of capital to invest and the maximum 
number of positions for each category by updating the corresponding fields and then clicking 
on the "Update" button. 

 

10. Update a portfolio 

Select a portfolio then click on "Update". 

 

11. Delete a portfolio 

 
To remove a portfolio, click on "Remove" in the Portfolio View. 

 

12. Deposit and Withdraw Money 

 

To deposit or withdraw cash from a Portfolio, click on "Add//Withdraw Cash" button and 

then select the amount. 
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Here is how to update cash transactions: 

- Select "Cash Activity" tab 

- Double click on a cell under "Date" or "Amount" 

- Type a new value 

 

13. Stats 

13.1 Portfolio History 

This tab displays historical equity positions. For each day, you will see the portfolio equity, 
available cash, percent invest and the number of positions in the portfolio. 

13.2 Summary 

This tab displays some statistics: Portfolio value, cash, return, total gain, total loss, current 
drawdown, maximum drawdown, percent winning trades... 

13.3 Advanced Report 
 
To create an advanced report from a portfolio: 

- Select your portfolio 
- Select "Summary" tab 
- Click on "Create Advanced Report" 

14. Advanced Report 

By right clicking on a portfolio then selecting "Create Advanced Report", you can create a 
report from your portfolio trades (as the one created after a simulation or backtest) 

15. Combined Portfolios 

The portfolio combination tool lets you create combinations from a number of portfolios and 

shows you how each combination performs. 

 

Example: 

Let us say you have three portfolios and you want to see the combined results. 

 

- In the "Portfolio" manager, select "Tools" then "Report for combined portfolios". 

- Click on "Add Portfolio" and add three portfolios 

- Click on "Analyze" to create advanced reports for each combination 
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The tool will display the result of the following portfolios: 

 

Portfolio 1 

Portfolio 2 

Portfolio 3 

Portfolio 1 + Portfolio 2 

Portfolio 1 + Portfolio 3 

Portfolio 2 + Portfolio 3 

Portfolio 1 + Portfolio 2 + Portfolio 3 

 

For each combination, you can display the advanced report by clicking on the "Report" 

button. 

 

16. Import Trades 

It is possible to add several trades in a portfolio from different sources: 

 

Another Portfolio: 

- Right click on a portfolio 

- Select "Import trades from another portfolio" 

- Select a portfolio 

- Click on "Load Selected Item" 

File: 

- Right click on a portfolio 

- Select "Import trades from a file" 

- Click on "Add File" then select the file that contains the list of trades 

- Select the appropriate Symbol Field (default is Name) 

- Click on "Import" 

Sample File: 

10/11/2011 12:52;EURUSD;Buy;1.43;1000;1 

10/11/2011 13:52;EURUSD;Buy;1.45;1000;1 

10/11/2011 14:52;EURUSD;Sell;1.41;500;1 

10/11/2011 15:52;EURUSD;Sell;1.4;1000;1 

10/11/2011 16:52;EURUSD;Sell;1.42;1000;1 
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Note1: 

Symbol field is used when the file contains ticker symbol names that are different from the 

current symbol names in your database. 

Example: 

The file references the following symbol: A.P 

You have the following symbol in your database: A (Both symbols references the same stock) 

To successfully import trades from this symbol, youhave to set "Name1" field to "A.P" and 

then use "Name1" as Symbol field in the "Import Trades" form. 

 

Simulation Report: 

- Open a simulation report 

- Select "Trades tab 

- Select "Realized trades" or "Orders flow" tabs 

- Select one or several trades (use CONTROL to select multiple trades) 

- Right click(Keep pressing on CONTROL if you have selected many trades) 

- Click on "Add all trades to a portfolio" or "Add selected trades to a portfolio" 

- Select a portfolio then click on "Load Selected Item" 

 

[TOP] 

1.8.15 Artificial Intelligence 

Optimizer 
  

  

1. Introduction 

 

The optimizer is a plug-in that uses artificial intelligence algorithms to optimize rules, ranking 

systems, trading systems and prediction items.  

  

2. Optimizer algorithms 

The plug-in provides two algorithms:  

 Genetic algorithm  
 Population-based incremental learning 

Example: 
Take a list of rules with 1000 rules. 

For these rules, we have more than billions of combination which will take years to back-test. 

Optimization algorithms are used to find good solutions among all the combinations in a short 

period. 
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2.1. Genetic algorithm 

These are the genetic algorithm parameters: 

 Number of generation  
 Population size  
 Selection method: Elite, Rank or Roulette  
 Crossover rate  
 Mutation rate  
 Random selection portion  

  

http://en.wikipedia.org/wiki/Genetic_algorithm 

  

2.2. PBIL algorithm 

These are the PBIL algorithm parameters: 

 Number of generation  
 Population size  
 Learning rate  
 Number of best solutions to use in learning  
 Enable multithreading: Check this field to enable multithreading during the optimization 

(This will allow QuantShare to use all available CPUs instead of a single one) 

  

http://en.wikipedia.org/wiki/Population-based_incremental_learning 

 

  

3. Optimize items 
  

3.1. Optimize list of rules 

Search for the best combination of rules among a list of rules.  

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'List of Rules' in the 'What do you want to optimize?" 

list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select the number of rules  
 Select a list of rules, by clicking on 'Select rules'.  
 For list of rules, select whether to always include the current rule or not by checking or un-

checking 'Always visible' checkbox  
 Select the output  
 Define a fitness formula  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  

http://en.wikipedia.org/wiki/Genetic_algorithm
http://en.wikipedia.org/wiki/Population-based_incremental_learning
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 The optimizer item will now appears in the optimize manager.  
 

Example:  

List of rules contains 100 rules, from rule1 to rule100. 

 

The optimizer will try to find good combination of rules. 

The result will look like this: 

Formula Fitness 

Rule87 && rule3 0.9 

Rule12 && rule2 0.76 

Rule33 0.66 

Rule67 && Rule32 && Rule2 0.5 

 

Fitness could be the return of the symbol or something else; it depends on the 'Fitness' formula. 

3.2. Optimize ranking system 

Try to find which combination of nodes and nodes' weight gives the best fitness score for the ranking 

system. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Ranking System' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select a ranking system by clicking on 'Select a ranking system'  
 Select the number of buckets and the rebalance period  
 Choose whether to optimize nodes' weight by checking or un-checking 'Optimize node 

weights' checkbox  
 Type a fixed rule if you want to use a fixed rule in the ranking system evaluation  
 Select the output  
 Define a fitness formula  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

  

3.3. Optimize trading system 
  

When optimizing a trading system, you can either optimize list of rules and then include 

these rules as buy, sell, short and cover rules or you can update directly a trading system 
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formula. 

 

Next to "How to optimize trading system?", choose: 

 

Using optimize variables in a formula: To specify a trading system with optimizable variables 

(formula, settings and money management). This looks like the exhaustive optimization but 

instead of trying every combination, the optimizer will use the PBIL or Genetic Algorith to 

speed up the optimization process  

 

Using buy & sell list of rules: To enter several list of rules and then having the optimizer try 

different combinations of rules and choosing the ones that maximum the fitness function. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Trading System' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select the number of buy and sell rules  
 For each buy and sell rule, select a list of rules by clicking on 'Select rules'  
 For each buy and sell rule, select whether to always include this rule or not by checking or 

un-checking 'Always visible' checkbox  
 Define a fitness formula  
 On the 'Settings' tab, type a fixed buy rule and a fixed sell rule if you want to include fixed 

rules in your trading system  
 Select 'Optimization', to include capital and stops optimizable variables  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

  

3.4. Optimize prediction item 
  

Try to find which prediction item leads to a better prediction accuracy given a list of inputs. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Prediction Model' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select a prediction item then click on 'Load Inputs'  
 Update the prediction item if necessary by clicking on 'Update Item'  
 Select the input that will always be used in iterations by checking them (Fixed inputs)  
 Define a fitness formula  
 Click on 'Next'  
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 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

 
  
3.5. Notifications 

  
On the last screen, click on "Define Notifications" to bring the notifications control. 

There you can specify how you want to be notified when the AI optimizer completes its work. 

Popup Message: Displays a popup message 

Chart Message: Displays a message on the active chart 

Play Sound: Plays a specific sound file 

Speech: Translates text into spoken works 

Send Email: Sends an email to a specific address 

Execute Script: Executes a specific script 

For more information about the different options, please check the "Alerts Tool" topic. 

 
  

4. Optimize manager 

The 'Optimize manager' list all optimize items (AI -> Optimizer)  

 

 

To create an optimize item, click on 'Create'. 

To remove an optimize item, click on 'Delete'. 

To update an optimize item, click on 'Update'. 

To load the optimizer report, click on 'Report'. 

To start an optimize item, click either on 'Run' or on 'Run...' 

 

Running an optimize item indefinitely, using 'Run...', means that when the optimizer reach the 

maximum number of generation or the fitness value converge, the software re-run the optimize item 

and increase the value of 'Turn' by one. 
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5. Turn 

If you run an optimize item multiple times, you may end up each time with different results. 

This is because the optimizer algorithms do not look for all combinations but instead try to find good 

solutions in a short period. 

This is why we introduced the concept of 'Turn'. 

The optimizer report includes the best items for all the turns (not only the last turn).. 
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6. In/Out of Sample Testing 

In the right panel of the AI optimizer report, you can perform out-of-sample testing (If we consider 

that the analyzed period is the in-sample period). 

- Click on "Settings" 

- Select the securities to analyze in the out-of-sample testing 

- Select the out-of-sample period 

- Click on "Start" to begin the analysis 

This will create three additional columns in the report table. 

In-Sample Fitness: The original fitness value (measure) of each chromosome 

Out-of-Sample Fitness: The new fitness value calculated based on the out-of-sample period and 

symbols 

Gain: The difference between the in-sample and out-of-sample fitness values 

[TOP] 

1.8.15.1 Optimizer 

Optimizer 
  

  

1. Introduction 

 

The optimizer is a plug-in that uses artificial intelligence algorithms to optimize rules, ranking 

systems, trading systems and prediction items.  

  

2. Optimizer algorithms 

The plug-in provides two algorithms:  

 Genetic algorithm  
 Population-based incremental learning 

Example: 
Take a list of rules with 1000 rules. 

For these rules, we have more than billions of combination which will take years to back-test. 

Optimization algorithms are used to find good solutions among all the combinations in a short 

period. 

2.1. Genetic algorithm 

These are the genetic algorithm parameters: 

 Number of generation  
 Population size  
 Selection method: Elite, Rank or Roulette  
 Crossover rate  
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 Mutation rate  
 Random selection portion  

  

http://en.wikipedia.org/wiki/Genetic_algorithm 

  

2.2. PBIL algorithm 

These are the PBIL algorithm parameters: 

 Number of generation  
 Population size  
 Learning rate  
 Number of best solutions to use in learning  
 Enable multithreading: Check this field to enable multithreading during the optimization 

(This will allow QuantShare to use all available CPUs instead of a single one) 

  

http://en.wikipedia.org/wiki/Population-based_incremental_learning 

 

  

3. Optimize items 
  

3.1. Optimize list of rules 

Search for the best combination of rules among a list of rules.  

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'List of Rules' in the 'What do you want to optimize?" 

list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select the number of rules  
 Select a list of rules, by clicking on 'Select rules'.  
 For list of rules, select whether to always include the current rule or not by checking or un-

checking 'Always visible' checkbox  
 Select the output  
 Define a fitness formula  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

 

Example:  

List of rules contains 100 rules, from rule1 to rule100. 

 

The optimizer will try to find good combination of rules. 

The result will look like this: 

http://en.wikipedia.org/wiki/Genetic_algorithm
http://en.wikipedia.org/wiki/Population-based_incremental_learning
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Formula Fitness 

Rule87 && rule3 0.9 

Rule12 && rule2 0.76 

Rule33 0.66 

Rule67 && Rule32 && Rule2 0.5 

 

Fitness could be the return of the symbol or something else; it depends on the 'Fitness' formula. 

3.2. Optimize ranking system 

Try to find which combination of nodes and nodes' weight gives the best fitness score for the ranking 

system. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Ranking System' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select a ranking system by clicking on 'Select a ranking system'  
 Select the number of buckets and the rebalance period  
 Choose whether to optimize nodes' weight by checking or un-checking 'Optimize node 

weights' checkbox  
 Type a fixed rule if you want to use a fixed rule in the ranking system evaluation  
 Select the output  
 Define a fitness formula  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

  

3.3. Optimize trading system 
  

When optimizing a trading system, you can either optimize list of rules and then include 

these rules as buy, sell, short and cover rules or you can update directly a trading system 

formula. 

 

Next to "How to optimize trading system?", choose: 

 

Using optimize variables in a formula: To specify a trading system with optimizable variables 

(formula, settings and money management). This looks like the exhaustive optimization but 
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instead of trying every combination, the optimizer will use the PBIL or Genetic Algorith to 

speed up the optimization process  

 

Using buy & sell list of rules: To enter several list of rules and then having the optimizer try 

different combinations of rules and choosing the ones that maximum the fitness function. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Trading System' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select the number of buy and sell rules  
 For each buy and sell rule, select a list of rules by clicking on 'Select rules'  
 For each buy and sell rule, select whether to always include this rule or not by checking or 

un-checking 'Always visible' checkbox  
 Define a fitness formula  
 On the 'Settings' tab, type a fixed buy rule and a fixed sell rule if you want to include fixed 

rules in your trading system  
 Select 'Optimization', to include capital and stops optimizable variables  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

  

3.4. Optimize prediction item 
  

Try to find which prediction item leads to a better prediction accuracy given a list of inputs. 

 In the 'Optimizer' form, click on 'Create'  
 Select the optimization algorithm and 'Prediction Model' in the 'What do you want to 

optimize?" list box  
 Click on 'Next'  
 Update the algorithm settings  
 Click on 'Next'  
 Select a prediction item then click on 'Load Inputs'  
 Update the prediction item if necessary by clicking on 'Update Item'  
 Select the input that will always be used in iterations by checking them (Fixed inputs)  
 Define a fitness formula  
 Click on 'Next'  
 Select the number of items to keep in the report  
 Select the symbols the optimizer will use  
 Click on 'Next'  
 The optimizer item will now appears in the optimize manager.  

 
  
3.5. Notifications 
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On the last screen, click on "Define Notifications" to bring the notifications control. 

There you can specify how you want to be notified when the AI optimizer completes its work. 

Popup Message: Displays a popup message 

Chart Message: Displays a message on the active chart 

Play Sound: Plays a specific sound file 

Speech: Translates text into spoken works 

Send Email: Sends an email to a specific address 

Execute Script: Executes a specific script 

For more information about the different options, please check the "Alerts Tool" topic. 

 
  

4. Optimize manager 

The 'Optimize manager' list all optimize items (AI -> Optimizer)  

 

 

To create an optimize item, click on 'Create'. 

To remove an optimize item, click on 'Delete'. 

To update an optimize item, click on 'Update'. 

To load the optimizer report, click on 'Report'. 

To start an optimize item, click either on 'Run' or on 'Run...' 

 

Running an optimize item indefinitely, using 'Run...', means that when the optimizer reach the 

maximum number of generation or the fitness value converge, the software re-run the optimize item 

and increase the value of 'Turn' by one. 

 

  

5. Turn 

If you run an optimize item multiple times, you may end up each time with different results. 

This is because the optimizer algorithms do not look for all combinations but instead try to find good 

solutions in a short period. 
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This is why we introduced the concept of 'Turn'. 

The optimizer report includes the best items for all the turns (not only the last turn).. 
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6. In/Out of Sample Testing 

In the right panel of the AI optimizer report, you can perform out-of-sample testing (If we consider 

that the analyzed period is the in-sample period). 

- Click on "Settings" 

- Select the securities to analyze in the out-of-sample testing 

- Select the out-of-sample period 

- Click on "Start" to begin the analysis 

This will create three additional columns in the report table. 

In-Sample Fitness: The original fitness value (measure) of each chromosome 

Out-of-Sample Fitness: The new fitness value calculated based on the out-of-sample period and 

symbols 

Gain: The difference between the in-sample and out-of-sample fitness values 

[TOP] 

1.8.15.2 Artificial Intelligence 

Artificial Intelligence 

  

Artificial intelligence is a plug-in that let you build prediction model using neural network and SVM 

(Support vector machine) systems. 

  

1. Neural Networks 
  

http://en.wikipedia.org/wiki/Neural_network 

  

2. Create a prediction model 
  

To create a prediction model, open the 'prediction model' form (Click on 'AI' then 'Prediction'), in the 

new form, click on 'Add'. 

The prediction model has many settings; those settings will help you fine-tune your model.  

 

  

  

3. Learning, validation and testing periods 
  

http://en.wikipedia.org/wiki/Neural_network
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Each prediction model must have three periods. 

 

The first period or the learning period is used to train the model. 

The second period or the validation period is used to choose the best model among all the generated 

models. 

The third period or the testing period is used to test the model with new data. (Data on which the 

model was not trained) 

Note that the model is trained only with data from the learning period. 

 

To change the learning, validation and testing periods, click on the triangles and move them. 

  

4. Learning and validation samples 
  

There are two options: 

Normal: The first bars (depending on the learning period) will be associated to the learning samples, 

and then the next bars will be associated with the validation samples.  

Random: The learning and validation periods will be merged and the learning and validation samples 

will be chosen randomly. 

  

5. Periodicity 
  

This option let you choose the period that the prediction item will use. 

  

6. Inputs 
  

Inputs are time-series that will be used to train the prediction item. 

This is probably the most important step in the creation of the prediction item. 

Add a new input by clicking on 'Add'. 
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Columns: 

 Select: The select checkbox indicate whether to enable or disable the current input  
 Input Type: Select the input type you would like to use.  
 Input: Display information about the input time-series.  
         Settings: Define settings related to the input you have selected 

         WS: Let you create multiple inputs from this input. 
Example: if you create 'close' as input and set WS to two, the system will create two time-
series. The first one is 'close' and the second one is 'close one bar ago' or 'ref (close, 1)'. 

         Lag: Let you specify the lag to include for the input. 
Example: if you create 'close' as input and set Lag to 3, the system will create the following 
input 'close three bar ago' or 'ref(close, 3)'. 

         Preprocessing: Let you select the pre-processing calculation that will be applied to the input. 

         R: This button is used to remove the selected input. 

Input Types: 

 Symbol Field: You can choose between open, high, low, close or volume times-series.  
 Symbol Return: This creates a formula that returns the performance of one of these time-

series: open, high, low, close, volume.  
 Formula: This lets you build your own time-series using the formula editor.  
 Extern Symbol: This lets you create a time-series based on an external symbol data.  
 Database Field: This lets you create a time-series from a field database.  

  

  

7. Output 
  

The output is the time-series that will be predicted. 

You can predict a symbol price, a symbol returns or any other time-series. 

The output has the same settings as inputs. 

 

The 'WS' column doesn't exists in the output settings.  

You can create only one output. 
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8. Neural network model settings 

A neural network model has different settings that can dramatically improve or reduce the 

performance of the prediction model. 

 

  

  

9. Network 
  

A neural network model is composed of one input layer, one output layer and zero, one or many 

hidden layers. 

Click on the circles to select a layer. 

  

Network settings: 

 Annealing Epoch: The epoch at which the learning rate increase or decrease is performed  
 Jitter Epoch: The epoch at which the Jitter is performed. Jitter is the process of adding small 

random noise to weights of all synapses at regular intervals in order to get the network out 
of a potential local minimum  

 Learning Rate Increase Factor: Let the network learn faster in order to improve the global 
error, value should lies between 1.00 and 1.03  

 Learning Rate Decrease Factor: Let the network learn slower in order to improve the global 
error, value should lies between 0.97 and 1.00  
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Input layer: 

The input layer is the first layer of the neural network model. 

The number of inputs determines the number of nodes for this layer. 

Hidden layers: 

Hidden layers are layers that are always between the input and the output layer. 

Output layer: 

The output layer is the last layer of the neural network model. 

There is only one node in the output layer. 

The value that leaves this layer is the predicted value. 

  

Layer settings: 

      Transfer function: Activation or transfer function in a back propagation network defines the 
way to obtain output of a neuron given the collective input from source synapses. 

      Learning rate: Learning rate is one of the parameters that govern how fast a neural network 
learns and how effective the training is. 

 Momentum: Momentum term associated with each synapse represents its tendency to 
retain its previous weight change. This factor varies from zero to one.  

 Max Jitter: The maximum limit to the random noise added to weights while Jitter, Jitter is the 
process of adding small random noise to weights of all synapses at regular intervals in order 
to get the network out of a potential local minimum.  

 Weight Decay: Each time the neural network is trained, the weights of synapses are 
multiplied by this 'Weight Decay'. Weight decay value is usually between 0.9 and 1.  
  

  

10. Filter 
  

The filter lets you create a formula that will be used to reject certain bars from the learning process. 

Example: If you want to reject bars where the volume was insignificant then type something like this: 

'volume < 100'. 

  

11. Symbols 
  

Select the symbols that will be used in the learning process. 

  

12. Stop training settings 
  

Specify when to stop the training, there are three options: 

 By error value: Stop when the error value reaches a certain level.  
 By error change: Stop when the error change goes below a certain value for a determined 

number of iterations.  
 By iterations: Stop after a specific number of iterations.  
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13. Selecting the best model 
  

Select the model that will be used in prediction among all the models created during the training. 

Type: Select the model based on one of these values: 

Network Error: 

 MSE (Root mean square error)  
 POCID (Directional accuracy)  
 POCD (Prediction sign accuracy)  
 UTHEIL (Coefficient U de Theil)  

  

Track on set: Choose whether to select the best model among the training models or the validation 

models.  

  

 

  

  

14. Train a model 
  

In the 'Prediction' form, select an item then click on 'Train', the 'Prediction Progress' form appears. 
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The blue line refers to the iteration that produced the best prediction model depending on your 

settings. 

  

15. Prediction 

 

In the 'Prediction' form, select an item then click on the small arrow next to 'Predict'. 

You have the choice to choose between 'Predict' and 'Predict a value'. 

15.1. Predict 

This option gives you the ability to predict values for a range of dates. 

15.2. Predict a value 

 

This option gives you the ability to predict a value for a specific date. 

16. Re-Training 

You have the possibility to re-train a prediction model on new data. To do so, click on 'Re-Train' 

button in the 'Prediction' form. 

16.1. Re-Training Settings 

Re-Training Settings lets you choose the range of dates and the learning and validation samples that 

will be used for the re-training. 

17. Update a model 
  

In the 'Prediction' form, select an item then click on 'Update'. 

You will lose the data of the prediction model if you update the latter. 
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18. Re-initialize a model 
  

Click on 'Reinitialize Model' in the 'Prediction' form to delete the date of the model. 

  

19. Access a model from a formula 
  

Two functions let you access a model data from a formula: 

Predict("category name", "model name") ; 

Returns a time-series that contains the prediction values. 

PredictSymbol("category name", "model name") ; 

Returns '1' if the prediction model was trained using the current symbol, otherwise returns '0'. 
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[TOP] 

1.8.16 External 

Portfolio123 
  

  

1. Introduction 
  

Portfolio123 is a service that lets you create ranking system models based on fundamental and 

technical items.  

Porfolio123 database contains more than 4000 fundamental ratios for all US companies. For more 

info, visit their website on www.portfolio123.com. 

This plug-in lets Portfolio123 subscribers import factors, formulas and ranking system data. 

  

2. Import a ranking system 

  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'Settings' tab, make sure you have inserted your portfolio123 login and password.  
 Select 'RS' tab  
 Click on 'Load' if no ranking systems appear  
 Select a ranking system  
 Type in a name in the 'Name' text box  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly created item appears there.  
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3. Create a factor 

  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'F&F' tab  
 Check the radio box 'Factor'  
 Select a factor (select a category then a factor)  
 Set the factor settings (lower or higher, rank vs.)  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly create item appears there.  

  

4. Create a function 
  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'F&F' tab  
 Check the radio box 'Formula'  
 Type a formula then type the formula name  
 Set the formula settings (lower or higher, rank vs.)  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly create item appears there.  
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5. Download Portfolio123 data 
  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'P123' tab  
 Check the items you want to download  
 Select the start date and the end date  
 Click on 'Start download'  

  

If you want to start the download from the last update date, click on 'Download Missing Dates' 

instead of 'Start download'. 
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[TOP] 

1.8.16.1 Portfolio123 

Portfolio123 
  

  

1. Introduction 
  

Portfolio123 is a service that lets you create ranking system models based on fundamental and 

technical items.  

Porfolio123 database contains more than 4000 fundamental ratios for all US companies. For more 

info, visit their website on www.portfolio123.com. 

This plug-in lets Portfolio123 subscribers import factors, formulas and ranking system data. 

  

2. Import a ranking system 

  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'Settings' tab, make sure you have inserted your portfolio123 login and password.  
 Select 'RS' tab  
 Click on 'Load' if no ranking systems appear  
 Select a ranking system  
 Type in a name in the 'Name' text box  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly created item appears there.  
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3. Create a factor 

  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'F&F' tab  
 Check the radio box 'Factor'  
 Select a factor (select a category then a factor)  
 Set the factor settings (lower or higher, rank vs.)  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly create item appears there.  

  

4. Create a function 
  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'F&F' tab  
 Check the radio box 'Formula'  
 Type a formula then type the formula name  
 Set the formula settings (lower or higher, rank vs.)  
 Click on 'Create Item'  
 Switch to 'P123' tab, your newly create item appears there.  
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5. Download Portfolio123 data 
  

 Open the Portfolio123 plug-in (Extern->Portfolio123)  
 Select 'P123' tab  
 Check the items you want to download  
 Select the start date and the end date  
 Click on 'Start download'  

  

If you want to start the download from the last update date, click on 'Download Missing Dates' 

instead of 'Start download'. 
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[TOP] 


